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1. What is CourseLab? 
CourseLab is a powerful and easy-to-use eLearning authoring system that offers programming-
free WYSIWYG environment for creating high-quality interactive eLearning content which can 
be published on the Internet, Learning Management Systems (LMS), CD-ROMS and other 
devices. 

1.1 Key Features of CourseLab 

 WYSIWYG (What You See Is What You Get) environment for creating and managing 
high-quality interactive eLearning content.  

 No HTML or other programming skills required.  
 Object-oriented Model allows constructing eLearning content of almost any complexity 

just as easy as you put together the building blocks.  
 Interface based on an Open Object Model enables to easily extend and enhance existing 

libraries of objects and templates including those created by the user.  
 Embedded mechanisms for objects animation.  
 Add any rich-media content like Macromedia Flash, Shockwave, Java, and video in 

different formats.  
 Easy mechanism for inserting and synchronization of sound files.  
 Import PowerPoint presentations into the learning material.  
 Built-in screen capture mechanism, which enables emulating functionality of different 

software.  
 Embedded event-action mechanism.  
 Advanced users can access CourseLab Objects and runtime variables and functions via 

JavaScript. 

1.2 System requirements 
CourseLab Editor system requirements: 

 Microsoft Windows 2000/XP/2003/Vista/7/2008;  
 Internet Explorer 6.0 or higher;  
 80МБ hard drive space;  
 1 free USB port (if hardware key is used).  

Minimum system requirements for viewing learning modules for computers and mobiles*: 

 operating system:  
 Microsoft Windows 98, Me, NT 4.0, 2000, XP, 2003, Vista, 7, 2008;  
 MacOS X;  
 iOS; *  
 Linux;  

 Browser:  
 Internet Explorer 6.0 or higher (8.0 and higher recommended); **  
 Mozilla FireFox 3.0 or higher (4.0 and higher recommended); **  
 Google Chrome 1.0 or higher (7.0 and higher recommended);  
 Apple Safari 4.0 or higher (5.1 and higher recommended);  
 Opera 11.0 or higher (12.0 and higher recommended);  



 JavaScript enabled;  
 XML support enabled. 

* Some web technologies may not work. For example, Adobe Flash is not supported in some 
mobile devices. 

** Local launching of Course is available for these browsers only. User must allow launching 
active content from local disks in browser settings. 

1.3 Compliance to the Standards 
eLearning Courses created using CourseLab, depending on the publishing method, support the 
following international learning industry standards: 

 AICC ( http://www.aicc.org/ )  
 SCORM 1.2 ( http://www.adlnet.org/ )  
 SCORM 1.3 (SCORM 2004) ( http://www.adlnet.org/ )  

CourseLab certified by ADL for compliance to the SCORM 2004. 

 

1.4 CourseLab and LMS 
Learning Management System (LMS) is a complex software platform, that enables automation 
of the management and delivery of distributed learning content. Learning Management System 
tracks completion of the e-learning Courses and provides/compiles reports upon completion of 
the course. Modern Learning Management Systems are based on the international standards 
for utilizing and exchanging learning content.  

The complete comprehensive eLearning course can be created using CourseLab application. 

When Course is ready, author starts publication process. The result of publication is ZIP-
package, which is structured according to selected e-Learning standard's Content Aggregation 
Model (CAM). This package contains all necessary course files and special metadata files, which 
contain information on Course structure. 

Course package is imported into standard compliant LMS using built-in import procedures. 

When learner studies course, course communicates with LMS using corresponding e-Learning 
standard's Run-Time Environment (RTE). Course stores its state in LMS storage and restores 
state on continued approaches.  

http://www.aicc.org/
http://www.adlnet.org/
http://www.adlnet.org/


2. Interface 
This is what the CourseLab window looks like upon finishing New Course Wizard.  

 

CourseLab window is divided into the panels, each of which is used for completion different 
tasks.  

 Course Pane is located in the left portion of the CoursLab window. Course Pane contains 
the heading of the Learning Course. 

 Opened Module's window is located in the middle of the CourseLab window. 
 Task Pane is located in the right portion of the CourseLab window. 

  

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Interface_CoursePane.htm
file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Interface_ModulePane.htm
file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Interface_TaskPane.htm


2.1 Course Pane 
Course Pane contains the heading of the Learning Course. The same heading will be displayed 
for the learner in the Learning Management System.  

To open or close Course Pane select menu option View -> Course. 

 

Course Pane is located in the left portion of the CourseLab window.  

 

The heading consists of: 

 Course name;  
 names of the Chapters;  
 names of the Modules.  

Chapters can be grouped within another Chapters resulting in complicated Course hierarchy 
structure.  

Double click on the name of the Module to open Module for editing. 

To move Module or Chapter into the different Chapter, drag and drop name of the Module into 
the target Chapter's name.  

To modify the sequence of the Modules and Chapters, use mouse to drag heading component 
into the parent's element of the heading. By doing so, the dragged element will be moved to 
the end of the list.  



2.2 Module window 
Opened Module's window is located in the middle of the CourseLab window. Module window 
consists of the two parts: Slide panel and Workspace. 

 

Workspace is used for placing Objects on the Slide.  

Slide panel is used for displaying drafts of the Slides. By clicking on the draft of the Slide, 
selected Slide will be displayed in the Workspace. 

To change Slides order drag selected Slide icon into appropriate place of the Slide Panel. 

   



Use tabs with images above in the top of the Slide Panel to switch views between Slide's drafts 
and Slide's names.  

Use Tab and Shift+Tab to move name of the selected Slide to the right or to the left accordingly. 
In such a way, you can create simple Slide's hierarchy, which can be shown during playback of 
the Module. 

You can also use Module window to open Frames and Timeline Panes.  

2.3 Task Pane 
Task Pane is located in the right portion of the CourseLab window. The switch on top of the 
Task Pane enables accessing of one of the following sections of the Task Pane: 

      

 

  

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Frames_FramesPane.htm
file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Time_TimelinePane.htm


2.3.1 Frame structure 

 

Task Pane in the "Frame Structure" mode displays current Frame ID and list of all 
Objects (also Groups and Scenarios), that are used on the Frame. Objects within a 
Frame appear sequentially. The newly created objects displayed first, therefore 
they are covered by objects, which have been created later. 

Each Object area has Object ID and small icons that depicts additional Object's 
parameters: 

 

Object has Actions attached to its Events 

 

Object displays with delay 

 

Object is not displayed at all 

 

Object has transition on display 

 

Object has sound file attached 
 

2.3.2 Object Library 

 

Task Pane in the "Frame Structure" mode displays all Objects that available for 
creating Course. Objects are grouped by their purpose. 

There are two way to insert the Object on the Frame: drag the Object's icon on the 
Frame or double-click on its icon (in this case Object will be inserted exactly in the 
center of the Frame). 

Objects can be customized by user (using Customize link at the bottom of the 
Pane). 

  

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Layout_Order.htm
file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Layout_Order.htm
file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Reference_Complex_CreateModify.htm


2.3.3 Clip Art 

 

For inserting frequently used pictures it is convenient to use the Clip Art section in 
the tasks area. It displays thumbnail images in a Clip Art folder on the computer. 
Click “Browse…” at the bottom of the “Clip Art” section to designate the folder 
which will be accessible in the Clip Art panel. In the opened “Browse for Folder” 
dialog box, select the folder containing pictures. It is a good idea to preload this Clip 
Art with the pictures you plan to use in your course.  

To add a picture to the Slide, drag the thumbnail image into the working area. 

2.3.4 Autoshapes 

 

AutoShapes is a group of special Objects based on vector controls (arrows, stars, 
curves, rectangles etc.). Depending on the vector structure, AutoShapes can be 
resized to any size without losing form and quality.  

To insert an Object, select the desired tab in the AutoShapes section on the Task 
Pane and double-click on the Object.  

  



2.3.5 Scenarios 

 

CourseLab scenarios are templates for building interactions between multiple 
Objects.  

Task Pane in the "Scenarios" mode displays all Scenarios that available for creating 
Course, grouped by their purpose. 

2.3.6 Design Templates 

 

Task Pane in the "Templates" mode displays all Templates that available for 
creating Course. Using these Templates user can change Module's initial Template 
or add another Template to use it on some Slides. 

To add new Template into current Module double-click on suitable Template icon. 
New Master-Slide (and Title-Slide - if confirmed) will be added into Module. 

Templates can be customized by user (using Customize link at the bottom of the 
Pane). 

User can create own Templates and save them into My Templates section. To 
create Template user should create Module with one empty Slide, change Master-
Slide and Title-Slide according to design requirements and select menu command 
Tools -> Add module to templates.... 

 



3. What is eLearning Course? 
eLearning Course encapsulates structured, thematically self-contained learning material, which 
can be distributed to the learner throughout Internet or using memory devices. 

Typically, the eLearning Course accommodates self learning material, but unlike book or 
manual provides the following: 

 Powerful multimedia content - Graphics, animation and other rich-media material 
(audio and video in different formats, Flash-movie, Java applications and others).  

 Interaction - presentation of the learning material may depend on the actions taken by 
the user.  

 Different options for assessing and evaluating gathered knowledge (tests, exercises).  

Incorporation of eLearning Course into the Learning Management System and 
intercommunication between them enables the most efficient management of the overall 
learning process. Within Learning Management System the eLearning Course is considered as 
an independent learning unit, which can be assigned for assessing the level of learning. Upon 
completion of eLearning Course various reports could be generated by the Learning 
Management System.  

From the education methodology perspective eLearning Course corresponds to any 
conventional Learning Course - assuming that eLearning Course encloses all the necessary self-
educational learning material and tests for controlling and evaluating apprehension of the 
learning material. 

3.1 Module 
Learning Module is a fundamental building block of the Course hierarchy representing the set 
of author-structured Slides. During the learning process the learner is led from one Slide to 
another sequentially, which is default behavior. If desired, author of the learning Module can 
define different order of the Slides appearance (for example depending on the result of the 
test). 

Learning Module can be used for educational purposes (in this case consists of learning material 
only), besides that, Learning Module can be employed for assessing of the learned lessons (can 
contain tests and exercises). It is a common practice to combine both learning material and 
tests in one single Learning Module: In this case upon completion of the learning material 
learner is tested within the same Learning Module. 

In the Learning Management System the Learning Module is one of the component part of the 
Learning Course and the only dynamic structural unit; system collects information regarding 
completion of the Learning Module. When processing information about status of all Learning 
Modules, the system changes the completion state of not only the particular sections of the 
Course but also Learning Course itself with accordance to the rules defined in the particular 
Learning Management System. 

From the education methodology point of view Learning Module corresponds to lesson or 
lecture - meaning it supposed to have thematically coherent and completed learning material.  



3.2 Chapter 
Modules created in CourseLab can be thematically combined in Chapters. Chapters can be 
grouped within another Chapters resulting in complicated Course hierarchy structure. Although 
there is no limitation for number of Chapters and number of sub Chapters within a Chapter, it is 
strongly recommended to avoid using too complex hierarchy structure. The reason is that you 
do not mean to discourage student from pursuing this Course just because the structure of that 
Course is too hard to apprehend. 

Within Learning Management System the Chapter is usually displayed as a folder containing 
Modules and/or other Chapters. The Chapter for the distance Learning System is a structural 
unit. There is no information regarding state of the Chapter transmitted to the System from the 
Modules. The system is making changes to the state of the Chapters based on state information 
of its Modules and other Chapters. 

From the education methodology point of view Chapter can be represented as a series of 
thematically grouped lectures or lessons. 

3.3 Slide 
Slide (Interactive page) is the main building block of Module. Slides are used by the author to 
place learning material, tests, and exercises. The order of Slide correlation is predefined by the 
author. 

Slide itself consists of Frames. Depending on complicity the number of Frames can vary (e.g. 
using animation, software scenario etc. can significantly increase the number of Frames). Any 
Slide has at least one Frame. 

Slides are not accessible by the Learning Management System individually. The Module is the 
smallest system managed unit. 

From the education methodology perspective Slide can be employed for expressing single point 
of view (thought or idea) with regards to the Module. 

3.4 Frame 
Frame is the smallest structural unit of the Module. In order to create a Module author uses 
Frames as the foundation for objects. 

Even though there is no limitation for the number of Frames within a Slide, we recommend not 
to exceed 30-40 Frames per Slide otherwise the time elapsed for loading up the Slide could be 
inconveniently slow. 

Similar to Slides, Frames are not accessible by the Learning Management System individually. 
The Module is the smallest system managed unit. 

From the education methodology perspective Frame is not a self-containing unit - it is rather 
component of the Slide. 

  



3.5 Master-Slide 
All the Slides for the Module are created on top of the Master Slide. The Master slide is the 
slide that contains elements that are common to all or several slides: Navigation Objects within 
a Module, Help etc.  

There is no limit for the number of Master Slides and hypothetically each Slide with assessment 
content might have a Master Slide, but this is rather inefficient and must be avoided. In most 
cases one Master Slide is enough. 

LIMITATION: Since Master-Slide is "background" Slide it has limited functionality: links, 
hotspot areas, effects, display delays, events and actions are not supposed to work on 
Master-Slide. Most of Complex Objects also may not work on Master-Slide, except for 
Navigation Objects, which are designed especially for Master-Slide.  

3.6 Title-Slide 
Title-Slide is an introductory part of the Module which appears on the PC screen right after 
launching Module. Along with the introductory page the system loads the main part of module 
on the background, which makes it convenient for user. 

Important! During display of the Title-Slide introduction the main code for the 
module is not loaded yet, therefore, not all the complex objects will be displayed. 
Thus only text, images, and special objects, located in Title-Slide folder (such as 
Start Module Button and Title-Slide Popup) should be used when editing the Title-
Slide Slide. Transitions, delays, events and actions are not allowed too. 

  



4. How to Create Course? 
The following topics describe the steps for creating eLearning Course. 

 eLearning Course Scenario  
 New Course Wizard  
 Editing Module  
 Adding Modules  
 Adding Chapters and grouping Modules  
 Publish Course  

4.1 eLearning Course Scenario 
The following should be taken under consideration while creating Learning Course: 

Thematic Presentation of the Learning Course must be strictly consistent.  

 Stay focused.There is no need to pause - do not follow the usual teaching approach of 
blending some funny story into the studying material. Student himself will set the right 
pace to absorb the material.  

 Do not provide too many alternatives. A tree-like Course structure is rather 
disadvantageous if compared to linear type Course. It sends learners different directions 
therefore some parallel paths of the tree-like structure are in jeopardy of not being 
revealed at all. The only exception for using more complex structure is in case you need 
to provide an Example, which is relevant to the Main Objective. Note, this example 
should be just an additional illustration to the learning material and could be skipped 
causing no damage to the overall learning process. And again, if above mentioned 
example is an essential part of the main course the linear Course structure should be 
taken into consideration. Ideally, learner should be able to go through the entire Course 
only by pressing Next button.  

Specifics of delivering Learning Material - Pieces of the Learning Material 
should be reasonably sized. 

 Break down the Learning Material into chunks of learning content. Build the clear 
hierarchy structure. If learning material is extensive, break it down into Modules with 
respect to thematic coherence - clear and consistent story lines and content. It is not 
recommended to group more than one learning subject into one Module; better use 
more Modules in the Course than overload the Modules with different learning 
subjects. Use thematic coherence inside each Module to distribute learning assessment 
into the Slides.  

 One Topic per Slide. The learning material in the Course is divided into the Slides. 
Although there is a thematic relationship among the slides we do not recommend using 
several slides for covering a single learning Topic. Ideally, use only one Topic per Slide. 

Use Interactive Multimedia features 



 Utilize multimedia illustrations and graphics.. eLearning has a huge advantage over 
conventional learning since eLearning introduces multimedia content. Animated 
schemes or Flash-movie is often more comprehensive than lengthy descriptions and 
should be used to full extent to explore the Topic within a Slide.  

 Learn as you practice. Allow audience to interact with the system as it significantly 
improves the process of memorizing the learning material. eLearning is interactive by its 
nature, thus use this potential to the full extent. Where appropriate, enable onscreen 
actions to demonstrate different results by manipulating with parameters. Use quizzes.  

4.2 New Course Wizard 
To create a new course, select File -> New -> Course... 

 

The New Course Wizard appears. To continue, click Next. 

 



Provide the name of the course, the name of the course folder, and location where course 
folder should be created. 

 

The Course is created with the single Module by default. On the next page of the Master: insert 
name of the first Module, and Select Module template. Later on you may add more modules to 
the Course, as well as Chapters. 

 



Course is created. Click Close button to finish working on the New Course Wizard. 

 

4.3 Editing Module 
Editing module include following tasks: 

 Editing Title-Slide  
 Editing Master-Slide  
 Editing Slides  
 Preview Module  
 Adding Slides 

4.3.1 Editing Title-Slide 

To turn On Title-Slide editing mode use View -> Title-Slide sub-menu or quick switching button 
in the Slide's Panel. 



 

 

You may change picture, Logo, insert Module name and Instructions prior to presenting 
Module, and so on. If necessary, you can modify the look of Start button. Start button can be 
displayed in two ways: Inactive (displayed from the moment system starts loading the Module 
up until Module is loaded) and Active (displayed when the code for the Module is loaded) - 
arrange the necessary pictures in Graphic Editor and change corresponding pictures using Edit 
Object context Menu option. 

LIMITATION: Title-Slide introduction appears on the screen before the system loads all of 
the Course Player files necessary for Module and Objects functionality, therefore only the 
limited number of the objects such as pictures, text blocks, auto shapes, and special 
objects from Title folder, which do not require Course Player, can be employed. Links, 
banners, animation effects and other events are not functioning on Title-Slide. Except for 
mentioned above WYSIWYG editing mode is used for editing Title-Slide. 

4.3.2 Editing Master-Slide 

To turn On Master-Slide editing mode use View -> Master-Slide sub-menu or quick switching 
button in the Slide's Panel. 

 

 

  



If required, change/replace pictures on the Master-Slide, insert Logo, specify Module's name, 
and so on. The appearance of the objects on the Master-Slide can be modified with respect to 
overall design of the Module. 

LIMITATION: Since Master-Slide is simply background for other Slides, therefore links, 
banners, animation effects, and events are disabled. Besides that, there is a limitation 
on using Objects: you can only use pictures, text blocks, auto shapes and special objects 
from the Navigation folder. All other Master-Slide editing features are based on 
WYSIWYG editing mode. 

4.3.3 Editing Slide 

To turn On Regular Slide editing mode use View -> Normal sub-menu or quick switching button 
in the Slide's Panel. 

 

 

  

The following settings of the Slide can be edited: 

 Name of a Slide  
 Selecting Master-Slide  
 Slide Content  
 Slide Comments  
 Slide Transition  

4.3.3.1 Name of a Slide 



 

Usually, the name of a Slide reflects the main topic of a Slide. 
The name of a Slide appears on every Frame of this Slide (in 
case Master Slide has a corresponding object Slide Name, which 
enables display of this text). Besides that, the name of a Slide is 
mentioned in the table of contents of the Module (again, if 
Master Slide has the corresponding Heading objects defined) 
even if the name is not displayed on the Slide itself. 

By default, newly created Slide is titled as Untitled. In order to 
change the name of a Slide, right click on it and choose 
Rename... option from Context menu. 

Limitation: The newly edited name of a Slide will not be 
displayed right away in edit mode; but it will be visible in 
the viewing mode. 

 

4.3.3.2 Selecting Master-Slide 

 

The Learning Module may contain several Master-Slides. 

By Default, in the process of building a Module every newly 
created Slide is linked to the first Master-Slide from the list, 
regardless of number of Master-Slides for this Module. 

You can modify Master-Slide which is the foundation for 
associated Slide while in editing mode: Right click on the Slide 
from the Slide Panel and select Master-Slide option from the 
context menu. In the pop-up window make a selection of 
desired Identifier from the list of Master-Slides. 

Note, that every newly created Slide is based on the Master-
Slide, which is associated with the previous Slide. For example, 
the foundation for new Slide 11 will be the Master-Slide of Slide 
10. 

  

4.3.3.3 Slide Content 

To insert pictures, texts, and objects into the Frame of the Slide, Insert -> Picture, Insert -> Text 
Box, and Insert -> Object... sub-menus can be used, or corresponding toolbar buttons. Complex 
objects can be inserted directly from the Object Library either by double-clicking on the 
selected objects or by dragging and dropping the object into the working area.  



 

Please refer to the Positioning Objects section of this document for more details on the 
specifics of object allocation. 

4.3.3.4 Slide Comments 

 

Slide Comments is additional text block that can be attached to 
the Slide. It can contain author's comments and remarks to the 
Slide, or comments to the Slide that imported from PowerPoint 
presentation. 

Slide Comments is not part of viewable Slide area, and it is not 
an object, therefore it cannot be displayed as usual text object. 
Special objects are used to display comments to learner (please 
refer to Complex Objects - Navigation section). 

To add or edit comments to the Slide right click on the Slide from 
the Slide Panel and select Comments option from the context 
menu. RichText editing window will appear. Edit the text. 

Please note, that PowerPoint makes comments white by default, 
therefore imported comments may be invisible (white on white). 

4.3.3.5 Slide Transition 
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By default, it is assumed that Transition to the next Slide will be 
performed by using Next Slide Button or other user-activated 
navigations. Apparently, this is the most common situation 
when the user is in control of the timing for observing the Slide. 

But there are instances when timing must be set to Transition 
to the next Slide regardless of the action from the user. In order 
to change default Transition settings, right click on the target 
Slide icon from the Slide Panel and select Advance... option 
from the context menu. 

In the open window select Wait for Action or Immediate. 

Please refer to the Actions section of this document for other 
methods of programming Slide transitions. 

4.3.4 Adding Slides 

Once the Module is created - it already contains the Slide. 

Add text, pictures, and complex objects according to the course scenaio. 

To add a new slide, select Insert -> New Slide, or use context menu in Slides Pane. Add as many 
slides as you need, and place a learning content on them. 
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You can always adjust position of the Slide: left click on the Slide thumbnail image that you 
would like move and drag this Slide to the desired location while holding down the left mouse 
button. 

4.3.5 Preview Module 

During editing you always can preview module to see how it will be showed by Web Browser. 

To preview entire module select Module -> View Module (or press F5).  

 

Module will be loaded into separate Web Browser window of defined size. 

To preview editing slide select Module -> View Slide (or press Shift+F5). 

 

Module will be loaded into separate Web Browser window of defined size and automatically 
advances to selected slide. 

4.4 Adding Modules 
Upon creation new Learning Course it contains only single Module. In case it is not enough, you 
can add required number of Modules and group them into the Chapters. 

To add new Module to the Course you can either select File -> New -> Module... or use context 
menu by right clicking on the name of the Course from the Course Pane. Add required number 
of Modules and fill them with the learning content. 



 

 

To change Module's order do the following: in the Course Pane drag Module with the mouse 
button to the parent element (Course or Chapter). Dragged Module will be placed at the end of 

the list. 

4.5 Adding Chapters 
Upon creation new Learning Course it contains only single Module, which is not placed in the 
Chapter. As the number of the Modules increases, it might be necessary to group Modules into 
the Chapters. 

To add new Chapter to the Course you can either select File -> New -> Folder or use context 
menu by right clicking on the name of the Course from the Course Pane. Add required number 
of Chapters and fill them with the learning content. 



 

 

To change Chapter's order do the following: in the Course Pane drag Chapter with the mouse 
button to the parent element (Course or Chapter). Dragged Chapter will be placed at the end of 
the list. 

4.6 Publish Course 
After completing of all editing tasks Course should be published. 

Publishing Course - creation fully functional standalone (separate from CourseLab) version of 
the Learning Course intended for distribution on CD, in the Learning Management System and 
so on. During publishing only those elements which are required for displaying the Course are 
copied into the separate folder from the folder containing the working version of the Course, 
also some other elements added which are not used for editing, but require for Course display. 
The working version of the Course during publishing remains unchanged. 

Depending on the prospective usage there are different choices of Course publishing: 

 for Launching from the CD  
 for distribution in the LMS, which supports AICC standard  
 for distribution in the LMS, which supports SCORM 1.2 standard  
 for distribution in the LMS, which supports SCORM 2004 standard  
 for further work in CourseLab TeamWork  



Sequence of the publishing steps as follows: 

 Module Runtime Settings  
 Course Runtime Settings  
 Course Publication Wizard  

4.6.1 Module Runtime Settings 

Prior to publishing it is necessary to specify runtime settings for each Module in the Course. 

Select Module -> Runtime Settings sub-menu. “Module Properties” dialog window opens up. 

 

Select “General” tab and fill in “Identifier” and “Description” fields under “Module 
identification in LMS” section. These parameters will be saved in metadata files which will be 
used to import course structure in LMS. 

Identifier is a short Module id, which will be used as Module reference code in the Learning 
Management System. Please use Latin characters and numbers for Course and Module code. 
Avoid using spaces and other special symbols. 

Description – brief informal description of the Module, which will be used within Learning 
Management System in the Course card.  



 

Use “Checks” tab to specify names of the software components that need to be checked for 
availability on student’s computer prior to launching Module. 

 

On “Runtime” tab you can specify some Module runtime parameters, such as: 

 Show Title-Slide at Module Startup - if this checkbox is unchecked Title-Slide will be 
automatically skipped.  

 Preload images - allows preloading all images of particular Slide before display. Usually 
this feature causes some delay (with "Loading images" progress bar) before transition to 
the Slide but then all the images of the Slide will be displayed much faster.  



 Allow to view Slides in sequential order only - this feature disables transition on the 
Slide that is unvisited yet and is not the next to last visited Slide in line. Transition to any 
visited Slide is not restricted.  

 Scale module score to 100% - legacy feature. Modern eLearning standards include 
special parameters for raw and scaled score.  

To set Objectives and Rules please read Objectives chapter. 

4.6.2 Course Runtime Settings 

Prior to publishing, it is necessary to specify execution parameters for the Course. 

Select File -> Course Runtime Settings sub-menu. “Course Execution Parameters” dialog 
window opens up. 

 

On “General” tab fill in “Identifier” and “Description” fields under “Course identification in 
LMS” section. These parameters will be saved in metadata files which will be used to import 
course structure in LMS.  

Identifier is a short Course id, which will be used as Course reference code in the Learning 
Management System.  

LIMITATION: Please use Latin characters and numbers for Course and Module 
code. Avoid using spaces and other special symbols. 

Description – brief informal description of the Course, which will be used within Learning 
Management System in the Course card.  
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4.6.3 Course Publication Wizard 

Select File -> Publish Course… sub-menu to start Course publishing.  

 

In case you have not filled in Course and Modules runtime parameters yet, next Wizard screens 
will contain fields for Course and Modules codes and descriptions. 

 

Click Next button. Select desired publication type - standard compliant package or folder for 
CD. 

Use "Run from CD" option for any local (non-LMS) launches. Use autorun.html file as starting 
point. Please note, that browser security settings may block active content from CD and local 
computer. 



If you plan to proceed Course editing in CourseLab TeamWork system, select "Upload into 
WebTutor (CourseLab TeamWork)" - course will be uploaded into your server for further work. 

 

Click Next button. Select name of the package (or CD folder) and location where it will be saved. 

 

Click Next button and wait, while your course is published. 



Course is published and saved in given location. 

 

4.6.4 Publication for CD 

This publication option is used to create the course for CD, DVD or any other "local" storage 
type (or for demonstration purposes). The course that is published using this option is not 
intended to support any e-learning standard, therefore it will not send any data to LMS.  

 



Note, that, while the course does not send any data, it is treated by browser as 
"active content" anyway, therefore it can be the subject for browser security 
settings. Playing of active content from local computer and removable drives is 
not allowed by default in some browsers. 

As a result of publication you will get the folder with full uncompressed course structure 
(excluding design time information) and small simple file autorun.html on the top level (see 
example on the picture). This file contains links to all course modules, but does not contain any 
specific design (use any HTML editor if you need to customize its design).  

 

Place the content of this folder on the CD and use autorun.html as starting point. 

4.6.5 Publication for AICC LMS 

This publication option is used to create the AICC standard compliant course package (i.e. ZIP 
archive with course files and AICC metadata files). The course that is published using this option 
can be imported and used in any LMS that supports AICC standard.  



 

Note, that the course published for using in AICC environment will support this 
standard only. 

As a result of publication you will get the ZIP archive, that contains all course runtime files and 
course metadata files. In most cases you do not need to unzip the archive - most of LMS can 
accept ZIP archive for importing. If your LMS cannot import zipped package - unzip the archive 
in specified folder and use course descriptor file (with .crs extension) on the top level of folder 
to import course structure. 

 

  



4.6.6 Publication for SCORM 1.2 LMS 

This publication option is used to create the SCORM 1.2 standard compliant course package (i.e. 
ZIP archive with course files and SCORM metadata files). The course that is published using this 
option can be imported and used in any LMS that supports SCORM 1.2 standard.  

 

Note, that the course published for using in SCORM 1.2 environment will support 
this standard only. 

As a result of publication you will get the ZIP archive, that contains all course runtime files and 
course metadata files. In most cases you do not need to unzip the archive - most of LMS can 
accept ZIP archive for importing. If your LMS cannot import zipped package - unzip the archive 
in specified folder and use imsmanifest.xml file on the top level of folder to import course 
structure. 

 



4.6.7 Publication for SCORM 2004 LMS 

This publication option is used to create the SCORM 2004 standard compliant course package 
(i.e. ZIP archive with course files and SCORM metadata files). The course that is published using 
this option can be imported and used in any LMS that supports SCORM 2004 standard.  

 

Note, that the course published for using in SCORM 2004 environment will 
support this standard only. 

As a result of publication you will get the ZIP archive, that contains all course runtime files and 
course metadata files. In most cases you do not need to unzip the archive - most of LMS can 
accept ZIP archive for importing. If your LMS cannot import zipped package - unzip the archive 
in specified folder and use imsmanifest.xml file on the top level of folder to import course 
structure. 

 



4.6.8 Uploading into CourseLab TeamWork 

This method is used to transfer working copy of the Course into CourseLab TeamWork system 
to allow simultaneous editing by team. 

 

LIMITATION: CourseLab application version must be supported by CourseLab 
TeamWork for successful import. 

On the next Wizard screen fill in CourseLab TeamWork server address, and user login and 
password. 

 



IMPORTANT: User must have privileges to place courses into CourseLab TeamWork 
system. 

Press "Next" button - if all connection parameters are correct and Internet connection is 
present, Course will be uploaded into selected CourseLab TeamWork system.  

4.7 Export Course Outline 
Sometimes it may be useful to get outline of the Course (for demonstration or discussion 
purposes). Export Course Outline is creating "screenshots" for each Slide of the Course.  

To launch Export Course Outline process select menu File -> Export Course Outline.  

 

Export Course Outline Wizard opens up. 

 



Select graphics file format, which will be used for export and select location on the local disk.  

 

Press "Next" button. While exporting, CourseLab will open each Slide and create screenshot. 
Depending on Course complexity, this process may take significant time to complete. 

 

When process is finished, all graphic files will be placed into selected location.  



5. Objects 
Object is the basic element of CourseLab, the building brick of the Learning Module. You may 
construct the Learning Module of any complexity by employing various Objects and building 
relationships among them. 

When you insert the Object of any shape into the Frame it is placed into the Rectangular 
Placeholder. You can change size and orientation of this Rectangular Placeholder. There are 3 
types of Objects allocation within the Rectangular Placeholder:  

 Object that can automatically adjust it’s size to the size of Rectangular Placeholder (For 
example, pictures, and AutoShapes are always resizing it’s height and width to fit the 
Rectangular Placeholder),  

 Object that can resize by itself (autofit to contents depending, for example, on the 
amount of the text)  

 fixed-size Object  

Two main types of Objects are used in the CourseLab for building up learning Module: internal 
and complex.  

Internal Objects are the primary and most frequently used Objects; they are built into the 
CourseLab. In fact, you can create entire learning Module by utilizing only internal Objects such 
as:  

 text (including tables);  
 images;  
 autoshapes. 

Since these types of Objects are the most commonly used, the access to the Editor menu is very 
simple - editing buttons are conveniently located on the toolbar.  

Complex Objects are external to CourseLab and loaded into the CourseLab using the Open 
Object Interface.  

For simulations of software execution the special object Cursor can also be employed.  
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5.1 Text 
Text – embedded into the editor object, which is used for creating areas within a Frame with 
formatted text and tables.  

5.1.1 Using Text 

Inserting Text 

You can add Text to a Frame as follows: select Insert -> Text Box menu option, or choose “Text 
Box” icon from the toolbar. 

 

Area of text appears on the Slide with “Enter Text” instruction on it. 

Alternatively, copy desired text to Clipboard using any text editor and Paste it into the Frame. 
Text Box with copied text will be created automatically. This insertion method is more 
convenient to use in many cases.  

Editing Text 

Using left mouse button, double click on Text Box or use “Edit text” option from the context 
menu to open text editing window. Text Editing Window will open up. 



 

  



5.2 Images 
CourseLab enables insertion of the graphics created by any graphic editor tool into the Slides of 
learning module. Please note that CourseLab itself does not support graphic editing. 

5.2.1 Using Images 

To insert picture into Frame of the learning Module you can either choose "Picture" sub-menu 
within "Insert" menu or use "Insert Picture From File" Icon on the toolbar. Locate the picture 
you need to insert and press "Open" button.  

 

Picture will be inserted into the Slide and file itself will be copied into the “Images” folder of 
learning Module. In case file being copied already exists, the User will be prompted to cancel 
file overwriting.  

LIMITATION: Since Learning Modules can be further used on Internet, all file 
names of the pictures should be web-safe, in particular it is recommended to use 
letters and numbers of Latin alphabet only; no spaces and no special characters. 

5.2.2 Valid Graphic File Formats 

Any internet-friendly graphic file formats can be used in a learning course. Because learning 
courses can be hosted on the Internet, it is strongly recommended that you use small graphic 
files in compressed graphic formats such as GIF, JPG, and PNG. Each format has some 
advantages and disadvantages, which should be taken under consideration. Below is the brief 
overview of these formats.  

GIF (Graphics Interchange Format) 

GIF is the most common format for Internet graphics as it is supported by all Browsers and 
majority of graphic editors. GIFs use a special compression algorithm (limited to 256 or less 
colors and simple linear compression along the horizontal axis) allowing for a very small size of 
graphic file if there are large areas of the same color. It is therefore not suitable for storing 
photos and images with the large grated areas - the stored image will have a large file size and 
poor quality. GIFs support transparency (you can choose a single color in the image that will be 
rendered as invisible, allowing the background to show through when the image is viewed on a 



Web page) but you have to remember that GIF supports only 1-bit transparency: each pixel for 
the given color (so called Alpha Channel )is completely removed.  

The latest version of the GIF format supports animation created by stringing together various 
still images. GIF animation can be used in a learning Module. The CourseLab editor will not play 
a GIF animation – only the first GIF image is displayed on the Slide in editing mode. The GIF 
animation will display properly when the course is published. 

JPG (Joint Photographic Experts Group) 

JPG is one of the most common formats for graphic images on the Internet and is supported by 
all Browsers and most graphic editors. When JPG compression is executed, the source image is 
divided into square blocks with specific color and brightness information (so called 
chrominance/luminance scheme) created for each block, which enables coding of this area. The 
human eye is more sensitive of them to the details of shapes than to color information 
therefore JPG compression reduces color information to Variable size while using 256-grade 
brightness scale. The degree of color information depends on the user-defined quality setting. 
Having said that, JPG format is very practical for displaying smooth color transitions and well 
suited for compressing photos and pictures with high color gradient areas. However, if the 
source image has multiple contrasting color changeovers, the compressed image will degrade 
depending on the level of compression (there will be mottled areas around color’s edges). JPG 
allows the user to choose the balance between file size and image quality but choosing a higher 
quality can make the file size very large and slow to upload. Most Internet graphics are set to 72 
dots per inch (dpi). Unlike GIFs, the JPEG format does not support transparency. 

PNG (Portable Network Graphics) 

The Portable Network Graphics (PNG) format was designed to replace the older and simpler GIF 
and JPG formats. When saving at an 8-bit depth (PNG-8)the format is comparative to GIF (in 
general, it provides about 15% better compression ratio than GIF, since PNG-8 performs 
compression along both horizontal and vertical axes). When saving to a 24-bit depth (PNG-24), 
the format provides high-quality color changeovers and a very good level of file compression. 
PNG supports transparency and preserves the quality of the color changeovers regardless of 
the underlying color. The only disadvantage of the PNG format is that it has limited support in 
older versions of Internet Browsers and limited support by some graphic editors. Nevertheless, 
since the older versions of Browsers are not supported in CourseLab Courses, we encourage 
using this format if possible.  

Other Formats 

You can use other graphical formats which are supported by Internet Browsers, such as BMP, 
WMF, and others. However, consider the fact that some Browsers display these formats 
incorrectly. Besides, BMP files (and other non-compressed formats) are very large in size. The 
choice is yours - if you are confident that images will be displayed correctly and network traffic 
permits it – you may use these types of format in your Course.  

5.2.3 Optimizing Pictures 



Change the Size of Picture 

Once picture is inserted, you may format picture within CourseLab using controls on “Size” tab 
on the “Format Picture” dialog window. 

 

Things to consider: 

 By enlarging the picture you are not increasing the amount of information stored in the 
image file, therefore the quality will definitely suffer.  

 The browser’s formatting capability that is used for minimizing pictures is far from 
perfect if compared to graphic editing tools. Besides that, remember that any 
formatting changes you apply to Slide’s picture will not affect the size of the loaded 
image file.  

Therefore we do not recommend making significant changes to the format of the picture when 
editing a Slide.  

Optimizing Pictures 

After the picture is inserted and its size is changed to fit Slide layout it is recommended to 
optimize file size of picture. Use Tools -> Compress Images menu to optimize Module image 
files.  



 

All scaled pictures in Module will be automatically resized to fit user-defined width and height 
exactly with maximal possible picture quality and re-saved. Besides, pictures in BMP, WMF, 
EMF formats will be converted and re-saved in PNG format to minimize file sizes.  

5.2.4 Clip Art Pane 

For inserting frequently used pictures it is very convenient to use Clip Art Pane in the tasks area. 
It displays images thumbnails from the folder on the computer. To add picture into the Slide, 
drag image thumbnail into the working area.  

Unlike using the Insert From File menu, the above mentioned picture inserting method 
eliminates the inconvenience of specifying the path to the picture file each time within “Open” 
dialog box.  

Use Insert -> Picture -> Clip Art … sub-menu to start using Images collection or "Insert Clip Art 
Icon" in the toolbar. In the right part of the main editor window, tasks area will open up 
displaying the selected pane “Clip Art”.  

 

Click “Browse…” link at the bottom of the Clip Art Pane to specify folder containing pictures 
which will be accessible from the Clip Art Pane. In the opened “Select Folder” dialog box, select 
folder containing pictures. 



 

To place picture on the slide simply drag and drop image icon into slide area. 

  



5.3 Complex Objects 

5.3.1 Rapid Development 

5.3.1.1 Image Gallery 1 (with paging) 

Image Gallery 1 is used for displaying multiple images in one block with "paging", i.e. one by 
one. In case width or height of the image is more than object's image block, images will be 
automatically resized to fit the block. Images that are less than image block will be displayed "as 
is" (no scaling). If allowed, user also can click the image to open original size picture in separate 
window. 
 
Example of object appearance:  
 

 

There are 4 configurable zones in the Object: 

 Background (blue on the picture).  

 Images block (white area with gradient where images are displayed).  

 Caption (text block below the image block with text description for each image).  

 Buttons.  

IMPORTANT! Please take in account, that each image will consume time to 
download and computer resources to handle. Though there are no technical 
restrictions on quantity of images in the object, you should consider possible 
learners computer and network restrictions. 

Object parameters 



 

On the "Images" tab you can define the list of images with their descriptions and optional 
sound files for each image, transition effects. Display original image in separate window 
checkmark allows opening original image. 

Use "+" button to open image properties dialog. 

 

Select image file and fill Description field. You can also attach sound file to each image (.swf or 
.mp3/.wma/.wav). It will be played when user selects this image. 



 

On the "Images block" tab you can switch displaying of image block on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Description" tab you can switch displaying of descriptions on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Button" tab you can define buttons display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  



 

On the "Background" tab you can switch displaying of background block on and off and define 
its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.1.2 Image Gallery 2 (with icons ribbon) 

Image Gallery 2 (with icons ribbon) is used for displaying multiple images in one block on click 
on icons in the icon ribbon. In case width or height of the image is more than object's image 
block, images will be automatically resized to fit the block. Images that are less than image 
block will be displayed "as is" (no scaling). If allowed, user also can click the image to open 
original size picture in separate window. 

Example of object appearance:  



 

There are 4 configurable zones in the Object: 

 Background (blue on the picture).  

 Images block (white area with gradient where images are displayed).  

 Caption (text block below the image block with text description for each image).  

 Icons block.  

IMPORTANT! Please take in account, that each image will consume time to 
download and computer resources to handle. Though there are no technical 
restrictions on quantity of images in the object, you should consider possible 
learners computer and network restrictions. 

Object parameters 



 

On the "Images" tab you can specify the list of "image-description-sound" blocks and using 
transition effects.  

Use "+" button to open image properties dialog. 

 

Select image file and fill Description field. You can also attach sound file to each image (.swf or 
.mp3/.wma/.wav). It will be played when user selects this image. 



 

On the "Icons block" tab you can switch displaying of icons ribbon on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Images block" tab you can switch displaying of image block on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Caption" tab you can switch displaying of description block on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Background" tab you can switch displaying of background block on and off and define 
its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.1.3 Pointer 

Pointer is used for displaying short and/or long description when learner selects small active 
point on the slide. 

Example of object appearance:  



 

Object parameters 

Object consists of small round active point - pointer, and 2 descriptions (short and long).  

 

On the "Pointer" tab you can define pointer size, colors (one of the predefined color schemes 
or custom), pointer/description position and transition effects.  

Pointer symbol - optional symbol (for example, number).  



 

On the "Description" tab you can select events that will trigger display of descriptions and 
define its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 transition effect.  

 You can also attach sound file to each description (.swf or .mp3/.wma/.wav). It will be 
played when user selects this description.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

  

5.3.1.4 Tab block (leftside tabs) 

Tab block objects are used for displaying group of similar descriptions in one tabbed block.  

Example of object appearance:  



 

Object parameters 

 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 



 

For each element you can define Tab text - short text for element. Description text - Rich Text 
field for full descrioption of the element. Vertical scrolling will be added automatically and 
sound file, which will be played on tab selection. You can add sound file for each Tab. 

Display this tab selected from the start makes current tab "default" tab. If this checkbox is not 
checked at one of the tabs, then None selected text will be displayed in description area at 
object display. If checkbox is checked at more than one tab - first checked tab becomes default, 
others will be ignored. 

Select one of the predefined color schemes or define custom colors for tab/description blocks, 
gradient angle for background, and common display parameters: corner arc sizes and spacings. 

Other params include: 

 tab width (in percent),  

 corner radius - in pixels or relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 border width (in pixels),  

 intertab spacing.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.1.5 Tab block (top tabs) 

Tab block objects are used for displaying group of similar descriptions in one tabbed block.  

Example of object appearance:  



 

Object parameters 

 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 



 

For each element you can define Tab text - short text for element. Description text - Rich Text 
field for full descrioption of the element. Vertical scrolling will be added automatically and 
sound file, which will be played on tab selection. You can add sound file for each Tab. 

Display this tab selected from the start makes current tab "default" tab. If this checkbox is not 
checked at one of the tabs, then None selected text will be displayed in description area at 
object display. If checkbox is checked at more than one tab - first checked tab becomes default, 
others will be ignored. 

Select one of the predefined color schemes or define custom colors for tab/description blocks, 
gradient angle for background, and common display parameters: corner arc sizes and spacings. 

Other params include: 

 tab height (in percent),  

 corner radius - in pixels or relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 border width (in pixels),  

 intertab spacing.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.1.6 Tab block (with buttons) 

Tab block objects are used for displaying group of similar descriptions in one tabbed block.  

Example of object appearance:  



 

Object parameters 



 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 



 

For each element you can define Tab text - short text for element. Description text - Rich Text 
field for full descrioption of the element. Vertical scrolling will be added automatically and 
sound file, which will be played on tab selection. You can add sound file for each Tab. 

Display this tab selected from the start makes current tab "default" tab. If this checkbox is not 
checked at one of the tabs, then None selected text will be displayed in description area at 
object display. If checkbox is checked at more than one tab - first checked tab becomes default, 
others will be ignored. 

Select one of the predefined color schemes or define custom colors for tab/description blocks, 
gradient angle for background, and common display parameters: corner arc sizes and spacings. 

Other params include: 

 tab height (in percent),  

 corner radius - in pixels or relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 border width (in pixels),  

 interbutton spacing.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.1.7 Tab block (accordion) 

Tab block objects are used for displaying group of similar descriptions in one tabbed block.  

Example of object appearance:  



 

Object parameters 

 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 



 

For each element you can define Tab text - short text for element. Description text - Rich Text 
field for full descrioption of the element. Vertical scrolling will be added automatically and 
sound file, which will be played on tab selection. You can add sound file for each Tab. 

Display this tab selected from the start makes current tab "default" tab. If this checkbox is not 
checked at one of the tabs, then None selected text will be displayed in description area at 
object display. If checkbox is checked at more than one tab - first checked tab becomes default, 
others will be ignored. 

Select one of the predefined color schemes or define custom colors for tab/description blocks, 
gradient angle for background, and common display parameters: corner arc sizes and spacings. 

Other params include: 

 tab height (in pixels),  

 corner radius - in pixels or relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 border width (in pixels),  

 intertab spacing.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.1.8 Tab block (timeline) 

Tab block objects are used for displaying group of similar descriptions in one tabbed block.  

Example of object appearance:  



 

Object parameters 

 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 



 

For each element you can define Tab text - short text for element. Description text - Rich Text 
field for full descrioption of the element. Vertical scrolling will be added automatically and 
sound file, which will be played on tab selection. You can add sound file for each Tab. 

Display this tab selected from the start makes current tab "default" tab. If this checkbox is not 
checked at one of the tabs, then None selected text will be displayed in description area at 
object display. If checkbox is checked at more than one tab - first checked tab becomes default, 
others will be ignored. 

Select one of the predefined color schemes or define custom colors for tab/description blocks, 
gradient angle for background, and common display parameters: corner arc sizes and spacings. 

Other params include: 

 tab height (in percent),  

 corner radius - in pixels or relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 border width (in pixels),  

 intertab spacing.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.1.9 Managed tab block vertical 

Tab block objects are used for displaying group of similar descriptions in one tabbed block. This 
type of Object its own Controls ribbon with Next/Previous buttons. 

Example of object appearance:  



 

Object parameters 

 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 



This Object can restore its state, i.e. when learner returns to the Slide it will see Object in the 
same state.  

 

Tab text - short text that will be displayed on the Tab. Description - full text that will be 
displayed in Description Area of the Object when corresponding Tab is selected. This is Rich 
Text field - it can contain pictures, tables, links etc. Scroll bar will be added automatically when 
text size will exceed Description Area size. For each element you can define sound file with 
narration. 

Display this tab selected from the start checkbox allows displaying this Tab selected from the 
start (and also displaying its preview in Edit mode). In case no Tab is selected first Tab will be 
selected by default. In case more than one Tab is selected - first selected Tab will be active, 
others will be ignored. 



 

Select color schemes for idle and selected states - one of predefined or custom. You can also 
lighten or darken colors of selected color schemes. Change tab width (in percents of full Object 
width) and Tab font settings. 



 

On the Controls tab you can change display parameters for Controls ribbon and buttons or 
switch it off.  



 

On Descriptions tab you can change display parameters for Description Area.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius,  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon  

on Item Displayed On every tab selection 

on First Item Displayed When first tab is selected 

on Last Item Displayed When las tab is selected 

on All Items Displayed When last unvisited tab is selected. Note that this event fires only once. 

  



Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

NEXT ITEM Selects next tab (if applicable) 

PREVIOUS ITEM Selects previous tab (if applicable) 

DISPLAY Selects tab that is selected in method parameter, starting from 1 (if applicable). 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

item Number of current opened tab (starting from 1) $OBJ_ID.item 

allVisited Returns "1" if all tabs have been visited, "0" otherwise. $OBJ_ID.allVisited 

5.3.1.10 Managed tab block "Sequence" 

Tab block objects are used for displaying group of similar descriptions in one tabbed block. This 
type of Object its own Controls ribbon with Next/Previous buttons. 

The main feature of this Object is its ability to group elements. 

Example of object appearance:  

 

Object parameters 



 

On the "Elements" tab you can define list of groups, elements in groups and their descriptions.  

This Object can restore its state, i.e. when learner returns to the Slide it will see Object in the 
same state.  

In the Group Edit dialog you can fill in all elements for this group, its color scheme. 



 

 

Tab text - short text that will be displayed on the Tab. Description - full text that will be 
displayed in Description Area of the Object when corresponding Tab is selected. This is Rich 
Text field - it can contain pictures, tables, links etc. Scroll bar will be added automatically when 
text size will exceed Description Area size. For each element you can define sound file with 
narration. 

Display this tab selected from the start checkbox allows displaying this Tab selected from the 
start (and also displaying its preview in Edit mode). In case no Tab is selected first Tab will be 
selected by default. In case more than one Tab is selected - first selected Tab will be active, 
others will be ignored. 



 

Select color schemes for idle and selected states - one of predefined or custom. You can also 
lighten or darken colors of selected color schemes. Change Tab font settings. 



 

On the Controls tab you can change display parameters for Controls ribbon and buttons or 
switch it off.  



 

On Descriptions tab you can change display parameters for Description Area.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius,  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon  

on Item Displayed On every tab selection 

on First Item Displayed When first tab is selected 

on Last Item Displayed When las tab is selected 

on All Items Displayed When last unvisited tab is selected. Note that this event fires only once. 

  

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

NEXT ITEM Selects next tab (if applicable) 

PREVIOUS ITEM Selects previous tab (if applicable) 

DISPLAY Selects tab that is selected in method parameter, starting from 1 (if applicable). 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

group Current group number (starting from 1) $OBJ_ID.group 

item Current tab number inside the group (starting from 1) $OBJ_ID.item 

allVisited Returns "1" if all tabs have been visited, "0" otherwise. $OBJ_ID.allVisited 

5.3.1.11 Managed tab block "Accordion" 

Tab block objects are used for displaying group of similar descriptions in one tabbed block. This 
type of Object its own Controls ribbon with Next/Previous buttons. 

Example of object appearance:  

 

Object parameters 



 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 

This Object can restore its state, i.e. when learner returns to the Slide it will see Object in the 
same state.  

 

Tab text - short text that will be displayed on the Tab. Description - full text that will be 
displayed in Description Area of the Object when corresponding Tab is selected. This is Rich 
Text field - it can contain pictures, tables, links etc. Scroll bar will be added automatically when 
text size will exceed Description Area size. For each element you can define sound file with 
narration. 



Display this tab selected from the start checkbox allows displaying this Tab selected from the 
start (and also displaying its preview in Edit mode). In case no Tab is selected first Tab will be 
selected by default. In case more than one Tab is selected - first selected Tab will be active, 
others will be ignored. 

 

Select color schemes for idle and selected states - one of predefined or custom. You can also 
lighten or darken colors of selected color schemes. Change Tab font settings. 



 

On the Controls tab you can change display parameters for Controls ribbon and buttons or 
switch it off.  



 

On Descriptions tab you can change display parameters for Description Area.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius,  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon  

on Item Displayed On every tab selection 

on First Item Displayed When first tab is selected 

on Last Item Displayed When las tab is selected 

on All Items Displayed When last unvisited tab is selected. Note that this event fires only once. 

  

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

NEXT ITEM Selects next tab (if applicable) 

PREVIOUS ITEM Selects previous tab (if applicable) 

DISPLAY Selects tab that is selected in method parameter, starting from 1 (if applicable). 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

item Number of current opened tab (starting from 1) $OBJ_ID.item 

allVisited Returns "1" if all tabs have been visited, "0" otherwise. $OBJ_ID.allVisited 

5.3.1.12 Managed tab block "Process" 

Tab block objects are used for displaying group of similar descriptions in one tabbed block. This 
type of Object its own Controls ribbon with Next/Previous buttons. 

Example of object appearance:  

 

Object parameters 



 

On the "Elements" tab you can define list of elements and its descriptions in the displaying 
order. 

This Object can restore its state, i.e. when learner returns to the Slide it will see Object in the 
same state.  

 

Tab text - short text that will be displayed on the Tab. Description - full text that will be 
displayed in Description Area of the Object when corresponding Tab is selected. This is Rich 
Text field - it can contain pictures, tables, links etc. Scroll bar will be added automatically when 
text size will exceed Description Area size. For each element you can define sound file with 
narration. 



Display this tab selected from the start checkbox allows displaying this Tab selected from the 
start (and also displaying its preview in Edit mode). In case no Tab is selected first Tab will be 
selected by default. In case more than one Tab is selected - first selected Tab will be active, 
others will be ignored. 

 

Select color schemes for idle and selected states - one of predefined or custom. You can also 
lighten or darken colors of selected color schemes. Change Tab font settings. 



 

On the Controls tab you can change display parameters for Controls ribbon and buttons or 
switch it off.  



 

On Descriptions tab you can change display parameters for Description Area.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius,  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon  

on Item Displayed On every tab selection 

on First Item Displayed When first tab is selected 

on Last Item Displayed When las tab is selected 

on All Items Displayed When last unvisited tab is selected. Note that this event fires only once. 

  

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

NEXT ITEM Selects next tab (if applicable) 

PREVIOUS ITEM Selects previous tab (if applicable) 

DISPLAY Selects tab that is selected in method parameter, starting from 1 (if applicable). 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

item Number of current opened tab (starting from 1) $OBJ_ID.item 

allVisited Returns "1" if all tabs have been visited, "0" otherwise. $OBJ_ID.allVisited 

5.3.1.13 Guide Mark 

Guide Mark objects are used in conjunction with Guided Image object to mark image key points. 
This object is visible in Edit mode only. 

Examples of object appearance in Edit mode (note Guide Marks on the Image):  

 

Object parameters 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/v_rapid_008.html


 

The only Object parameter is color - you can change it in contrast to Image colors. 

5.3.1.14 Guided Image 

Guided Image object is used to display Image with descriptions to Image's key points. This 
Object needs Guide Mark Objects to mark Image's key points. This type of Object its own Controls 
ribbon with Next/Previous buttons. 

Examples of object appearance in Edit mode (note Guide Marks on the Image): 

 

The same Object in real Course looks different - Guide Marks are not visible, but arrow from 
Description Area points exactly to the one of the Guide Marks: 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/v_rapid_007.html
file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/v_rapid_007.html


 

Object parameters 

 

On the "Image" tab you can define Image file, place of Description Area and list of Guide Mark 
Objects, which will be managed. You can also select arrow color to make it contrast relative to 
the Image. 



Image in the Object area is scaled according to selected Image scaling type - select appropriate 
depending on Image width and height proportions. Note that in some cases image clipping may 
occur. 

 By height - Image height will be scaled to Object work area height, width will be scaled in the same ratio.  

 By half height - Image height will be scaled to the half of Object work area height, width will be scaled in the same 

ratio.  

 By width - Image width will be scaled to Object work area width, height will be scaled in the same ratio.  

 By half width - Image width will be scaled to the half of Object work area width, height will be scaled in the same 

ratio.  

 No scaling - Image will be displayed in its original size. Note that if Image width or height will exceed work area size 

clipping may occur. 

This Object can restore its state, i.e. when learner returns to the Slide it will see Object in the 
same state.  

 

Guide mark ID - ID of corresponding Guide Mark Object. Description - full text that will be 
displayed in Description Area of the Object when corresponding Guide Mark is selected. This is 
Rich Text field - it can contain pictures, tables, links etc. Scroll bar will be added automatically 
when text size will exceed Description Area size. For each element you can define sound file 
with narration. 

Display this Mark selected from the start checkbox allows displaying this Description selected 
from the start. In case no Mark is selected first element will be selected by default. In case 
more than one Mark is selected - first selected element will be active, others will be ignored. 



 

On the Controls tab you can change display parameters for Controls ribbon and buttons or 
switch it off.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius,  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon  

on Item Displayed On every tab selection 

on First Item Displayed When first tab is selected 

on Last Item Displayed When las tab is selected 

on All Items Displayed When last unvisited tab is selected. Note that this event fires only once. 

  

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

NEXT ITEM Selects next element (if applicable) 

PREVIOUS ITEM Selects previous element (if applicable) 

DISPLAY Selects element that is passed in method parameter, starting from 1 (if applicable). 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

item Number of current selected element (starting from 1) $OBJ_ID.item 

allVisited Returns "1" if all elements have been visited, "0" otherwise. $OBJ_ID.allVisited 

5.3.1.15 Managed controls block 

Managed controls block is used to manage consecutive display of other Objects. In case target 
Objects have its own methods OPEN/CLOSE (for example Pointer), these methods will be used to 
display them, otherwise usual action DISPLAY will be used automatically. 

Example of object appearance:  

 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/005_pointer.html


Object parameters 

 

On the "Elements" tab you can define namaged Objects list and order, in which they will be 
managed. 

This Object can restore its state, i.e. when learner returns to the Slide it will see Object in the 
same state.  

 

Object - ID of the Object to be managed. For each Object you can add sound file with narration. 

Display this element selected from the start checkbox allows displaying this Object visible from 
the start. In case no Object is selected first element will be selected by default. In case more 
than one Object is selected - first selected element will be active, others will be ignored. 



 

On the Controls tab you can change display parameters for Controls ribbon and buttons or 
switch it off.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius,  

 inner margin.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon  

on Item Displayed On every tab selection 

on First Item Displayed When first tab is selected 

on Last Item Displayed When las tab is selected 

on All Items Displayed When last unvisited tab is selected. Note that this event fires only once. 

  

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

NEXT ITEM Selects next tab (if applicable) 

PREVIOUS ITEM Selects previous tab (if applicable) 

DISPLAY Selects tab that is selected in method parameter, starting from 1 (if applicable). 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

item Number of current opened tab (starting from 1) $OBJ_ID.item 

allVisited Returns "1" if all elements have been visited, "0" otherwise. $OBJ_ID.allVisited 

 

  



5.3.2 Data Visualization 

5.3.2.1 Pie chart 

Pie chart (circle diagram) is representing percent distribution of data. Each sector of the 
diagram is proportional to quantity it represents. 

Example of object appearance:  

 

Object parameters 



 

Define the list of sectors on the "Elements" tab. For each data element you can assign color 
scheme, text of sector, description text and its parameters. Please note that sectors are 
displayed exactly in the order they are entered, counterclockwise from "north" direction. Use 
"+" button to open sector properties dialog. 



 

You can use one of predefined color schemes or select custom colors (in this case color values 
from the right part of dialog will be used). 

Element ID - any unique (for this object) sequence of latin characters and numbers (reserved 
for future use, can be blank). 

Numeric value defines angle value for this sector. Actual angle will be calculated automatically 
(sum of umeric values of all sectors will be treated as 360°).  

Element text - short text on the arc inside the sector. Font parameters from right part of the 
dialog will be applied to this text.  

LIMITATION: length of the text arc is quite small, please keep this text as short as 
you can. It cannot be distributed in few lines - one line only. Long texts will be cut. 
Please use description for long texts. 

WARNING: Choosing font parameters please make sure that you have selected 
fonts, which are installed on learners computer. Otherwise browser will use its 
default fonts and object appearance will be distorted. 

Description - any rich text description, that will be displayed in special description block near 
the "pie".  

You can also attach sound file to each sector (.swf or .mp3/.wma/.wav). It will be played when 
user selects this sector. 



Preview description in editor checkbox allows to preview diagram with one of the description 
blocks displayed in edit mode (if this checkmark is set on more than one sector - only first 
description will be displayed).  

 

On the "Description" tab you can switch displaying of description blocks on and off and define 
its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin,  

 event to start display - mouse click or mouse over,  

 display pointer line to element enables display of connecting line between sector and description block,  

 use transitions on description enables using transitions on displaying description block.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.2.2 Pyramid chart 

Pyramid chart is representing hierarchical data. Each level can contain more than one block. It 
is similar to Rings chart (represents the same type of hierarchy). 

Example of object appearance:  

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/010_rings.html


 

Object parameters 

 

Define the list of pyramid levels and level elements (blocks) on the "Elements" tab. For each 
level you can assign color scheme, for each block in level - text of element, description text and 
its parameters. Please note that if there are no blocks defined in level, then it will not displayed 



at all. Top level can have only one block - if more than one block is defined, then only first will 
be displayed. 

WARNING: If no elements defined on current level - level will be displayed as 
empty level. Top level can contain one element only - if more than one is defined, 
only first will be displayed. 

Use "+" button to open level properties dialog. 

 

You can use one of predefined color schemes or select custom colors (in this case color values 
from the right part of dialog will be used). Define font parameters in the right part of the dialog 
- they will be applied to short text on the elements.  

WARNING: Choosing font parameters please make sure that you have selected 
fonts, which are installed on learners computer. Otherwise browser will use its 
default fonts and object appearance will be distorted. 

Add level elements. 



 

Element ID - any unique (for this object) sequence of latin characters and numbers (reserved 
for future use, can be blank). 

Element text - short text on the arc inside the sector. Font parameters from right part of the 
Level dialog will be applied to this text.  

LIMITATION: length of the text arc is quite small, please keep this text as short as 
you can. It cannot be distributed in few lines - one line only. Long texts will be cut. 
Please use description for long texts. 

Description - any rich text description, that will be displayed in special description block near 
the pyramid.  

You can also attach sound file to each element (.swf or .mp3/.wma/.wav). It will be played 
when user selects current element. 

Preview description in editor checkbox allows to preview diagram with one of the description 
blocks displayed in edit mode (if this checkmark is set on more than one sector - only first 
description will be displayed).  



 

On the "Description" tab you can switch displaying of description blocks on and off and define 
its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin,  

 event to start display - mouse click or mouse over,  

 display pointer line to element enables display of connecting line between sector and description block,  

 use transitions on description enables using transitions on displaying description block.  



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.2.3 Rings chart 

Rings chart is representing hierarchical data. Each level can contain more than one sector. It is 
similar to Pyramid chart (represents the same type of hierarchy). 

Example of object appearance:  

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/010_pyramid.html


 

Object parameters 

 

Define the list of pyramid levels and level elements (sectors) on the "Elements" tab. For each 
level you can assign color scheme, for each block in level - text of element, description text and 
its parameters. Please note that if there are no sector elements defined in level, then it will not 



displayed at all. Top level can have only one element - if more than one element is defined, 
then only first will be displayed. Use "+" button to open level properties dialog. 

 

You can use one of predefined color schemes or select custom colors (in this case color values 
from the right part of dialog will be used). Use "+" button to open level element dialog. 

 

Element ID - any unique (for this object) sequence of latin characters and numbers (reserved 
for future use, can be blank). 

Element text - short text on the arc inside the sector. Font parameters from right part of the 
Level dialog will be applied to this text.  

LIMITATION: length of the text arc is quite small, please keep this text as short as 
you can. It cannot be distributed in few lines - one line only. Long texts will be cut. 
Please use description for long texts. 



Description - any rich text description, that will be displayed in special description block near 
the pyramid.  

You can also attach sound file to each element (.swf or .mp3/.wma/.wav). It will be played 
when user selects current element. 

Preview description in editor checkbox allows to preview diagram with one of the description 
blocks displayed in edit mode (if this checkmark is set on more than one sector - only first 
description will be displayed).  

 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin.  



 

On the "Description" tab you can switch displaying of description blocks on and off and define 
its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin,  

 event to start display - mouse click or mouse over,  

 display pointer line to element enables display of connecting line between sector and description block,  

 use transitions on description enables using transitions on displaying description block.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.2.4 Histogram 

Histogram is representing distribution of data. Each column of the histogram is proportional to 
quantity it represents. 

Example of object appearance:  



 

Object parameters 



 

Define the list of columns on the "Elements" tab. For each data element you can assign color 
scheme, text of column, description text and its parameters. Please note that columns are 
displayed exactly in the order they are entered. Use "+" button to open sector properties 
dialog. 

LIMITATION: Transitions work only in Internet Explorer. 



 

You can use one of predefined color schemes or select custom colors (in this case color values 
from the right part of dialog will be used). 

Element ID - any unique (for this object) sequence of latin characters and numbers (reserved 
for future use, can be blank). 

Numeric value defines value for this element. Actual height will be calculated automatically 
depending on selected calculation method.  

Element text - short text inside (or near) the column. Font parameters from right part of the 
dialog will be applied to this text.  

LIMITATION: length of the text area is quite small, please keep this text as short 
as you can. It cannot be distributed in few lines - one line only. Long texts will be 
cut. Please use description for long texts. 

WARNING: Choosing font parameters please make sure that you have selected 
fonts, which are installed on learners computer. Otherwise browser will use its 
default fonts and object appearance will be distorted. 

Description - any rich text description, that will be displayed in special description block near 
the histogram.  

Preview description in editor checkbox allows to preview diagram with one of the description 
blocks displayed in edit mode (if this checkmark is set on more than one sector - only first 
description will be displayed). 



 

On the "Description" tab you can switch displaying of description blocks on and off and define 
its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin,  

 event to start display - mouse click or mouse over,  

 display pointer line to element enables display of connecting line between sector and description block,  

 use transitions on description enables using transitions on displaying description block.  

LIMITATION: Transitions work only in Internet Explorer. 



 

On the "Axes" tab you can switch displaying of histogram axes on and off and define its 
parameters. 



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.2.5 Radar chart 

Radar chart is representing distribution of data in multiple series and by multiple axes.  

Example of object appearance:  



 

Object parameters 

 

Define the list of data series on the "Data series" tab. For all series you can define series type 
and displaying values methods. For each series you can assign color scheme, name of the series, 
description text and its parameters. Please note that series are displayed exactly in the order 



their values are entered, counterclockwise from "north" direction. Use "+" button to open 
series properties dialog. 

 

You can use one of predefined color schemes or select custom colors (in this case color values 
from the right part of dialog will be used). 

Fill in series values by axes. 

Series name - short text in legend. Font parameters from right part of the dialog will be applied 
to this text.  

LIMITATION: length of the text area is quite small, please keep this text as short 
as you can. It cannot be distributed in few lines - one line only. Long texts will be 
cut. Please use description for long texts. 

Description - any rich text description, that will be displayed in special description block near 
the diagram. You can also attach sound file to each series (.swf or .mp3/.wma/.wav). It will be 
played when user selects current element. 

Preview description in editor checkbox allows to preview diagram with one of the description 
blocks displayed in edit mode (if this checkmark is set on more than one sector - only first 
description will be displayed).  



 

On the "Axes" tab you can switch displaying of histogram axes on and off and define its 
parameters. 

There are options for scaling that defined by two checkmarks (Normalize every axis 
independently and Use custom value (**) for 100%): 

 default - none of checkmarks are set (maximum value on all axes is treated as 100%, this 
scale is applied to all axes)  

 Normalize every axis independently (maximum value of each axis is treated as 100%, scale is applied to 

corresponding axis only)  

 Use custom value (**) for 100% (custom value for each axis is treated as 100%, scale is applied to 

corresponding axis only)  



 

On the "Description and legend" tab you can switch displaying of description blocks on and off 
and define its display parameters: 

 color scheme (one of predefined or custom),  

 border width,  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin,  

 event to start display - mouse click or mouse over,  

 display pointer line to element enables display of connecting line between sector and description block,  

 use transitions on description enables using transitions on displaying description block.  

LIMITATION: Transitions work only in Internet Explorer. 



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius - in pixels or in relative units from 0 to 1 (0 corresponds to no arc, 1 corresponds to half of width or 

height - shorter one),  

 inner margin. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

  



5.3.3 External 

5.3.3.1 External File Object 

External File object enables opening external files such as: documents, pictures, movie, etc., in 
a separate Browser window. Example of External File appearance:  

 

What types of files are supported by the Object? 

Object is not limited by the file types. At the same time, Browser restricts opening some of the 
file types; therefore, in a separate Browser window you may open any file which is NOT 
RESTRICTED BY BROWSER. For some conventional file types Object can place the corresponding 
Icon into the Frame. In case of undefined file type, Text document Icon will be displayed.  

Object parameters 

 

After inserting object into Frame, specify path to the file, which you are going to open. Next, 
File will be copied into the images folder of learning Module.  

Input file Caption and choose location of the Caption with respect to position of the Icon.  

Select the activation event to open file: mouse click only on Icon, mouse click only on Caption, 
mouse click either on Icon or on Caption. 

5.3.3.2 External URL 

External URL object is used for opening an external Link in a separate Browser window. The 
exceptional feature of the “External URL” object is an ability to fully control browser settings of 
the window being opened. The settings are: size of the Browser window and Browser 



navigation restrictions (limited availability since Microsoft introduced additional Security 
settings in Windows XP SP2). Example of External URL appearance:  

 

Object parameters 

 

After inserting object into the Frame, specify URL which you are going to open.  

Remove checkmark, in case you prefer not to use standard icon. After “Display Icon” field 
becomes active select desired image, file will be copied into the images folder of learning 
Module. 

Select size for the browser window to be opened, and other settings as appropriate.  

5.3.3.3 IFRAME 

IFRAME object is used for opening an external web-content (from file or distant server) into the 
area on the Frame.  

WARNING! This object must be placed on top of ALL other objects on the Frame - 
otherwise errors may arise due to specific nature of this HTML Element. 

NOTE! This object is capable to load content from other domains, therefore 
browser's security restrictions (i.e. cross-domain security) may apply to this 
object. There's no possibility to override browser security settings from content.  

Example of IFRAME appearance in Edit area:  



 

The same IFRAME in Runtime mode: 

 

Object parameters 



 

After inserting object into the Frame, specify URL or file which you are going to open. Set 
appearance parameters if necessary. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

REPLACE SOURCE  Replaces URL of IFRAME content. 

 

  



5.3.4 Questions 

The current version of CourseLab supports the following types of questions:   

You can insert a separate question of certain type as well as test (using Test Object) which 
contains combination of the above listed questions. 

5.3.4.1 True-False 

True-False Question object enables user to choose one correct item from two predefined 
possible answers. 

LIMITATION: No more than one question on the Slide is recommended. 

Example of object appearance:  

 

Object parameters 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/q_099_test.html


 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in.  

Select variants layout, order and correct variant. Note, that the object allows to use different 
weights for each variant (corresponding scoring type must be selected). 



 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts for this type of question is always 1.  

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  

3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  



 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 

In case of the credited question the following options are available:  

1. Scoring type. There are 3 options for this question type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list).  

o Variant weight - in case of correct answer, weight of variant will be placed to all 
objectives (for question with no correct answer only). 

2. Weight of question/attempt – base for calculating score.  



3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner - horizontal and vertical offsets). 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 



 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Change Selection User changes selected item  

on Attempt At the moment of answer acceptance, but before answer evaluation 



on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "truefalse" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

questionValue Returns current question value (string values -" true" or "false"). $OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

5.3.4.2 Single choice 

Single Choice Question object enables user to choose one correct item from a list of possible 
answers. 

LIMITATION: No more than one question on the Slide is recommended.   

Example of object appearance:  

 

Object parameters 



 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in. 

Use "+" button to specify possible answers as many as needed. In the opened sub-dialog screen 
press “TE” button of the corresponding field and insert text of the possible answer. Select 
checkbox for correct answer. 

LIMITATION: No more than one answer should be marked as the correct, 
otherwise result will be incorrect.  

Select “Shuffle variants on display” check box in case you want answers to be displayed in 
random order. Otherwise, answers will be displayed in order they were inserted. Use “Up” and 
”Down” arrows to change order.  



 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. In case number of attempts is not supposed to be defined automatically (i.e. checkbox 

“Define automatically” is not checked), “Number of Attempts” field is available for input. There you can specify the 
number with respect to the level of question complexity or testing methodology. The following formula is used for 

Automatic attempts calculation: number of attempts equals to number of possible answers minus one (for 

example, 3 attempts for question with 4 answers, 4 attempts for questions with 5 answers and so on). In case automatic 
attempts calculation is selected, the number specified in the “Number of Attempts” field is ignored.      

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if "Submit Answer" button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  

3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  



 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 
In case of the credited question the following options are available:  

1. Scoring type. There are 3 options for this question type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list).  

o Variant weight - in case of correct answer, weight of variant will be placed to all 
objectives (for question with no correct answer only). 



2. Weight of question/attempt – base for calculating score.  

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

 



Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner - horizontal and vertical offsets). 

 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 

 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Change Selection User changes selected item  



on Attempt At the moment of answer acceptance, but before answer evaluation 

on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "choice" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

questionValue Returns current question value (spot values divided by "~": for example, 
"0~1~0~0" - 0 corresponds to empty spot, 1 - to checked spot). Note, that the 
order of spots is always as it was defined in object - no matter shuffled or not. 

$OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.4.3 Multiple select 

Multiple Select Question object enables user to choose one or several correct items from a list 
of possible answers. 

LIMITATION: No more than one Test on the Slide is recommended.   

Example of object appearance:  



 

Object parameters 



 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in. 

Use "+" button to specify possible answers as many as needed. In the opened sub-dialog screen 
press “TE” button of the corresponding field and insert text of the possible answer. Select 
checkbox for correct answer. 

Select “Shuffle variants on display” check box in case you want answers to be displayed in 
random order. Otherwise, answers will be displayed in order they were inserted. Use “Up” and 
”Down” arrows to change order.  



 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. In case number of attempts is not supposed to be defined automatically (i.e. checkbox 

“Define automatically” is not checked), “Number of Attempts” field is available for input. There you can specify the 
number with respect to the level of question complexity or testing methodology. The following formula is used for 

Automatic attempts calculation: number of attempts equals to number of possible answers minus one (for 

example, 3 attempts for question with 4 answers, 4 attempts for questions with 5 answers and so on). In case automatic 
attempts calculation is selected, the number specified in the “Number of Attempts” field is ignored.      

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  

3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  



 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 

In case of the credited question the following options are available:  

1. Scoring type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list).  

o Sum of variant weights - sum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  



o Max of variant weights - maximal weight of all selected variant weights will be placed 
to all objectives (for question with no correct answer only).  

o Min of variant weights - minimum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of variant weights - average of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of all variant weights - sum of all selected variant weights regarding full number 
of variants will be placed to all objectives (for question with no correct answer only).  

2. Base weight of a question/attempt – base number of points for the question (or attempt for regression 

method). This number is used to calculate the Total score for the question. If fixed crediting method is used, the base 
weight of question equals the total score.         

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  



 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner)   Note, that there is a check box 
displayed next to every Edit button for the text feedback; it enables to turn On/Off display of 
feedback messages in CourseLab Editor. By default, all check boxes are empty to avoid 
overloading the question Object with too many details. 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 

 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Change Selection User changes selected item  



on Attempt At the moment of answer acceptance, but before answer evaluation 

on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "select" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

questionValue Returns current question value (spot values divided by "~": for example, 
"0~1~1~0" - 0 corresponds to empty spot, 1 - to checked spot). Note, that the 
order of spots is always as it was defined in object - no matter shuffled or not. 

$OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.4.4 Ordered items 

Ordered Items types of questions require from the user to specify the right order of presented 
items. 

LIMITATION: No more than one question on the Slide is recommended. 

Example of object appearance:  



 

Object parameters 



 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in. 

Use "+" button to specify possible answers as many as needed. In the opened sub-dialog screen 
press “TE” button of the corresponding field and insert text of the variant.  

Note, that for this type of question the correct Order of Items will be the order specified by 
author. Question items are ALWAYS presented randomly to the user. Use “Up” and ”Down” 
arrows to change items order.  



 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. In case number of attempts is not supposed to be defined automatically (i.e. checkbox 

“Define automatically” is not checked), “Number of Attempts” field is available for input. There you can specify the 
number with respect to the level of question complexity or testing methodology. The following formula is used for 

Automatic attempts calculation: number of attempts equals to number of possible answers minus one (for 

example, 3 attempts for question with 4 answers, 4 attempts for questions with 5 answers and so on). In case automatic 
attempts calculation is selected, the number specified in the “Number of Attempts” field is ignored.      

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  

3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  



 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 

In case of the credited question the following options are available:  

1. Scoring type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list).  

o Sum of variant weights - sum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  



o Max of variant weights - maximal weight of all selected variant weights will be placed 
to all objectives (for question with no correct answer only).  

o Min of variant weights - minimum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of variant weights - average of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of all variant weights - sum of all selected variant weights regarding full number 
of variants will be placed to all objectives (for question with no correct answer only).  

2. Base weight of a question/attempt – base number of points for the question (or attempt for regression 

method). This number is used to calculate the Total score for the question. If fixed crediting method is used, the base 
weight of question equals the total score.         

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  



 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner)   Note, that there is a check box 
displayed next to every Edit button for the text feedback; it enables to turn On/Off display of 
feedback messages in CourseLab Editor. By default, all check boxes are empty to avoid 
overloading the question Object with too many details. 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 

 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Item Moved User moves any item  



on Attempt At the moment of answer acceptance, but before answer evaluation 

on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "range" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

questionValue Returns current question item order (spot numbers starting from 0 divided by 
"~": for example, "3~1~0~2" - "0~1~2~3" in this case corresponds to correct 
order).  

$OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.4.5 Numerical fill-in-blank 

Numerical fill-in-Blank Questions require from the user to enter the correct number into the 
answer field using keyboard. 

LIMITATION: No more than one question on the Slide is recommended.   

Example of object appearance:  

 

Object parameters 



 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in.  

Specify the approximate length of the entry field in symbols. We recommend allowing some 
extra space for that purpose. For example, if desired answer is 3.224 then the field size is 5 
symbols (including decimal point). We recommend using double size of the desired length (4 
symbols in this example) so that user does not get a hint about the correct answer. 

If necessary, enter description message for the answer field. Description message appears to 
the left of the answer field and may contain for example, units of measure for the answer.  

Specify conditions for the correct answer. Use "+" menu button to add conditions to the list of 
conditions menu as many as needed. In the opened sub-dialog screen fill in the list of 
conditions for validating an answer. In the simple case only single condition is used (for 
example, when entered answer must exactly match some number). 



In case you need to specify the interval of numbers (for example when the answer should be 
the number in the range of 7 to 8) you should specify two conditions: a) greater than 7 b) less 
than 8. Therefore any number in the range of 7 to 8 (excluding 7 and 8 otherwise different 
conditions should be used: greater or equal to 7 AND less or equal to 8) will be treated as 
correct answer.  

IMPORTANT! When user’s response is checked, there is no difference whether 
comma or dot symbols are used as a decimal separator. However, for specifying 
the correct answer in CourseLab editor, it is recommended to use decimal POINT.  

 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. “Number of Attempts” field is always available for input (there is no automatic attempts 

calculation rule). There you can specify the number of answer attempts with respect to the level of question complexity 
or testing methodology.   



2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  

3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  

 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 
In case of the credited question the following options are available:  



1. Scoring type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list). 

2. Base weight of a question/attempt – base number of points for the question (or attempt for regression 

method). This number is used to calculate the Total score for the question. If fixed crediting method is used, the base 
weight of question equals the total score.         

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  



 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner)   Note, that there is a check box 
displayed next to every Edit button for the text feedback; it enables to turn On/Off display of 
feedback messages in CourseLab Editor. By default, all check boxes are empty to avoid 
overloading the question Object with too many details. 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 



 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Attempt At the moment of answer acceptance, but before answer evaluation 



on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "numeric" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

questionValue Returns current question field value (if there is more than one input field, then 
returns string: values delimited by "~").  

$OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.4.6 Text fill-in-blank 

Text Fill-in-Blank types of questions require from the user to fill in the correct answer into the 
blank spaces using the keyboard. In general, entered text can contain numbers, but when user’s 
response is evaluated numbers are interpreted as text characters rather than numbers. 

LIMITATION: No more than one question on the Slide is recommended.   

Example of object appearance:  

 

Object parameters 



 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in. 

Specify the approximate length of the entry field in symbols. We recommend allowing some 
extra space for that purpose.  

If necessary, enter description message for the answer field. Description message appears to 
the left of the answer field and may contain answer format instructions, for example, “Use 
capital letter to answer”.  

Specify conditions for the correct answer. Use "+" menu button to add conditions to the list of 
conditions menu as many as needed. In the opened sub-dialog screen fill in the list of 
conditions for validating an answer. In the simple case only single condition is used (for 
example, when entered answer must exactly match some word). You can also set condition 
“Contain”. In this case entered answer will be validated on whether or not it contains the 



character string specified by author. For example, if “Contain” “point” conditions is set, either 
one of the following words will be considered as correct answers: Pointing, pointless, and 
pinpoint.  

Lastly, you can set the “Match Case” condition to match case when validating the answer. In 
this case, for above mentioned example the word “Pointing” which starts from the capital letter 
will not be considered as correct answer.  

 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. “Number of Attempts” field is always available for input (there is no automatic attempts 

calculation rule). There you can specify the number of answer attempts with respect to the level of question complexity 
or testing methodology.   

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  



3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  

 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 
In case of the credited question the following options are available:  

1. Scoring type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  



o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list). 

2. Base weight of a question/attempt – base number of points for the question (or attempt for regression 

method). This number is used to calculate the Total score for the question. If fixed crediting method is used, the base 
weight of question equals the total score.         

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  



 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner)   Note, that there is a check box 
displayed next to every Edit button for the text feedback; it enables to turn On/Off display of 
feedback messages in CourseLab Editor. By default, all check boxes are empty to avoid 
overloading the question Object with too many details. 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 



 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Attempt At the moment of answer acceptance, but before answer evaluation 



on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "text" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

questionValue Returns current question field value (if there is more than one input field, then 
returns string: values delimited by "~").  

$OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.4.7 Matching pairs (one-to-one) 

Matching Pairs type of questions require from the user to match the provided question items 
on one-to-one basis. 

LIMITATION: No more than one question on the Slide is recommended.   

Example of object appearance:  

IMPORTANT! Matching pairs type of question is space consuming when placed 
into the Frame, therefore we do not recommend setting the width of the object 
to less than 700 pixels. 



 

Object parameters 



 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in. Considering specifics of matching pairs questions, it is not always necessary to display the 
text of the question. Remove corresponding checkmark, in case you want the question text not 
to be displayed.  

Specify variants of matching question items. In the list of answers menu add as many variants 
of matching question items as needed using "+" menu button.  In the opened sub-dialog pairs 
editor screen press “TE” button of the corresponding field and insert text of base item and it’s 
corresponding match, which is in RichText format. Please remember, that there are size 
limitations for entering both the base items and matches, therefore try using short texts and 
small fonts. Inserted question items appear in in the List of items.  If desired, you can edit 
entered items by pressing “Edit” button under the “List” menu. 



Note, that in matching pairs types of questions the correct matching pairs will be the ones 
specified by author. Unlike the question base items, which will be displayed in order they were 
inserted, the matches will ALWAYS be displayed in random order. 

 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. In case number of attempts is not supposed to be defined automatically (i.e. checkbox 

“Define automatically” is not checked), “Number of Attempts” field is available for input. There you can specify the 
number with respect to the level of question complexity or testing methodology. The following formula is used for 

Automatic attempts calculation: number of attempts equals to number of possible answers minus one (for 

example, 3 attempts for question with 4 answers, 4 attempts for questions with 5 answers and so on). In case automatic 
attempts calculation is selected, the number specified in the “Number of Attempts” field is ignored.      

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  



3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  

 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 

In case of the credited question the following options are available:  

1. Scoring type. There are 3 options for this question type:  



o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list).  

o Sum of variant weights - sum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Max of variant weights - maximal weight of all selected variant weights will be placed 
to all objectives (for question with no correct answer only).  

o Min of variant weights - minimum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of variant weights - average of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of all variant weights - sum of all selected variant weights regarding full number 
of variants will be placed to all objectives (for question with no correct answer only).  

2. Base weight of a question/attempt – base number of points for the question (or attempt for regression 

method). This number is used to calculate the Total score for the question. If fixed crediting method is used, the base 
weight of question equals the total score.         

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  



 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner)   Note, that there is a check box 
displayed next to every Edit button for the text feedback; it enables to turn On/Off display of 
feedback messages in CourseLab Editor. By default, all check boxes are empty to avoid 
overloading the question Object with too many details. 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 



 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Item Moved User moves any item  



on Attempt At the moment of answer acceptance, but before answer evaluation 

on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "oto" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

questionValue Returns current match item order (match numbers starting from 0 divided by 
"~": for example, "3~1~0~2" - "0~1~2~3" in this case corresponds to correct 
order).  

$OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.4.8 Matching groups (one-to-many) 

Matching Groups Question require from the user to match the provided question items on 
one-to-many basis. 

LIMITATION: No more than one Test on the Slide is recommended.   

Example of object appearance:  

IMPORTANT! Matching pairs type of question is space consuming when placed 
into the Frame, therefore we do not recommend setting the width of the object 
to less than 700 pixels. 



 

Object parameters 

 



To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in.  

Specify variants of groups and corresponding matching items. In the list of variants add as 
many groups as needed using "+" menu button.  

 

Please remember, that there are size limitations, therefore try using short texts and small fonts. 
If suitable, you can define weight of each "base-match" pair to use it in complex scoring types. 

Unlike the group items, which will be displayed in order they were inserted, the matches will 
ALWAYS be displayed in random order. 

Number of displayes slots on the base restricts maximal number of matches that can be 
attached to base. It can be 0 (no restriction, there will be no match slots on the bases), exact 
number of matches for this group (in fact, this is the hint for user), maximal number of matches 
(i.e. from group with maximal number of matches) and custom. Note, that if the number of 
displayed slots is not 0, then user will see the warning No more slots message when trying to 
attach more matches than defined by this value. 



 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. In case number of attempts is not supposed to be defined automatically (i.e. checkbox 

“Define automatically” is not checked), “Number of Attempts” field is available for input. There you can specify the 
number with respect to the level of question complexity or testing methodology. The following formula is used for 

Automatic attempts calculation: number of attempts equals to number of possible answers minus one (for 

example, 3 attempts for question with 4 answers, 4 attempts for questions with 5 answers and so on). In case automatic 
attempts calculation is selected, the number specified in the “Number of Attempts” field is ignored.      

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  

3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  



 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 
In case of the credited question the following options are available:  

1. Scoring type. There are 3 options for this question type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list).  

o Sum of variant weights - sum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Max of variant weights - maximal weight of all selected variant weights will be placed 
to all objectives (for question with no correct answer only).  



o Min of variant weights - minimum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of variant weights - average of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of all variant weights - sum of all selected variant weights regarding full number 
of variants will be placed to all objectives (for question with no correct answer only).  

2. Weight of question/attempt – base for calculating score.  

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  



 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner)   Note, that there is a check box 
displayed next to every Edit button for the text feedback; it enables to turn On/Off display of 
feedback messages in CourseLab Editor. By default, all check boxes are empty to avoid 
overloading the question Object with too many details. 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 



 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Item Moved User moves any item  

on Attempt At the moment of answer acceptance, but before answer evaluation 



on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "otm" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.4.9 Multiple matching groups (many-to-many) 

Multiple Matching Groups Question require from the user to match the provided question 
items on many-to-many basis. 

LIMITATION: No more than one question on the Slide is recommended.   

Example of object appearance:  

IMPORTANT! This type of question is space consuming when placed into the 
Frame, therefore we do not recommend setting the width of the object to less 
than 700 pixels. 



 

Object parameters 



 

To input question’s text, press “TE” button of the corresponding field. The format of input area 
is RichText, therefore all font settings (size, color, and style) will be saved as you type the text 
in. 

Specify list of groups and corresponding matching items for each group by number in the list of 
matches. 



 

If suitable, you can define weight of each "base-match" pair to use it in complex scoring types. 

Unlike the group items, which will be displayed in order they were inserted, the matches will 
ALWAYS be displayed in random order. 

Number of displayes slots on the base restricts maximal number of matches that can be 
attached to base. It can be 0 (no restriction, there will be no match slots on the bases), exact 
number of matches for this group (in fact, this is the hint for user), maximal number of matches 
(i.e. from group with maximal number of matches) and custom. Note, that if the number of 
displayed slots is not 0, then user will see the warning No more slots message when trying to 
attach more matches than defined by this value. 



 

Use “Limitations” tab to set the following restrictions: 

1. Number of attempts. In case number of attempts is not supposed to be defined automatically (i.e. checkbox 

“Define automatically” is not checked), “Number of Attempts” field is available for input. There you can specify the 
number with respect to the level of question complexity or testing methodology. The following formula is used for 

Automatic attempts calculation: number of attempts equals to number of possible answers minus one (for 

example, 3 attempts for question with 4 answers, 4 attempts for questions with 5 answers and so on). In case automatic 
attempts calculation is selected, the number specified in the “Number of Attempts” field is ignored.      

2. Time limit for the answer. Upon time expiration user will be restricted to make further answer selections, and 

the question will be validated for correctness even if “Submit Answer” button is not pressed. If the correct answer is 
chosen just before time expiration, it will be credited to the user.  

3. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  

4. Possibility to reset stored result and answer the question once again (recurring 
approaches).  



 

Use “Score” tab to specify scoring parameters for the question. The essential CheckBox is 
“Credit Question”. In case it is not marked, all other scoring parameters are disabled, therefore 
they will be ignored when presenting question to the user. Such questions are referred as not 
credited questions. These questions are frequently used to prepare the user for the next Slide 
Topic, to keep the user focused, and so forth. 

In case of the credited question the following options are available:  

1. Scoring type. There are 3 options for this question type:  

o Question weight - in case of correct answer, question weight will be placed in all 
question objectives.  

o Weight by objective - in case of correct answer, different weight will be placed to 
each objective (according to weight in objective list).  



o Sum of variant weights - sum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Max of variant weights - maximal weight of all selected variant weights will be placed 
to all objectives (for question with no correct answer only).  

o Min of variant weights - minimum of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of variant weights - average of all selected variant weights will be placed to all 
objectives (for question with no correct answer only).  

o Avg of all variant weights - sum of all selected variant weights regarding full number 
of variants will be placed to all objectives (for question with no correct answer only).  

2. Weight of question/attempt – base for calculating score.  

3. The following crediting methods can be used:  

o Fixed (Upon the correct response user gets the same score regardless the number of attempts. This score is 

equal to the base weight)  

o Regression method (In this case user is getting the highest possible score for providing the correct answer 

from the first try; the number of points is decreasing on the second try and so forth, until all tries are used). The 

maximum number of points in this case is equal to the base number of points multiplied by the 
number of attempts. Regression method enables more accurate performance evaluation but requires 

applying additional requirements to question parameters. It is important that number of tries for this method 
should not exceed the automatically calculated one (which is number of possible answers minus one), otherwise 
regression method will become ineffective.              

4. Possibility to skip the question. In case this option is selected user is able to ignore the question by pressing “Skip 

Question” button. The author of the course can specify whether or not skipped question will be classified as skipped 
(with opportunity to provide the answer later) or counted as failed (without a chance for another attempt).  



 

Use “Feedback” tab to specify feedback options, which define what shall be displayed upon 
another attempt to respond (correct or incorrect) and after completing the question. 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing. 

You may permit or restrict the feedback messages. You can modify the text of feedback 
messages, which is in RichText format. Feedback messages are displayed in the separate small 
window during Module play back. You can modify display coordinates for this window (the 
coordinates are given relative to the object’s upper left corner)   Note, that there is a check box 
displayed next to every Edit button for the text feedback; it enables to turn On/Off display of 
feedback messages in CourseLab Editor. By default, all check boxes are empty to avoid 
overloading the question Object with too many details. 



 

On the Display, Button and Texts tabs you can select appearance settings for the object and 
edit the information and warning messages. 



 



 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 



on Item Moved User moves any item  

on Attempt At the moment of answer acceptance, but before answer evaluation 

on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

questionMode  Returns current question mode (tokens: "normal", "review"). $OBJ_ID.questionMode 

questionType "mtm" $OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if defined). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if defined). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

attemptsLast  Returns current number of attempts left. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

 

  



5.3.5 Popup 

Such objects as Pop-up windows are used for displaying various explanations to the text on the 
Slide. Basically, text size for explanations is considerably bigger than the one used for the 
similar Balloon type of objects. Therefore, Pop-up window can be activated by clicking on the 
link or button. It does not close automatically, it remains open. Compared to Balloon type of 
object, Pop-up window type has it’s own windows closing mechanism.  

5.3.5.1 Standard Popup Window 

Such objects as Pop-up windows are used for displaying various explanations to the text on the 
Slide. Basically, text size for explanations is considerably bigger than the one used for the 
similar Balloon type of objects. Therefore, Pop-up window can be activated by clicking on the 
link or button. It does not close automatically, it remains open. Compared to Balloon type of 
object, Pop-up window type has it’s own windows closing mechanism.  

Note, that this object is capable to make text substitution in Rich Text. Text substitutions 
can be variable values and object properties. Because Rich Text format is quite complex, 
additional markers for substitution area are used - double curle brackets. Text 
substitutions will be applied only for double curle brackets areas. For example {{$OBJ_19.x}} 
will be substituted by value of X coordinate of OBJ_19 object's top-left corner, and 
{{#att_left}}will be substituted by value of CourseLab variable named att_left. If no 
substitution is found, all double curle brackets area will remain intact. 

Example of object appearance:  

 

Object parameters 



 

Select color scheme for the object. The “Base color” refers to the color of the window title and 
border. The background color for the part of the window containing the main text is usually 
white. Input text for the header and the main part of the window. By default, title text is 
centered and has a font corresponding to the default font of selected learning Module. You can 
change these settings while in editing mode. 

Specify value for text margin. Text margin defines the space between border of the window 
and text block.  

Define window closing rule: it can be closed by clicking on pop-up window “Close” button 
(which looks similar to conventional Windows “Close” button) or by clicking anywhere within a 
pop-up window. Note, you can omit selecting closing rule, but in this case, it will be your 
responsibility to define closing procedure. Depending on the purpose of inserted pop-up 
window, it might be necessary to disable display of pop-up right after Frame loading and define 
actions enabling display of pop-up window.  

If necessary, select display effect for the object. This object can utilize additional efects: zoom in 
and fly in. 

This object can be displayed as modal, i.e. it will be displayed as only active object (all other 
objects will be dimmed). 



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Since object has its own closing mechanism, it is capable of generating the closing Event. While 
building Frame, we can use closing event for initiating various actions. Events are available 
using CourseLab built-in events manipulation mechanism. 

Event Triggered Upon 

on Text 
Refreshed 

After text is refreshed 

on Text Added After text is added 

on Close 
Object 

Right after the moment when user clicks on Popup Close Button (or on the 
window if "Hide window on mouse click" is checked  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

CLOSE TAB Closes the object. 

REFRESH TEXT Refreshes the text in the object, Can be useful if the text contains dynamically changed substitutes. 

ADD TEXT  Adds the text to the current text. Note, that the style of closest paragraph will be used for new text. 



5.3.5.2 Relief Popup Window 

Such objects as Pop-up windows are used for displaying various explanations to the text on the 
Slide. Basically, text size for explanations is considerably bigger than the one used for the 
similar Balloon type of objects. Therefore, Pop-up window can be activated by clicking on the 
link or button. It does not close automatically, it remains open. Compared to Balloon type of 
object, Pop-up window type has it’s own windows closing mechanism.  

Note, that this object is capable to make text substitution in Rich Text. Text substitutions 
can be variable values and object properties. Because Rich Text format is quite complex, 
additional markers for substitution area are used - double curle brackets. Text 
substitutions will be applied only for double curle brackets areas. For example {{$OBJ_19.x}} 
will be substituted by value of X coordinate of OBJ_19 object's top-left corner, and 
{{#att_left}}will be substituted by value of CourseLab variable named att_left. If no 
substitution is found, all double curle brackets area will remain intact. 

Example of object appearance:  

 

Object parameters 

 



Select color scheme for the object. The “Base color” refers to the color of the window title and 
border. The background color for the part of the window containing the main text is usually 
white. Input text for the header and the main part of the window. By default, title text is 
centered and has a font corresponding to the default font of selected learning Module. You can 
change these settings while in editing mode. 

Specify value for text margin. Text margin defines the space between border of the window 
and text block.  

Define window closing rule: it can be closed by clicking on pop-up window “Close” button 
(which looks similar to conventional Windows “Close” button) or by clicking anywhere within a 
pop-up window. Note, you can omit selecting closing rule, but in this case, it will be your 
responsibility to define closing procedure. Depending on the purpose of inserted pop-up 
window, it might be necessary to disable display of pop-up right after Frame loading and define 
actions enabling display of pop-up window.  

If necessary, select display effect for the object. This object can utilize additional efects: zoom in 
and fly in. 

This object can be displayed as modal, i.e. it will be displayed as only active object (all other 
objects will be dimmed). 

 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 



Object Events  

Since object has its own closing mechanism, it is capable of generating the closing Event. While 
building Frame, we can use closing event for initiating various actions. Events are available 
using CourseLab built-in events manipulation mechanism. 

Event Triggered Upon 

on Text 
Refreshed 

After text is refreshed 

on Text Added After text is added 

on Close 
Object 

Right after the moment when user clicks on Popup Close Button (or on the 
window if "Hide window on mouse click" is checked  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

CLOSE TAB Closes the object. 

REFRESH TEXT Refreshes the text in the object, Can be useful if the text contains dynamically changed substitutes. 

ADD TEXT  Adds the text to the current text. Note, that the style of closest paragraph will be used for new text. 

5.3.5.3 Text Popup Window 

Such objects as Pop-up windows are used for displaying various explanations to the text on the 
Slide. Basically, text size for explanations is considerably bigger than the one used for the 
similar Balloon type of objects. Therefore, Pop-up window can be activated by clicking on the 
link or button. It does not close automatically, it remains open. Compared to Balloon type of 
object, Pop-up window type has it’s own windows closing mechanism.  

Note, that this object is capable to make text substitution in Rich Text. Text substitutions 
can be variable values and object properties. Because Rich Text format is quite complex, 
additional markers for substitution area are used - double curle brackets. Text 
substitutions will be applied only for double curle brackets areas. For example {{$OBJ_19.x}} 
will be substituted by value of X coordinate of OBJ_19 object's top-left corner, and 
{{#att_left}}will be substituted by value of CourseLab variable named att_left. If no 
substitution is found, all double curle brackets area will remain intact. 

Example of object appearance:  



 

Object parameters 

 

Select color scheme of the Object. Gradient fill will be created automatically according to 
selected scheme. Enter header text and window text. By default, header is centered and has 
text parameters defined as default for the Module. 

If necessary, select display effect for the object. This object can utilize additional efects: zoom in 
and fly in. 



This object can be displayed as modal, i.e. it will be displayed as only active object (all other 
objects will be dimmed). 

 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Since object has its own closing mechanism, it is capable of generating the closing Event. While 
building Frame, we can use closing event for initiating various actions. Events are available 
using CourseLab built-in events manipulation mechanism. 

Event Triggered Upon 

on Text 
Refreshed 

After text is refreshed 

on Text Added After text is added 

on Close 
Object 

Right after the moment when user clicks on Popup Close Button (or on the 
window if "Hide window on mouse click" is checked  

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

CLOSE TAB Closes the object. 

REFRESH TEXT Refreshes the text in the object, Can be useful if the text contains dynamically changed substitutes. 

ADD TEXT  Adds the text to the current text. Note, that the style of closest paragraph will be used for new text. 

 

  



5.3.6 Balloons 

5.3.6.1 Simple Balloon 

Balloon objects are used for opening various instructions for a text on the Slide. In general, 
amount of text in Balloon instruction is relatively small (smaller than the instructions used for 
the similar Pop-up window types of objects). Balloon object is intended to open up when the 
user’s mouse moves over affected area versa the mouse click and closes when the user’s mouse 
moves away from the active area. Therefore, Balloon types of objects do not have their own 
closing mechanism. Compared to Pop-up window type of object, Balloon objects can have 
pointer arrow.  

Example of object appearance:  

 

Object parameters 

 

Select border color with respect to the overall design of the Slide. Press “Apply” button to 
observe changes. Select direction of arrow pointer and input Balloon text. If necessary, specify 
value for inner margin. Inner margin defines the space between balloon border and the text. 

After you done with parameters settings, place Balloon the way that arrow points right into the 
link or active area. Usually Balloon should open up when the user’s mouse moves over that link 
or active area. 



Depending on the purpose of inserted Balloon, it might be necessary to disable display of 
Balloon right after Frame loading and define onMouseOver and onMouseOut actions enabling 
display of Balloon. 

5.3.6.2 Standard Balloon 

Balloon objects are used for opening various instructions for a text on the Slide. In general, 
amount of text in Balloon instruction is relatively small (smaller than the instructions used for 
the similar Pop-up window types of objects). Balloon object is intended to open up when the 
user’s mouse moves over affected area versa the mouse click and closes when the user’s mouse 
moves away from the active area. Therefore, Balloon types of objects do not have their own 
closing mechanism. Compared to Pop-up window type of object, Balloon objects can have 
pointer arrow. 

 

Object parameters 

 

Select color scheme (background-border color) with respect to the overall design of the Slide. 
Press “Apply” button to observe changes. Select direction of arrow pointer and input Balloon 
text. If necessary, specify value for inner margin. Inner margin defines the space between 
balloon border and the text. 

After you done with parameters settings, place Balloon the way that arrow points right into the 
link or active area. Usually Balloon should open up when the user’s mouse moves over that link 
or active area. 



Depending on the purpose of inserted Balloon, it might be necessary to disable display of 
Balloon right after Frame loading and define onMouseOver and onMouseOut actions enabling 
display of Balloon. 

5.3.6.3 Convex Balloon 

Balloon objects are used for opening various instructions for a text on the Slide. In general, 
amount of text in Balloon instruction is relatively small (smaller than the instructions used for 
the similar Pop-up window types of objects). Balloon object is intended to open up when the 
user’s mouse moves over affected area versa the mouse click and closes when the user’s mouse 
moves away from the active area. Therefore, Balloon types of objects do not have their own 
closing mechanism. Compared to Pop-up window type of object, Balloon objects can have 
pointer arrow. 

 

Object parameters 

 

Select balloon color with respect to the overall design of the Slide. Press “Apply” button to 
observe changes. Select direction of arrow pointer and input Balloon text. If necessary, specify 
value for inner margin. Inner margin defines the space between balloon border and the text. 

After you done with parameters settings, place Balloon the way that arrow points right into the 
link or active area. Usually Balloon should open up when the user’s mouse moves over that link 
or active area. 



Depending on the purpose of inserted Balloon, it might be necessary to disable display of 
Balloon right after Frame loading and define onMouseOver and onMouseOut actions enabling 
display of Balloon. 

5.3.6.4 Gradient Balloon 

Balloon objects are used for opening various instructions for a text on the Slide. In general, 
amount of text in Balloon instruction is relatively small (smaller than the instructions used for 
the similar Pop-up window types of objects). Balloon object is intended to open up when the 
user’s mouse moves over affected area versa the mouse click and closes when the user’s mouse 
moves away from the active area. Therefore, Balloon types of objects do not have their own 
closing mechanism. Compared to Pop-up window type of object, Balloon objects can have 
pointer arrow. 

 

Object parameters 

 

Select balloon color with respect to the overall design of the Slide. Press “Apply” button to 
observe changes. Select direction of arrow pointer and input Balloon text. If necessary, specify 
value for inner margin. Inner margin defines the space between balloon border and the text. 

After you done with parameters settings, place Balloon the way that arrow points right into the 
link or active area. Usually Balloon should open up when the user’s mouse moves over that link 
or active area. 



Depending on the purpose of inserted Balloon, it might be necessary to disable display of 
Balloon right after Frame loading and define onMouseOver and onMouseOut actions enabling 
display of Balloon. 

5.3.6.5 Idea Balloon 

Balloon objects are used for opening various instructions for a text on the Slide. In general, 
amount of text in Balloon instruction is relatively small (smaller than the instructions used for 
the similar Pop-up window types of objects). Balloon object is intended to open up when the 
user’s mouse moves over affected area versa the mouse click and closes when the user’s mouse 
moves away from the active area. Therefore, Balloon types of objects do not have their own 
closing mechanism. Compared to Pop-up window type of object, Balloon objects can have 
pointer arrow. 

 

Object parameters 

 

Select color scheme (background-border color) with respect to the overall design of the Slide. 
Press “Apply” button to observe changes. Select direction of arrow pointer and input Balloon 
text. If necessary, specify value for inner margin. Inner margin defines the space between 
balloon border and the text. 

After you done with parameters settings, place Balloon the way that arrow points right into the 
link or active area. Usually Balloon should open up when the user’s mouse moves over that link 
or active area. 



Depending on the purpose of inserted Balloon, it might be necessary to disable display of 
Balloon right after Frame loading and define onMouseOver and onMouseOut actions enabling 
display of Balloon. 

  



5.3.7 Design 

5.3.7.1 Gradient Area 

The Gradient Area type of objects is generally used for decoration purposes. 

Example of object appearance:  

 

Object parameters 

 

Select color for the start (color 1) and the end (color 2) of the Gradient areas with respect to 
the selected design of the Slide. Click “Apply” to view changes.  

Select direction of the gradient – vertical or horizontal. 

5.3.7.2 Click Area 

The Click Area type of objects is used for defining transparent click area anywhere on the 
Frame. Transparent by default, click area can be made visible (and blinking) using object 
methods. This may be useful , for example, to highlight click area in case of incorrect click.  

The object is invisible by default, therefore object's placeholder is displayed in Edit mode: 

 



After inserting object into the Frame, adjust object's size and position in relation to the Frame 
structure. Open “Properties” dialog screen. 

 

On the Highlighting tab you can select blinking timer, background color, border parameters and 
opacity of the object in the Highlight mode. Check the Preview highlighted checkmark to 
preview object's Highlight mode. Be aware that there's no possibility to display transparency 
for this object in CourseLab Edit mode, therefore only background and border can be 
previewed. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

HIGHLIGHT ON  Turns the object in the Highlight mode 

HIGHLIGHT OFF  Turns the object back to Invisible mode 

5.3.7.3 Active Zone 

The Active Zone type of Object is used to control mouse click on any part of the Frame and to 
launch different actions on correct and incorrect clicks. Transparent by default, a click area can 
be made visible using Object Methods. This may be useful, for example, to highlight the click 
area if of an incorrect click.  

The object is invisible by default, therefore object's placeholder is displayed in Edit mode: 



 

WARNING! This Object captures ALL mouse clicks in selected control area, 
therefore all clickable objects (links, buttons, Objects with actions etc.) located 
under control area will not accept clicks while this Object is active.  

This Object evaluates mouse clicks on all Frame. Therefore no more than one 
Object of such type can be used in active mode simultaneously. To 
activate/deactivate this Object use Object’s special methods ACTIVATE 
AREA/DEACTIVATE AREA.  

Once involved, this object cannot be hidden as easy as any other Object due to its 
special abilities. To switch off this Object completely use Object’s special method 
DESTROY AREA.  

After inserting this Object into a Frame, adjust the Object's size and position in relation to the 
Frame structure. Open the “Properties” dialog screen. The mouse click on the defined Active 
zone is always considered as correct. There are 3 modes of incorrect mouse click control: 
Whole Frame, Selected Object or Selected Area, depending on area to control incorrect click.  

   

1. Whole Frame mode – mouse click anywhere on the Frame (except for Active zone) will be considered as incorrect.  

2. Selected Object mode - mouse click anywhere on the Object (except for Active zone) will be considered as 

incorrect. Mouse clicks outside the Object are not evaluated at all.  

3. Selected Area mode - mouse click anywhere on the area on the Frame that is defined by coordinates (except for 

Active zone) will be considered as incorrect. Mouse clicks outside this area are not evaluated at all.  



 

The number of attempts allowed can be defined on the Incorrect tab. Each attempt can have 
its own lists of Objects to display and to hide. Besides, highlighting of Active zone could be used 
after last incorrect attempt. 

 

The lists of Objects to display and to hide in case of correct attempt can be defined on Correct 
tab. 



 

Parameters of highlighting can be defined on Highlight tab. 

 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 



on Control Started When object switches into Active mode (start listening clicks). 

on Click Accepted When mouse click is captured anywhere on the Frame. Click is not evaluated yet.   

on Click Out Of 
Control Area 

First stage of click evaluation is complete – click is outside the control area. Further evaluation is 
stopped. 

on Click Within 
Control Area 

First stage of click evaluation is complete – click is inside the control area. Click will be evaluated further 
on stage 2.  

on Click Within 
Correct Zone 

Second stage of click evaluation is complete – click is inside the Active zone (i.e. correct). This event is 
fired BEFORE any actions in Object’s list are processed. 

on Click Out Of 
Correct Zone 

Second stage of click evaluation is complete – click is outside the Active zone (i.e. incorrect). This event is 
fired BEFORE any actions on Object’s list are processed. 

on Control Stopped When Object is deactivated 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

ACTIVATE AREA Turns the Object into Active mode.  

DEACTIVATE AREA Turns the Object into Inactive mode.  

DESTROY AREA DESTROY AREA 

5.3.7.4 Notifier 

The Notifier type of objects is used to attract learner's attention to the part of the Frame. There 
are three different shapes, which can be used as (optionally blinking) notifier: arrow, 
transparent rectangle with visible corners and colored transparent rectangular area. 

Examples of Notifier appearance:  

 

After inserting object into the Frame, open “Properties” dialog screen. Depending on selected 
object appearance, you can change various parameters: 



 

For arrow you can select arrow direction and color. 

 

For Corners you can select corners size and color. 



 

For Transparent area you can select blinking timer, background color, border parameters and 
opacity of the object. Be aware that there's no possibility to display transparency for this object 
in CourseLab Edit mode, therefore only background and border can be viewed. 

5.3.7.5 Gradient Backing with rounded corners 

Gradient Backing with rounded corners is used for design purpose. 

Example of object appearance:  

 

Object parameters 



 

Select color scheme for the Object - one of predefined or custom, according to your design 
requirements. Change border width and corner radius, if needed.  

5.3.7.6 Image thumbnail with magnification feature 

Image thumbnail with magnification feature is used to display magnified image on user click. 
Picture will be sized to maximal size that is allowed by Course Template. 

Example of object appearance in Thumbnail mode:  

 



Example of object appearance in Magnified mode: 

 

Object parameters 

 

Select image file. Define color schemes for button and background. Change tooltips if needed. 



5.3.7.7 Button for Next/Previous 

Button can be used to launch Actions. It has predefined symbols for Next/Previous. 

Example of object appearance:  

 

Object parameters 

 

Select color schemes for Button. 

  



5.3.8 Title-Slide 

Title Slide group of objects is used strictly on the Title Slide. 

5.3.8.1 Start Module Button 

Start Module button appears in inactive state on the Splash Screen Slide while the main block 
of Module is loading and becomes active only when Module is fully loaded.  

Example of object appearance:  

 

Object parameters 

 

By default, the standard Start Module button is used. If you wish to use different button, then 
create 2 images using any graphical editor:  

 First picture will be displayed while the main block of Module is loading (specify path in 
the “Picture before loading” field).  

 The second picture will be displayed after the main block of Module is loaded (specify path 
in the “Picture after loading” field).  

5.3.8.2 Title-Slide Popup 

Title-Slide Popup button and window appears on the Title-Slide and may be useful for 
providing descriptions or help instructions.  

Example of object appearance:  



 

Object parameters 

 

On the Popup window tab you can define popup window size and border, window header and 
text (these are RichText fields).  

If On open close other popups checkmark is set, then only one (last opened) popup window 
will be displayed. 

 

By default, the standard button is used. If you wish to use different button, then create 2 
corresponding images using any graphical editor. 

  



5.3.9 Media 

5.3.9.1 Flash 

Flash-movie object is used for playing Adobe Flash Movies. Adobe Flash movie files have .swf 
extension.  

IMPORTANT! The Adobe Flash Player software should be installed on the 
computer for playing Flash-movie. You can get the latest free version of Adobe 
Flash Player at http://www.adobe.com). To insure correct functionality of the learning 
Course remember to turn on the feature, which checks whether or not Flash 
Player has been installed on the target machine before loading the learning 
Module (“Module menu – Runtime Settings – Checks”).  

Flash-movie cannot be played in edit mode, only placeholder of the movie is visible.  

Object parameters 

 

Specify Flash-movie source. There are three options: 

1. Local file ( file will be automatically copied into the “Images” folder of learning Module);  

2. URL - full URL of Flash-movie;  

3. Code - this option allows you to insert code from YouTube and similar services. Object will try to determine Flash-

movie URL from this code. However, use this option with great care, because it is potentially erroneous.  

http://www.adobe.com/


Be aware, that URL and Code options refer to external content, therefore this Flash-
movie becomes the subject for Flash Player security settings (cross-domain 
security).  

Select the playing mode. Adobe Flash Player supports the following window modes for playing 
the movie: 

1. Window Mode - Always on top of all layers. Flash movie plays in its own virtual window in the Frame 

above the core browser display window, therefore no other objects in the Frame can cover/screen Flash-movie object. 
Background color for the Flash-movie precisely corresponds to the one selected by the user.    

2. Transparent Mode. Flash movie plays in the separate layer of the Frame and overlaps other objects placed 

underneath. However, the objects placed on top can overlap Flash movie. In case the background color for the Frame is 

not defined by user and Flash movie has transparent areas, then the objects layered underneath will be 

showing through the transparent portions of the movie. Since transparent mode is resource consuming, animation 

performance might be slower, therefore we do not recommend using transparent mode, unless it is absolutely 

necessary.  

3. Opaque Mode. Flash-movie plays in the separate layer of the Frame and overlaps other objects placed underneath. 

However, the objects placed on top can overlap Flash-movie. Compared to transparent mode Flash-movie in opaque 
mode will always have the background color defined, even if you do not explicitly specify Background color (White is 
default color).  

If necessary, you can specify background color for the Flash-movie object. 

Custom parameters can be added to Flash-movie (if Flash-movie is designed to handle these 
parameters). Be aware that parameter name must not contain whitespaces and special 
symbols, and parameter value must not contain quotes, left and right angle brackets.  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

PLAY  Start playing Flash-movie. 

STOP  Stops playing Flash-movie. 

REWIND Rewind the movie to the start position 

PAUSE Pauses playing 

CONTINUE Continues playing from paused state 

5.3.9.2 Shockwave 

Shockwave-movie object is used for playing Adobe Shockwave-movies created using Adobe 
Shockwave technology. Adobe Shockwave-movie files have .dcr extension. Adobe Shockwave 
technology is far more versatile than Adobe Flash. The wider range of the features has a 
drawback in terms of size of the Adobe Shockwave-movie, complexity of creation, and 
requirement to have a Adobe Shockwave player installed. Although, Adobe Shockwave player is 
distributed free of charge, it has a bigger size and it is less universal compared to Flash Player. 
Nevertheless, if you have a Adobe Shockwave-movie you can insert it into the Frame just as 
easy as Adobe Flash-movie. 



IMPORTANT! The Adobe Shockwave Player software should be installed on the 
computer for playing Shockwave-movies. You can get the latest free of charge 
version of Adobe Shockwave Player at http://www.adobe.com). To insure correct 
functionality of the learning Course remember to turn on the feature, which 
checks whether or not Shockwave Player has been installed on the target 
machine before loading the learning Module (“Module menu – Runtime Settings 
– Checks”). 

Object parameters 

 

Specify path to the Shockwave-movie file, which you are going to insert. Next, file will be 
automatically copied into the images folder of learning Module. 

LIMITATION: During insertion of the Shockwave-movie object, the content for this 
object is unknown to the CourseLab editor; therefore movie placeholder will be 
displayed in the editing mode instead. 

5.3.9.3 Video 

Video clip object is used for playing Video clips in the different formats.  

Windows Media Player is used by default for playing MPEG, AVI, and WMV formats. For FireFox 
browser family it is recommended to install latest version of Microsoft Windows Media Player 
plugin from Port 25 Team (http://port25.technet.com/pages/windows-media-player-firefox-plugin-download.aspx). 

QuickTime Player is used by default for playing QuickTime MOV and 3gp formats. Note, that 
QuickTime Player must be installed on learner's computer (free download at 
http://www.apple.com/quicktime/). 

Real Player is used by default for playing clips in Real Media RM, RAM and RPM files. Note that 
RealMedia Player must be installed on learner's computer (free download at http://www.real.com/).  

IMPORTANT! Additional software should be installed on the computer for playing 
video clips. To insure correct functionality of the learning Course remember to 

http://port25.technet.com/pages/windows-media-player-firefox-plugin-download.aspx
http://www.apple.com/quicktime/
http://www.real.com/


turn on the feature, which checks whether or not required software has been 
installed on the target machine before loading the learning Module (“Module 
menu – Runtime Settings – Checks”).  

LIMITATION: During insertion of the Video clip object, the content for this object 
is unknown to the CourseLab editor; therefore Video clip placeholder will be 
displayed in the editing mode instead. 

Object parameters 

 

Specify Video source. There are two options: 

1. Local file ( file will be automatically copied into the “Images” folder of learning Module);  

2. URL - full URL of movie;  

Be aware, that URL option refers to external content, therefore this Video clip 
becomes the subject for browser security settings (cross-domain security).  

Player selection option allows you to define desired player software explicitly. Note, that 
depending on this option and selected video source object placeholder may change the 
appearance. For example, this is Windows Media Player placeholder on the picture. 



 

Display of the player controls can be further adjusted.  

In case Movie Autostart check box is selected, Video clip is launched as soon as it is loaded, 
otherwise user should manually select “Play” button using video controls, or object methods. 

Windowless mode enables to launch Windows Media Player as inline element (i.e. in this case 
it can be overlapped by other objects), otherwise it will be launched in window mode (and by 
default it cannot be overlapped by other objects). Note, that not all players and browsers 
support windowless mode, however. 

Invisible mode enables to launch player software as a hidden element. This mode may be 
useful for playing audiofiles. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism. Yellow cells 
contain events used only for streaming media. 

Event Triggered Upon 

on Playing Tick Fires every second while the player is playing media. Use it with currentPosition property to create 
time-binded actions. 

on Change Play State Fires at the moment when playing state of the media is changed (state itself doesn't matter - just 
changed). 

on Play Stopped At the moment when playing of media stops (no matter was it learner's click or the end of media). 

on Play Paused At the moment when playing of media becomes paused. 

on Play Started At the moment when playing of media starts (position doesn't matter). 

on Play Begin At the moment when playing of media starts from the beginning. 

on Play Resumed At the moment when playing of media starts from the paused state. 

on End Of Media At the moment when playing of media stops on the end of media. 

on Position Changed Fires when current position is changed by slider control or method. 

on Media Changed At the moment when player media is changed. 



on Media Error At the moment when player generates media error. 

on Waiting Server 
Response 

At the moment when player starts for waiting server responce. 

on Reconnect To Server At the moment when player starts reconnecting to server. 

on Start Buffering Media At the moment when player starts buffering. 

on Preparing Media At the moment when media is loaded and player starts preparing. 

on Media Is Ready At the moment when media is loaded and player is ready to start. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

PLAY  Start playing clip. 

STOP  Stops playing clip. 

PAUSE Pauses playing. Use PLAY method to continue from paused. 

SET PROPERTY Sets one of the player properties. 

REPLACE MEDIA Replaces video source of player. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Note, that these properties are available only for Windows Media Player and 
QuickTime Player (not for Real Player). 

Property Returns Syntax 

autoStart  Returns 1 if AutoStart is set to true, 0 otherwise. $OBJ_ID.autoStart 

mute Returns 1 if mute sound is set to true, 0 otherwise. $OBJ_ID.mute 

volume Returns current sound volume (range 0-100). $OBJ_ID.volume 

currentMedia Returns current media name (if exists), empty string otherwise. $OBJ_ID.currentMedia 

duration  Returns full media duration in seconds. $OBJ_ID.duration 

currentPosition Returns current position in media in seconds. $OBJ_ID.currentPosition 

currentState  Returns current object state (tokens: "undefined", "stopped", "paused", "playing" 
,"forward", "backward", "buffering", "waiting", "ended", "preparing", "ready", 
"reconnect").  

$OBJ_ID.currentState 

url Returns current media URL if available. $OBJ_ID.url 

isOnline (WMP only) Returns 1 if player object has access to the network, 0 otherwise. $OBJ_ID.isOnline 

5.3.9.4 Java 

Java Applet object is used for inserting Java Applets into the learning Course.  

IMPORTANT! Java Virtual Machine should be installed on the computer for 
running Java Applets (free download at http://www.sun.com/). To insure correct 

http://www.sun.com/


functionality of the learning Course, remember to turn on the feature, which 
checks whether or not Java has been installed on the target machine before 
loading the learning Module (Module menu – Runtime Settings – Checks).  

Java-applet cannot be played in edit mode, only placeholder of the applet is visible.  

Object parameters 

 

Select path to files. Files will be copied into images folder.  

 

Define margins if necessary. Alt text will be displayed to user if there is no Java installed on the 
computer.  



Applet parameters will be transferred to applet on launch. 

 

Java Machine selection has practical meaning in very rare cases. 

5.3.9.5 Flash Video 

Flash Video clip object is used for playing Video clips in Flash Video format (FLV).  

IMPORTANT! The Adobe Flash Player 9 or higher should be installed on the 
computer for playing Flash Video. You can get the latest free version of Adobe 
Flash Player at http://www.adobe.com). To insure correct functionality of the learning 
Course remember to turn on the feature, which checks whether or not Flash 
Player has been installed on the target machine before loading the learning 
Module (“Module menu – Runtime Settings – Checks”).  

LIMITATION: Flash Video file must contain metadata to allow full functionality of 
the object (i.e. file must be converted in FLV 1.1 format). If your FLV-file is 
converted with FLV 1.0 converter, then only basic object methods and properties 
can be used (though FLV-file still can be played). 

Flash-movie cannot be played in edit mode, only placeholder of the movie is 
visible.  

Object parameters 

http://www.adobe.com/


 

Specify Flash video source.  

There are two options: 

1. Local file ( file will be automatically copied into the “Images” folder of learning Module);  

2. URL - full URL of movie;  

Be aware, that URL option refers to external content, therefore this Video clip 
may become the subject for browser and Flash Player security settings (cross-
domain security). 

Select the playing mode. Adobe Flash Player supports the following window modes for playing 
the movie: 

1. Window Mode - Always on top of all layers. Flash movie plays in its own virtual window in the Frame 

above the core browser display window, therefore no other objects in the Frame can cover/screen Flash-movie object. 
Background color for the Flash-movie precisely corresponds to the one selected by the user.    

2. Transparent Mode. Flash movie plays in the separate layer of the Frame and overlaps other objects placed 

underneath. However, the objects placed on top can overlap Flash movie. In case the background color for the Frame is 

not defined by user and Flash movie has transparent areas, then the objects layered underneath will be 

showing through the transparent portions of the movie. Since transparent mode is resource consuming, animation 

performance might be slower, therefore we do not recommend using transparent mode, unless it is absolutely 

necessary.  

3. Opaque Mode. Flash-movie plays in the separate layer of the Frame and overlaps other objects placed underneath. 

However, the objects placed on top can overlap Flash-movie. Compared to transparent mode Flash-movie in opaque 
mode will always have the background color defined, even if you do not explicitly specify Background color (White is 
default color). 

If necessary, you can specify background color for the Flash-movie object. 

Display of the player controls can be further adjusted.  

In case Movie Autostart check box is selected, Video clip is launched as soon as it is loaded, 
otherwise user should manually select “Play” button using video controls, or object methods. 



Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

IMPORTANT! Most of properties and events of this object are not native to Flash 
Video or Flash, they are simulated by software. Due to this fact and due to delays 
in Flash-JavaScript communication, some delay (up to 1 sec) may occur a) 
between calling the object's method and method's execution b) between 
changing Flash Video playing state and corresponding object's event c) in 
changing property values. Please be aware of this fact. 

Event Triggered Upon 

on Playing Tick Fires every second while the player is playing media. Use it with currentPosition property to create time-
binded actions. 

on Change Play 
State 

Fires at the moment when playing state of the media is changed (state itself doesn't matter - just 
changed). 

on Play Stopped At the moment when playing of media stops (no matter was it learner's click or the end of media). 

on Play Started At the moment when playing of media starts (position doesn't matter). 

on End Of Media At the moment when playing of media stops on the end of media. 

on Position 
Changed 

Fires when current position is changed by slider control or method. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

PLAY  Start playing clip. 

STOP  Stops playing clip. 

REWIND Rewinds clip to the beginning (does not change playing state). 

PAUSE Pauses playing. Use PLAY method to continue from paused. 

CONTINUE Start playing clip from current position. 

SET VOLUME Sets sound volume (integer 0-100). 

MUTE Mutes sound. 

UNMUTE Unmutes sound. 

SET POSITION Sets playing position in seconds (does not change playing state). May not work with FLV 1.0 files 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

IMPORTANT! Most of properties and events of this object are not native to Flash 
Video or Flash, they are simulated by software. Due to this fact and due to delays 



in Flash-JavaScript communication, some delay (up to 1 sec) may occur a) 
between calling the object's method and method's execution b) between 
changing Flash Video playing state and corresponding object's event c) in 
changing property values. Please be aware of this fact. 

Property Returns Syntax 

mute Returns 1 if mute sound is set to true, 0 otherwise. $OBJ_ID.mute 

volume Returns current sound volume (range 0-100). $OBJ_ID.volume 

duration  Returns full media duration in seconds. $OBJ_ID.duration 

currentPosition Returns current position in media in seconds. $OBJ_ID.currentPosition 

currentState  Returns current object state (tokens: "0" - means "stopped", 1 - means "playing" $OBJ_ID.currentState 

 

  



5.3.10 Navigation 

Navigation Objects enable transition among Slides and Frames. The majority of Navigation 
objects have certain usage limitations, therefore be cautious when implementing. 

5.3.10.1 Universal Button 

Universal button is configurable Button Template that allows to use it to display selected 
Objects. 

Example of object appearance:  

 

Object parameters 

 

This Object has no predefined images. Use any graphic editor to create following 3 pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  



 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the disabled button (specify path to the image under “Disabled 
Button”). 

You can specify mouse over tooltip messages for both enabled and disabled buttons. 

Define if this button should accept Navigation Events. 

Actions on Button click can be defined in Actions dialog. However, if the Object that you want 
to manage has its own OPEN and CLOSE methods, then you can select this Object as target. 

 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 



DISABLE ACCESS Restrict access to Button. 

ENABLE ACCESS Permit access to Button. 

5.3.10.2 Navigation Menu 

Navigation Menu enables tracing of the current Slide name and an instant transition to another 
Slide upon selecting its name (if there are no restrictions for such transition by other 
conditions). In case there exists Alternative path in the Module, object will use alternative Module 
structure from Alternative path. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

You can modify different Navigation menu display settings. 

The marker “Show Slide hierarchy” enables to modify display mode of the Slide’s structure in 
the Module.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the frame 
were played back.  

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/nav_025_structure.html


Strict slide order message will be displayed if the learner will try to jump more than one slide 
further and strict slide order mode is enabled in Module run-time settings. 

 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Navigation menu. 

ENABLE ACCESS  Permit access to Navigation menu. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

selectedID Returns ID of current Slide $OBJ_ID.selectedID 



selectedName Returns slide name of current Slide $OBJ_ID.selectedName 

selectedNumber Returns number of current Slide $OBJ_ID.selectedNumber 

totalEntries Return total number of selector options $OBJ_ID.totalEntries 

5.3.10.3 Current Position 

Current Position object enables tracing of the Slide number against the total number of Slides. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

By default, object displays the following label: “POSITION: N/M” (where N is a Slide number, 
and M is a total number of Slides). You can modify text, divider, and some other display 
parameters with respect to the overall design of the learning Module. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

currentPosition Returns number of current Slide $OBJ_ID.currentPosition 

5.3.10.4 Contents Tab 



Contents tab enables displaying the list of the Slides within Module and transition to other 
Slides by selecting their names (unless transition to selected Slide is in agreements with other 
conditions). In case there exists Alternative path in the Module, object will use alternative Module 
structure from Alternative path. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/nav_025_structure.html


 

In case the default tab is used, you can select color, change vertical margin with relation to the 
top border of the object, and specify mouse over tooltip messages for both enabled and 
disabled tabs. 

If default tab marker is unchecked you can use custom images for displaying tabs, change 
object’s border size, and color.  



 

Use default Slides icon set marker enables you to replace Slide’s icons, if desired. 

The marker “Show Slide hierarchy” enables to modify display mode of the Slide’s structure in 
the Module. Besides, you can replace images, which represents hierarchy nodes, if desired. 

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  

Strict slide order message will be displayed if the learner will try to jump more than one slide 
further and strict slide order mode is enabled in Module run-time settings. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Tab. 

ENABLE ACCESS  Permit access to Tab. 

OPEN TAB Opens Tab (if access is not disabled) 

CLOSE TAB Closes Tab 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 



disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 

5.3.10.5 Help Tab 

Help Tab object enables displaying the Help text block for the Module. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

In case the default tab is used, you can select color, change vertical margin with relation to the 
top border of the object, and specify mouse over tooltip messages for both enabled and 
disabled tabs. 

If default tab marker is unchecked you can use custom images for displaying tabs, change 
object’s border size, and color.  



 

You can modify header of the Help tab and insert Help text into the Rich Text fields.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Tab. 

ENABLE ACCESS  Permit access to Tab. 

OPEN TAB Opens Tab (if access is not disabled) 

CLOSE TAB Closes Tab 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 



disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 

5.3.10.6 Calculator Tab 

Calculator tab enables displaying the Calculator, which can be used for calculations inside the 
Module. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

In case the default tab is used, you can select color, change vertical margin with relation to the 
top border of the object, and specify mouse over tooltip messages for both enabled and 
disabled tabs. 

If default tab marker is unchecked you can use custom images for displaying tabs, change 
object’s border size, and color.  



 

You can modify header of the Calculator tab and insert short description text into the Rich Text 
fields.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Tab. 

ENABLE ACCESS  Permit access to Tab. 

OPEN TAB Opens Tab (if access is not disabled) 

CLOSE TAB Closes Tab 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 



disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 

value Returns current value from calculator display $OBJ_ID.value 

5.3.10.7 Settings Tab 

Settings Tab object enables displaying current Settings or Statistics for the Module. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

In case the default tab is used, you can select color, change vertical margin with relation to the 
top border of the object, and specify mouse over tooltip messages for both enabled and 
disabled tabs. 

If default tab marker is unchecked you can use custom images for displaying tabs, change 
object’s border size, and color.  



 

You can modify header of the Settings tab and insert description texts into the Rich Text fields.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back. 



 

On the Objectives tab you can select which Module parameters will be displayed. 



 

On the Texts tab you can define messages and tooltips that will be presented to learner. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Tab. 

ENABLE ACCESS  Permit access to Tab. 

OPEN TAB Opens Tab (if access is not disabled) 

CLOSE TAB Closes Tab 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 



disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 

5.3.10.8 Search Tab 

Search Tab object enables search functionality within the current Module. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 



In case the default tab is used, you can select color, change vertical margin with relation to the 
top border of the object, and specify mouse over tooltip messages for both enabled and 
disabled tabs. 

If default tab marker is unchecked you can use custom images for displaying tabs, change 
object’s border size, and color.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back. 

 

The Search tab contains options for search processing. You can disable user controls for 
selecting case sensitivity and search logic selection - in this case user cannot change these 
settings in the search form and default search settings will be applied in every search.  

 Case sensitive option sets default case sensitivity for search process.  

 Search logic defines search inclusion in case user enters more than one word in query. Any word means that all 

Slides or Objects containing any of eneterd words will be found (i.e. OR operation). All words means that only Slides or 
Objects containing all of enetersd words will be found (i.e. AND operation).  

 Search logic scope means the scope, to which Search logic will be applied - Slide or Object.  

 Search results can be presented as simple links or links with short text fragment.  



 

On the Texts tab you can define messages and tooltips that will be presented to learner. 



 

Styles tab contains style parameters for presenting search form and results. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Tab. 

ENABLE ACCESS  Permit access to Tab. 

OPEN TAB Opens Tab (if access is not disabled) 

CLOSE TAB Closes Tab 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 



disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 

5.3.10.9 About Tab 

About Tab object enables displaying the information text block for the Module. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

In case the default tab is used, you can select color, change vertical margin with relation to the 
top border of the object, and specify mouse over tooltip messages for both enabled and 
disabled tabs. 

If default tab marker is unchecked you can use custom images for displaying tabs, change 
object’s border size, and color.  



 

You can modify header of the tab and insert short description text into the Rich Text fields.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Tab. 

ENABLE ACCESS  Permit access to Tab. 

OPEN TAB Opens Tab (if access is not disabled) 

CLOSE TAB Closes Tab 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 



disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 

5.3.10.10 Next Slide Button 

Next Slide Button Object is a special object which enables transition to the next Slide from the 
current Slide. In case there exists Alternative path in the Module, object will use alternative Module 
structure from Alternative path. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following four pictures:  
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 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fourth picture displays the button being pressed (specify path to the image under 
“OnClick Button”).  

You can specify mouse over tooltip messages for both enabled and disabled buttons. 

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  

 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Button. 

ENABLE ACCESS  Permit access to Button. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

5.3.10.11 Previous Slide Button 

Previous Slide Button Object is a special object which enables transition to the previous Slide 
from the current Slide. In case there exists Alternative path in the Module, object will use 
alternative Module structure from Alternative path. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 
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By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following four pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fourth picture displays the button being pressed (specify path to the image under 
“OnClick Button”).  

You can specify mouse over tooltip messages for both enabled and disabled buttons. 

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Button. 

ENABLE ACCESS  Permit access to Button. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 



5.3.10.12 Slide Name 

Slide Name object enables to automatically display the current Slide name defined in the 
Editor. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

You can modify background color and font settings for the Slide Name with respect to the 
overall design of the learning Module.  

LIMITATION: The Slide Name will be displayed completely only while playing the 
actual Course. Name substitute will be displayed in the editing mode instead. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

slideName Returns slide name of current Slide $OBJ_ID.slideName 



5.3.10.13 Window title 

Window title object is used to configure format of title of the module window.  

LIMITATION. If the module is viewed in the frame or IFRAME (some LMS use this 
displaying method by default) window title will NOT be changed. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Note, that this object is "virtual", hidden, therefore you can see such placeholder in editor. 

 

Object parameters 

 

Select title contents. Module name (which usually is in Course structure pane) can be redefined 
for title, because window title is usually limited in length, so it is better to use shorter variant 
here. Note that chapter name is available only if Alternative Path object is defined for this module.  

5.3.10.14 Sound On/Off Button 

Sound On/Off Button object is a special object, which enables turning on and off the audio 
feature of the Module.  

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/q_025_structure.html


Example of object appearance:  

 

Object parameters 

 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following four pictures:  

 The first picture displays the “Sound” button in On state and the button can be pressed to 
turn the Sound Off (specify path to the image under “Enabled Off Button”)   

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Off Button”).  

 The third picture displays the “Sound” button in “Off” state and the button can be pressed 
to turn the Sound On (specify path to the image under “Enabled On Button”)  

 The fourth picture will replace the third one, in case user moves mouse over the enabled 
turn On button (specify path to the image under “OnMouseOver On Button”).  

You can specify mouse over tooltip messages for both enabled and disabled buttons. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

TOGGLE SOUND  Toggles sound on and off 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

soundOn  Returns 1 if object is sound is currently on, 0 otherwise. $OBJ_ID.soundOn 

5.3.10.15 Close Module Button 



Close Module Button object is a special object, which enables correct closing of the learning 
Module.  

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following three pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture will replace the second one when button is pressed. (specify path to the 
image under “OnClick button”).  



You can specify mouse over tooltip messages for both enabled and disabled buttons. 

 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.10.16 Replay Slide Button 

Replay Slide Button object is a special object, which enables current Slide reloading (for 
example, to repeat animation used in the Slide).  

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following four pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fourth picture displays the button being pressed (specify path to the image under 
“OnClick Button”).  

You can specify mouse over tooltip messages for both enabled and disabled buttons. 

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Button. 

ENABLE ACCESS  Permit access to Button. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 



5.3.10.17 Simple Progress Bar 

Simple Progress Bar is a special object, which indicates amount of the visited Slides relative to 
the overall amount of the Slides. In case there exists Alternative path in the Module, object will use 
alternative Module structure from Alternative path. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

By default, the standard Slide’s icons are used. If you wish to use different icons – uncheck the 
marker. Fields for inserting pictures become available. Create 3 images using any graphical 
editor: 

 The first image  will be displayed indicating already visited Slide.  

 The second image will be displayed indicating the current Slide.  

 The third image will be displayed indicating the Slides which are yet to be displayed.  

You can also, modify appearance parameters of the Progress Bar. 

5.3.10.18 Extended Progress Bar 

Extended Progress Bar is a special object, which indicates amount of the visited Slides relative 
to the overall amount of the Slides. Unlike Simple Progress Bar, Extended Progress Bar displays 
the name of the current Slide; it also enables exploring the names of other Slides and enables 
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transition to them. In case there exists Alternative path in the Module, object will use alternative 
Module structure from Alternative path. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

By default, the standard Slide’s icons are used. If you wish to use different icons – uncheck the 
marker. Fields for inserting pictures become available. Create 3 images using any graphical 
editor: 

 The first image  will be displayed indicating already visited Slide.  

 The second image will be displayed indicating the current Slide.  

 The third image will be displayed indicating the Slides which are yet to be displayed.  

Otherwise you can modify appearance parameters of the default Slide's icons. 
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You can also modify appearance parameters for slide name captions. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.10.19 Help Popup Window 

Help Popup Window object enables display of the help content for the learning Module. Object 
consists of two parts: button to call the object and pop up window with help content. Only 
“Help” button is visible in editing mode.  

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  



 

Object parameters 



 

In the opened dialog you can select the border color for the object with respect to the overall 
design of the learning Module. Also, you can modify title text and style. 

You may input the Help content into the “Window text” field, which is in Rich Text Format 
mode that enables insertion of the formatted text, tables, pictures, and so on. Please be 
advised that width of the text area is limited; therefore avoid using tables and pictures that 
exceed 450 pixels in width.  

You can modify size and location of pop up Help window with respect to the design of the 
learning Module, however, there are technical limitations for significant width and height 
changes.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following five pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the button being pressed (specify path to the image under 
“OnClick Button”);  

 The fourth picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fifth picture displays Help Popup Window Close button.  

You can specify mouse over tooltip messages for buttons. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Button. 

ENABLE ACCESS  Permit access to Button. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 



5.3.10.20 Contents Popup Window 

Contents Popup Window enables displaying current Module contents, indicates visited Slides, 
and allows navigation within a Module. Object consists of two parts: button to call the object 
and Contents Popup Window. Only “Contents” button is visible in editing mode. In case there 
exists Alternative path in the Module, object will use alternative Module structure from Alternative 
path. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 
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In the opened dialog you can select the border color for the results window with respect to the 
overall design of the learning Module. Also, you can modify title text and style. You can modify 
size and location of popup window with respect to the design of the learning Module, however, 
there are technical limitations for significant width and height changes.  



 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following five pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the button being pressed (specify path to the image under 
“OnClick Button”);  

 The fourth picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fifth picture displays Help Popup Window Close button.  

You can specify mouse over tooltip messages for buttons. 



 

Use default Slides icon set marker enables you to replace Slide’s icons, if desired. 

The marker “Show Slide hierarchy” enables to modify display mode of the Slide’s structure in 
the Module. Besides, you can replace images, which represents hierarchy nodes, if desired. 

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  

Strict slide order message will be displayed if the learner will try to jump more than one slide 
further and strict slide order mode is enabled in Module run-time settings. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Button. 

ENABLE ACCESS  Permit access to Button. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 



5.3.10.21 Search Popup Window 

Search Popup Window enables search functionality within the current Module. Only “Search” 
button is visible in editing mode. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

Window tab contains controls for popup window displaying parameters. You can select the 
border color for the object with respect to the overall design of the learning Module. Also, you 
can modify title text and style. You can modify size and location of popup window with respect 
to the design of the learning Module, however, there are technical limitations for significant 
width and height changes.  



 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following five pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the button being pressed (specify path to the image under 
“OnClick Button”);  

 The fourth picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fifth picture displays Help Popup Window Close button.  

You can specify mouse over tooltip messages for buttons. 

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

The Search tab contains options for search processing. You can disable user controls for 
selecting case sensitivity and search logic selection - in this case user cannot change these 
settings in the search form and default search settings will be applied in every search.  

 Case sensitive option sets default case sensitivity for search process.  

 Search logic defines search inclusion in case user enters more than one word in query. Any word means that all 

Slides or Objects containing any of eneterd words will be found (i.e. OR operation). All words means that only Slides or 
Objects containing all of enetersd words will be found (i.e. AND operation).  

 Search logic scope means the scope, to which Search logic will be applied - Slide or Object.  

 Search results can be presented as simple links or links with short text fragment.  



 

On the Texts tab you can define messages and tooltips that will be presented to learner. 



 

Styles tab contains style parameters for presenting search form and results. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Button. 

ENABLE ACCESS  Permit access to Button. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 



5.3.10.22 Glossary Popup Window 

Glossary Popup Window is used to display systematic glossary of terms with descriptions. 
Object consists of two parts: button to call the object and Glossary Popup Window. Only 
“Glossary” button is visible in editing mode. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

On the "Items" tab you can add as many glossary terms as you wish. Each term can be 
explained in Rich Text description. If you are planning to use external glossary calls (for 
example, you may need open some specific term description on click on the link, button, or 
image) it is recommended to use Item ID - unique for each term. Though there is also possibility 
to select term by its name, searching by name is generally slower than searching by ID, and also 
may lead to error (for example, if term contains some specific characters). Note, that you do 
not need to enter terms in alphabetic order - they will be sorted in alphabetic order 
automatically for display. 

 

You can also enable displaying first letter ribbon to allow learner select all terms starting with 
specific letter. This ribbon is created automatically. 



 

Window tab contains controls for popup window displaying parameters. You can select the 
border color for the object with respect to the overall design of the learning Module. Also, you 
can modify title text and style. You can modify size and location of popup window with respect 
to the design of the learning Module, however, there are technical limitations for significant 
width and height changes.  



 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create following five pictures:  

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the button being pressed (specify path to the image under 
“OnClick Button”);  

 The fourth picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fifth picture displays Help Popup Window Close button.  

You can specify mouse over tooltip messages for buttons. 

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

Style tab allows to change default text styles and margin for Glossary items. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Button. 

ENABLE ACCESS  Permit access to Button. 

DISPLAY ITEM 
Opens Glossary popup window and select the term by parameter: Item ID or Item name. If both 
parameters will present, then Item ID will be used and Item name will be ignored. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 



disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

open Returns 1 if object is currently open, 0 otherwise. $OBJ_ID.open 

5.3.10.23 Simple Search 

Simple Search object enables search functionality within the current Module. Simple Search is 
displayed as search field and button. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 

 

In the opened dialog you can select the border color for the results window with respect to the 
overall design of the learning Module. Also, you can modify title text and style. You can modify 



size and location of popup window with respect to the design of the learning Module, however, 
there are technical limitations for significant width and height changes.  

 

You can configure or change Search button and its parameters on "Button" tab: 

 The first picture displays the button in enabled state (specify path to the image under 
“Enabled Button”);  

 The second picture will replace the first one in case user moves mouse over the enabled 
button (specify path to the image under “OnMouseOver Button”);  

 The third picture displays the button being pressed (specify path to the image under 
“OnClick Button”);  

 The fourth picture displays the disabled button (specify path to the image under “Disabled 
Button”);  

 The fifth picture displays Help Popup Window Close button.  

You can specify mouse over tooltip messages for buttons. 



 

Field tab allows to change default styles for search field. 



 

The Search tab contains options for search processing. You can disable user controls for 
selecting case sensitivity and search logic selection - in this case user cannot change these 
settings in the search form and default search settings will be applied in every search.  

 Case sensitive option sets default case sensitivity for search process.  

 Search logic defines search inclusion in case user enters more than one word in query. Any word means that all 

Slides or Objects containing any of eneterd words will be found (i.e. OR operation). All words means that only Slides or 
Objects containing all of enetersd words will be found (i.e. AND operation).  

 Search logic scope means the scope, to which Search logic will be applied - Slide or Object.  

 Search results can be presented as simple links or links with short text fragment.  

Strict Navigation Mode – automatic blocking of the navigation object from the moment the 
Slide was opened until all objects on this Slide displayed in the Timeline panel of the Frame 
were played back.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE ACCESS  Restrict access to Search Field. 

ENABLE ACCESS  Permit access to Search Field. 

5.3.10.24 Load Progress 

Load Progress object is used to change the look of default load progress indicator. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

LIMITATION: If there will be more than one object of such type in the Module, 
then only one of them will be used. 



Example of object appearance:  

 

Object parameters 

Add object to the Master-Slide. Position it the way you prefer. Open “Properties” dialog screen. 

 

If Display Image Loading Progress checkmark is not set, then no progress indicator will be 
displayed at all. However, we do not recommend to switch it off - progress indicator contains 
Cancel button, which is very useful in case of network problems.  

Select layout type. 



 

On the Texts tab you can define message and the way it will be presented to learner. 

 

On the Progress Bar you can define parameters of progress bar. 



 

You can configure or change button and its parameters on Button tab. 

5.3.10.25 Alternative Path 

Alternative Path object allows to define alternative learning path within the Module. The 
Module can be divided on virtual chapters, each chapter can have completion conditions. If this 
object exists in the Module then all navigation objects will use alternative path automatically. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

LIMITATION: If there will be more than one object of such type in the Module, 
then only one of them will be used. 

Note, that this object is "virtual", hidden, therefore you can see such placeholder in editor. 

 

Object parameters 

Add object to the Master-Slide. Open object's properties. Pressing "+" add as manu "chapters" 
as you need. 



 

While adding chapter you can: 

 

 Set chapter number and name.  

 Select chapter's title slide (optional).  



 Create chapter's slide list. Note, that the slides will be displayed exactly in the order in this 
list.  

 Select chapter's objective - it's completion status will be changed to "completed" when all 
completion conditions will met.  

 Change the message that will be displayed if the learner will try leave incomplete chapter.  

 Set completion conditions.  

 

Object methods 

The state of the Object can be modified using methods. 

Method name  Execution Result 

EXCLUDE CHAPTER Selected chapter is excluded from alternative path. 

  

5.3.10.26 Frame Navigator 

Frame Navigator is a special object, which indicates amount of the visited Frames in particular 
Slide relative to the overall amount of the Frames in the Slide. 

Example of object appearance:  



 

Object parameters 

 

By default, standard button set is used. In case you prefer to use different button, remove the 
check mark “Use default button set”. Fields for specifying path to the pictures become active. 
Use any graphic editor to create pictures.  



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.10.27 Timer 

Timer is the special object, which can be used for different time counts. This object stores its 
state in LMS automatically (if present). 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

Autostart... checkmark allows to start counting immediately on Module's loading. If there 
already is some timer value that was stored in LMS: 

 if stored value is less than limit, then countdown will be resumed from stored value;  

 if stored value is greater or equal to limit, then object will fire "on Time Out" event and 
stop countdown.  

Check Display time limit to enable user to view the limit.. 

Display countdown from limit to zero toggles counting type. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Timer Start Timer starts counting 

on Time Out Time limit is reached 

on Timer Tick Every second while timer counts. Using this event with value property to launch actions on specific moment. 

Object Specific Properties  



Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

state 1 - timer is counting, 0 - timer is stopped. $OBJ_ID.state 

value Current timer value (integer in seconds) $OBJ_ID.value 

5.3.10.28 Comments object 

Comments object enables to automatically display comments to the current Slide, that defined 
by the author (or imported from PowerPoint). Object default parameters are optimized for 
"Import" templates (intended for importing PowerPoint presentations), but this is not 
limitation - object can be used on any other template. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  

 

Object parameters 



 

In case the Use default comments tab is checked, then you can select default tab color, change 
comments window size, specify mouse over tooltip messages and message, that appears when 
no comments to slide is present. Note, that window background color will be used for all 
comments, except for those imported from PowerPoint where background color is explicitly 
specified in PowerPoint source. 

If Use default comments tab marker is unchecked, then you can use custom images for 
displaying tabs, change object’s border size, and color.  

Checkmark Hide object on slides with no comments can be useful to attract learner attention. 
If it is checked (default state), then object will appear only on slides where comments are 
present. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

5.3.10.29 Comments Tab 

Comments Tab object enables to automatically display comments to the current Slide, that 
defined by the author (or imported from PowerPoint). Object default parameters are optimized 
for "Standard" templates, but this is not limitation - object can be used on any other template. 

LIMITATION: This Object can be placed only ON THE MASTER-SLIDE. 

Example of object appearance:  



 

Object parameters 

 

In case the Use default comments tab is checked, then you can select default tab color, specify 
mouse over tooltip messages and message, that appears when no comments to slide is present. 
Note, that window background color will be used for all comments, except for those imported 
from PowerPoint where background color is explicitly specified in PowerPoint source. 

If Use default comments tab marker is unchecked, then you can use custom images for 
displaying tabs, change comments window size, change object’s border color.  

If there is no comment to current slide, then No comments text will be displayed. 



 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

  



5.3.11 Agents 

5.3.11.1 Agent 

An “Agent” is an animated character with a set of basic Actions which can be launched using 
this Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  

 

Object parameters 

 

You can specify an Agent’s appearance and display parameters (similar to Flash-movie display 
settings, in fact, an Agent is a Flash-movie). 

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 



"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.   

Picture a situation when we have both a question and an Agent character presented in a Slide. 
The Agent’s task is to applaud when the provided answer to the question is correct.  

 

Here is the sequence of the necessary Actions:  

1. Memorize character ID and open “Actions” screen for the “Question” Object.  



 

2. Select “On Success” in the “Event” panel.  

3. Select “METHOD” in the “Action” panel.  

4. Specify parameters for the selected Action – select character ID; in the “Select Method” 
screen specify “ACTION” with the following parameters: “Applaud” and “Return upon 
completion”. Confirm your choice. At this point, configuration of the relationship among the 
Objects is completed. 

 



 

In this example, the Event of the “Question” Object has been used for launching the Action. 
However, any other Events or delayed Actions can be employed for the same purpose.  

Object methods 

The following Methods can be used when working with Agent Character: 

 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state.  

When you select automatic return into the idle mode, the above-mentioned Action phases will 
be automatically executed one after another. When we select wait for signal to return to idle 
mode, only the first phase - execution of the Action itself - is launched. The return to idle state 
is postponed until you use the “IDLE” Method or launch any other Action (in that case, before 
the new Action can be executed, the Object returns to the idle state automatically).  

Things to consider, when working with Actions:  

 Actions: Talk, Walk left/right cannot automatically return to the idle mode. The Agent will continue talking and 

walking until ordered to terminate the Action.  



 Actions, such as Yawn, Head-nod in agreement, Head-shake in disagreement (so called 
simple Actions, marked with *), will always return to the idle state upon completion.  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 
concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

curState  Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState Last state (action) - one of action token (short names) $OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $OBJ_ID.queue 

5.3.11.2 Talking Head 

The Talking Head is an animated character with a set of basic Actions; these Actions can be 
launched using Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  



 

Object parameters 

 

The Talking Head is actually a Flash movie so its appearance and display parameters can be 
manipulated in a similar manner.  

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 

"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.   

Picture the situation when we have both a question and a Talking Head character presented in 
a Slide. The Talking Head’s task is to be amazed when the provided response to the question is 
incorrect.  



 

Here is the sequence of the necessary Actions:  

1. Memorize character ID and open “Actions” screen for the “Question” Object.  

 

2. Select “On Failure” in the “Event” panel.  

3. Select “METHOD” in the “Action” panel.  

4. Specify parameters for the selected Action – select character ID; in the “Select Method” 
screen specify “ACTION” with the following parameters: “Amazement” and “Return upon 
completion”. Confirm your choice. At this point, configuration of the relationship among the 
Objects is completed. 



 

 

In the above example, the Event of the "Question" Object has been used for launching Action. 
However, any other Events or delayed Actions can be employed for the same purpose.  

Object methods 

The following Methods can be used when working with Object: 



 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state. When you select 
automatic return into the idle mode, the above-mentioned Action phases will be automatically 
executed one after another. When we select wait for signal to return to idle mode, only the first 
phase - execution of the Action itself - is launched. The return to idle state is postponed until 
you use the “IDLE” Method or launch any other Action (in that case, before the new Action can 
be executed, the Object returns to the idle state automatically).  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 
concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event  Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property  Returns  Syntax 

curState  Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState Last state (action) - one of action token (short names) $OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $OBJ_ID.queue 

5.3.11.3 Agent, type 2 



An “Agent” is an animated character with a set of basic Actions which can be launched using 
this Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  

 

Object parameters 

 

You can specify an Agent’s appearance and display parameters (similar to Flash-movie display 
settings, in fact, an Agent is a Flash-movie). 

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 

Object control 



By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.   

Picture a situation when we have both a question and an Agent character presented in a Slide. 
The Agent’s task is to applaud when the provided answer to the question is correct.  

 

Here is the sequence of the necessary Actions:  

1. Memorize character ID and open “Actions” screen for the “Question” Object.  

 

2. Select “On Success” in the “Event” panel.  



3. Select “METHOD” in the “Action” panel.  

4. Specify parameters for the selected Action – select character ID; in the “Select Method” 
screen specify “ACTION” with the following parameters: “Applaud” and “Return upon 
completion”. Confirm your choice. At this point, configuration of the relationship among the 
Objects is completed. 

 

 

In the above example, the Event of the "Question" Object has been used for launching Action. 
However, any other Events or delayed Actions can be employed for the same purpose.  



Object methods 

The following Methods can be used when working with Agent Character: 

 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state.  

When you select automatic return into the idle mode, the above-mentioned Action phases will 
be automatically executed one after another. When we select wait for signal to return to idle 
mode, only the first phase - execution of the Action itself - is launched. The return to idle state 
is postponed until you use the “IDLE” Method or launch any other Action (in that case, before 
the new Action can be executed, the Object returns to the idle state automatically).  

Things to consider, when working with Actions:  

 Actions: Talk, Walk left/right cannot automatically return to the idle mode. The Agent will continue talking and 

walking until ordered to terminate the Action.  

 Actions, such as Yawn, Head-nod in agreement, Head-shake in disagreement (so called 
simple Actions, marked with *), will always return to the idle state upon completion.  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 
concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  



Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property  Returns Syntax  

curState Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState  Last state (action) - one of action token (short names) $ OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $ OBJ_ID.queue 

5.3.11.4 Talking Head, type 2 

The Talking Head is an animated character with a set of basic Actions; these Actions can be 
launched using Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  

 

Object parameters 

 

The Talking Head is actually a Flash movie so its appearance and display parameters can be 
manipulated in a similar manner.  



In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 

"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.   

Picture the situation when we have both a question and a Talking Head character presented in 
a Slide. The Talking Head’s task is to be amazed when the provided response to the question is 
incorrect.  

 

Here is the sequence of the necessary Actions:  

1. Memorize character ID and open “Actions” screen for the “Question” Object.  



 

2. Select “On Failure” in the “Event” panel.  

3. Select “METHOD” in the “Action” panel.  

4. Specify parameters for the selected Action – select character ID; in the “Select Method” 
screen specify “ACTION” with the following parameters: “Amazement” and “Return upon 
completion”. Confirm your choice. At this point, configuration of the relationship among the 
Objects is completed. 

 



 

In the above example, the Event of the "Question" Object has been used for launching Action. 
However, any other Events or delayed Actions can be employed for the same purpose.  

Object methods 

The following Methods can be used when working with Object: 

 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state. When you select 
automatic return into the idle mode, the above-mentioned Action phases will be automatically 
executed one after another. When we select wait for signal to return to idle mode, only the first 
phase - execution of the Action itself - is launched. The return to idle state is postponed until 
you use the “IDLE” Method or launch any other Action (in that case, before the new Action can 
be executed, the Object returns to the idle state automatically).  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 



concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

curState  Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState  Last state (action) - one of action token (short names) $ OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $ OBJ_ID .queue  

5.3.11.5 Agent (different psychotypes) 

An “Agent” is an animated character with a set of basic Actions which can be launched using 
this Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  



 

Object parameters 

 

You can specify an Agent’s appearance and display parameters (similar to Flash-movie display 
settings, in fact, an Agent is a Flash-movie). 

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 

"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.   

Picture a situation when we have both a question and an Agent character presented in a Slide. 
The Agent’s task is to applaud when the provided answer to the question is correct.  



 

Here is the sequence of the necessary Actions:  

1. Memorize character ID and open “Actions” screen for the “Question” Object.  

 

2. Select “On Success” in the “Event” panel.  

3. Select “METHOD” in the “Action” panel.  

4. Specify parameters for the selected Action – select character ID; in the “Select Method” 
screen specify “ACTION” with the following parameters: “Applaud” and “Return upon 
completion”. Confirm your choice. At this point, configuration of the relationship among the 
Objects is completed. 



 

 

In this example, the Event of the “Question” Object has been used for launching the Action. 
However, any other Events or delayed Actions can be employed for the same purpose.  

Object methods 

The following Methods can be used when working with Agent Character: 



 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state.  

When you select automatic return into the idle mode, the above-mentioned Action phases will 
be automatically executed one after another. When we select wait for signal to return to idle 
mode, only the first phase - execution of the Action itself - is launched. The return to idle state 
is postponed until you use the “IDLE” Method or launch any other Action (in that case, before 
the new Action can be executed, the Object returns to the idle state automatically).  

Things to consider, when working with Actions:  

 Actions: Talk, Walk left/right cannot automatically return to the idle mode. The Agent will continue talking and 

walking until ordered to terminate the Action.  

 Actions, such as Yawn, Head-nod in agreement, Head-shake in disagreement (so called 
simple Actions, marked with *), will always return to the idle state upon completion.  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 
concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 



Property Returns Syntax 

curState  Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState Last state (action) - one of action token (short names) $OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $OBJ_ID.queue 

5.3.11.6 Talking Head (different psychotypes) 

The Talking Head is an animated character with a set of basic Actions; these Actions can be 
launched using Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  

 

Object parameters 

 

The Talking Head is actually a Flash movie so its appearance and display parameters can be 
manipulated in a similar manner.  

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 



"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.   

Picture the situation when we have both a question and a Talking Head character presented in 
a Slide. The Talking Head’s task is to be amazed when the provided response to the question is 
incorrect.  

 

Here is the sequence of the necessary Actions:  

1. Memorize character ID and open “Actions” screen for the “Question” Object.  



 

2. Select “On Failure” in the “Event” panel.  

3. Select “METHOD” in the “Action” panel.  

4. Specify parameters for the selected Action – select character ID; in the “Select Method” 
screen specify “ACTION” with the following parameters: “Amazement” and “Return upon 
completion”. Confirm your choice. At this point, configuration of the relationship among the 
Objects is completed. 

 



 

In the above example, the Event of the "Question" Object has been used for launching Action. 
However, any other Events or delayed Actions can be employed for the same purpose.  

Object methods 

The following Methods can be used when working with Object: 

 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state. When you select 
automatic return into the idle mode, the above-mentioned Action phases will be automatically 
executed one after another. When we select wait for signal to return to idle mode, only the first 
phase - execution of the Action itself - is launched. The return to idle state is postponed until 
you use the “IDLE” Method or launch any other Action (in that case, before the new Action can 
be executed, the Object returns to the idle state automatically).  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 



concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

curState  Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState Last state (action) - one of action token (short names) $OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $OBJ_ID.queue 

5.3.11.7 Arabian 

An “Agent” is an animated character with a set of basic Actions which can be launched using 
this Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  



 

Object parameters 

 

You can specify an Agent’s appearance and display parameters (similar to Flash-movie display 
settings, in fact, an Agent is a Flash-movie). 

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 

"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.  See detailed description of object control in "Agent" document. 

Object methods 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/agent_001.html


The following Methods can be used when working with Agent Character: 

 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state.  

When you select automatic return into the idle mode, the above-mentioned Action phases will 
be automatically executed one after another. When we select wait for signal to return to idle 
mode, only the first phase - execution of the Action itself - is launched. The return to idle state 
is postponed until you use the “IDLE” Method or launch any other Action (in that case, before 
the new Action can be executed, the Object returns to the idle state automatically).  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 
concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property  Returns Syntax 

curState Current state (action) - one of action token (short names) $ OBJ_ID .curState 

lastState Last state (action) - one of action token (short names) $ OBJ_ID .lastState 

queue  Action queue (action tokens, comma-delimited) $OBJ_ID.queue 



5.3.11.8 Animals 

An “Agent” is an animated character with a set of basic Actions which can be launched using 
this Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

Example of Object:  

 

Object parameters 

 

You can specify an Agent’s appearance and display parameters (similar to Flash-movie display 
settings, in fact, an Agent is a Flash-movie). 

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 

"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.  See detailed description of object control in "Agent" document. 

Object methods 

The following Methods can be used when working with Agent Character: 

 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state.  

When you select automatic return into the idle mode, the above-mentioned Action phases will 
be automatically executed one after another. When we select wait for signal to return to idle 
mode, only the first phase - execution of the Action itself - is launched. The return to idle state 
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is postponed until you use the “IDLE” Method or launch any other Action (in that case, before 
the new Action can be executed, the Object returns to the idle state automatically).  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 
concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

curState  Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState Last state (action) - one of action token (short names) $OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $OBJ_ID.queue 

5.3.11.9 Hare 

An “Agent” is an animated character with a set of basic Actions which can be launched using 
this Object’s Methods.  

IMPORTANT! This object is created using Adobe Flash technology so make sure to 
turn on this feature which checks whether or not Flash Player has been installed 
on the target machine before loading the learning Module.  

 

Object parameters 



 

In case "Warn if security settings are too strict" checkbox is set and there is no possibility to 
setup connection with Agent Flash-movie, warning message will appear. 

"Use HTTPS in codebase attribute" is used to check Flash Player version using secure protocol 
HTTPS. If you do not know if you need it or not - just left it set.  

Object control 

By default, Object is displayed in “idle” mode for an indefinite period of time. Object Methods 
(functions embedded in the Object, which modify the state of the Agent) are used to control 
the Agent.  See detailed description of object control in "Agent" document. 

Object methods 

The following Methods can be used when working with Agent Character: 

 ACTION – forces the Agent to execute some of the Actions defined in the Object. It has 2 parameters: Action itself 

(which needs to be executed) and an option for returning back to the idle state (the Agent can automatically return to 
the idle state or remain in the current state awaiting the return command).  

 IDLE – takes Agent back to the idle mode.  

 TELEPORT - relocates Agent into a location, specified by coordinates, using effects.  

Let us review the “ACTION” Method in greater details. Almost all Actions embedded into the 
Object have two execution phases: Action execution and return to idle state.  

When you select automatic return into the idle mode, the above-mentioned Action phases will 
be automatically executed one after another. When we select wait for signal to return to idle 
mode, only the first phase - execution of the Action itself - is launched. The return to idle state 
is postponed until you use the “IDLE” Method or launch any other Action (in that case, before 
the new Action can be executed, the Object returns to the idle state automatically).  

Sequence of Actions  

If the agent receives a command for a new Action while it is not in the idle mode ( meaning it is 
in the process of completion of a previous Action) this command is stored in the agent’s 
“commands queue” and new Action is postponed until the previous one finishes execution. The 
“Command queue” of the “Agent” role is based on the FIFO (First In First Out) data handling 
concept: i.e. each new incoming Action command is added to the end of the execution line. 
Therefore, by employing the “Command queue” you can create any sequence of Actions for the 
character.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  
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Event Triggered Upon 

on Ready When Flash-movie is fully loaded and ready to accept commands 

on Action End When any action is ended 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

curState  Current state (action) - one of action token (short names) $OBJ_ID.curState 

lastState Last state (action) - one of action token (short names) $OBJ_ID.lastState 

queue  Action queue (action tokens, comma-delimited) $OBJ_ID.queue 

 

  



5.3.12 Lists 

5.3.12.1 Bulleted List 

Bulleted List object is used for creating sequentially appearing list of statements. It contains the 
list of items with built-in display manipulation mechanisms. 

IMPORTANT! Since this object contains built-in display mechanisms, the actual 
duration might not be in accordance with the duration specified in the Time 
panel for the Frame. 

Example of object appearance:  

 

Object parameters 

 



Fill in the statements list. You can select bullet type and other appearance parameters for each 
list item. Set button top margin (if you plan to use it) and divider lines between list items. 

Depending on selected display mode parameters list on "Display" tab will be different. Default 
mode is On user click (this mode include text link, form and image buttons - all controls that 
activated with mouse click). Define button or link parameters. 

 

In Delayed auto mode the only available parameter is Item display delay (in seconds). 



 

Third mode - On external call - means that no list controls will be displayed and items will 
appear only when object's method NEXT ITEM will be used. The only parameter here is Display 
first item automatically.  

 

Select “Effects” tab. 



 

In case “Use Transitions” check box is marked on "Effects" tab, you can choose any of the 
standard transition effects. Positive numbers (greater than 0) are used to set Time of the 
transition in seconds.  

LIMITATIONS: Due to lack of transition support in some browsers, transition 
effects might be substituted to closest available in browsers other than Internet 
Explorer.  



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Item Displayed At the moment when Item begins to display 

  

Object Methods  

The state of the Object can be modified using methods. 



Method name  Execution Result 

DISPLAY NEXT ITEM  Start displaying of next item in queue. 

  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

lastItem  Returns number of last displayed item (starting from 1). $OBJ_ID.lastItem  

nextItem  Returns number of next displayed item (if exists). $OBJ_ID.nextItem  

totalItems  Returns total number of items. $OBJ_ID.totalItems  

5.3.12.2 Simple List 

Simple List object is used for creating sequentially appearing list of statements. It contains the 
list of items with built-in display manipulation mechanisms. 

IMPORTANT! Since this object contains built-in display mechanisms, the actual 
duration might not be in accordance with the duration specified in the Time 
panel for the Frame. 

Example of object appearance:  

 

Object parameters 



 

Fill in the statements list. You can select item appearance parameters for each list item. 

Depending on selected display mode parameters list on this tab will be different. Default mode 
is On user click (this mode include text link, form and image buttons - all controls that activated 
with mouse click). Define button or link parameters. 



 

In Delayed auto mode the only available parameter is Item display delay (in seconds). 



 

Third mode - On external call - means that no list controls will be displayed and items will 
appear only when object's method NEXT ITEM will be used. The only parameter here is Display 
first item automatically.  

 

In case “Use Transitions” check box is marked on "Effects" tab, you can choose any of the 
standard transition effects. Positive numbers (greater than 0) are used to set Time of the 
transition in seconds.  



 

LIMITATIONS: Due to lack of transition support in some browsers, transition 
effects might be substituted to closest available in browsers other than Internet 
Explorer.  



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Item Displayed At the moment when Item begins to display 

Object Methods  

The state of the Object can be modified using methods. 



Method name  Execution Result 

DISPLAY NEXT ITEM  Start displaying of next item in queue. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

lastItem  Returns number of last displayed item (starting from 1). $OBJ_ID.lastItem  

nextItem  Returns number of next displayed item (if exists). $OBJ_ID.nextItem  

totalItems  Returns total number of items. $OBJ_ID.totalItems  

5.3.12.3 Standard List 

Standard List object is used for creating sequentially appearing list of statements. Object 
consists of Standard list items. It contains the list of items with built-in display manipulation 
mechanisms. 

IMPORTANT! Since this object contains built-in display mechanisms, the actual 
duration might not be in accordance with the duration specified in the Time 
panel for the Frame. 

Example of object appearance:  

 

Object parameters 



 

Select border color for the list items with respect to the overall design. Select items mark for 
the list Item. Input text for the list items. Specify value for text margin and space between 
items. Text margin defines the space between border of the window and text block.  



 

Object enables displaying the list of items either consecutively, in automatic mode with user 
defined time delays or  by accepting user input in a form of pressed button or clicked text link. 
On external call mode means that no list controls will be displayed and items will appear only 
when object's method NEXT ITEM will be used. The only parameter here is Display first item 
automatically.  



 

In case “Use Transitions” check box is marked, you can choose any of the standard transition 
effects. Positive numbers (greater than 0) are used to set Time of the transition in seconds.  

LIMITATIONS: Due to lack of transition support in some browsers, transition 
effects might be substituted to closest available in browsers other than Internet 
Explorer.  



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Item Displayed At the moment when Item begins to display 

  

Object Methods  

The state of the Object can be modified using methods. 



Method name  Execution Result 

DISPLAY NEXT ITEM  Start displaying of next item in queue. 

  

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

lastItem  Returns number of last displayed item (starting from 1). $OBJ_ID.lastItem  

nextItem  Returns number of next displayed item (if exists). $OBJ_ID.nextItem  

totalItems  Returns total number of items. $OBJ_ID.totalItems  

5.3.12.4 Standard Block-List 

Standard Block-List object is used for creating lists of semantically related block statements, 
which will be displayed simultaneously. 

Example of object appearance:  

 

Object parameters 

 



Select border color for the list items with respect to the overall design. Select items mark for 
the list Item. Input text for the list items. Specify value for text margin. Text margin defines the 
space between border of the window and text block.  

5.3.12.5 Standard List Item 

Standard List Item object is used for creating Lists, which contain clearly highlighted 
statements. 

Example of object appearance:  

 

Object parameters 

 

Select border color of item with respect to the overall design. Select marker type for the list 
Item. Input text for the list item. Specify value for text margin. Text margin defines the space 
between border of the window and text block. 

5.3.12.6 Simple List Item 

Simple List Item object is used for creating Lists, which contain clearly highlighted statements. 

Example of object appearance:  

 

Object parameters 



 

Select item background color and border color of item with respect to the overall design. 
Select marker type for the list Item. Input text for the list item. Specify value for text margin. 
Text margin defines the space between border of the window and text block. 

5.3.12.7 Animated List 

Animated Listиспользуется обычно для создания списков утверждений, появляющихся по 
очереди. Содержит встроенные механизмы управлением показа элементов.  

IMPORTANT! Since this object contains built-in display mechanisms, the actual 
duration might not be in accordance with the duration specified in the Time 
panel for the Frame. 

Example of object appearance:  

 

Object parameters 



 

Select main element color and marker color, according to your design requirements. Select 
transition effects. This Object can use additional Zoom in and Fly in effects. 

 

Select marker type. Fill elements text. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Item Displayed At the moment when Item begins to display 



on First Item Displayed Immediately after first list item is displayed 

on Last Item Displayed Immediately after last list item is displayed 

 

  



5.3.13 Textboxes 

5.3.13.1 Shaded Text Box 

Shaded Text Box object enables placing desired text box with modified display settings 
(including shadow effects). Compared to embedded regular text box, this one enables using 
special effects for text appearance.  

IMPORTANT! Internet Explorer 5.5 and above should be used for correct shading 
display, however, text box will be visible in older versions of browser.  

Note, that this object is capable to make text substitution in Rich Text. Text 
substitutions can be variable values and object properties. Because Rich Text 
format is quite complex, additional markers for substitution area are used - 
double curle brackets. Text substitutions will be applied only for double curle 
brackets areas. For example {{$OBJ_19.x}} will be substituted by value of X 
coordinate of OBJ_19 object's top-left corner, and {{#att_left}}will be substituted by 
value of CourseLab variable named att_left. If no substitution is found, all double 
curle brackets area will remain intact. 

 

Object parameters 

 



To input text into the text box, press “TE” button of the corresponding field. The format of 
input area of the Text box is Rich Text, therefore all font settings (size, color, and style) will be 
saved as you type the text in. 

If desired, modify value for text margin. Text margin defines the space between border of the 
box and text. 

You can change text box fill color. You can modify style, color, and width for the text box 
border. Заметьте, что граница бокса также подчиняется этому параметру.  

Finally, you can modify opacity of the main box. Please be advised that any changes applied to 
the opacity, affects the border of the text box as well. In case text box Shading is On, it is not 
recommended to use opacity less than 100%. 

 

Use “Shadow” tab to specify display settings for shading effect. The key control is Display Box 
Shadow check box. In case this check box is not marked then all other settings are disabled for 
editing. 

In case text box Shading is On, you can specify vertical and horizontal Shadow Shift with 
relation to the main box as well as opacity. We recommend using opacity of 40%, which is a 
default opacity value. 

The next check box is Shadow copies main box. In case this check box is marked, such shading 
box settings as background color, style, color, and width of the box border will be copied from 
the main box settings (it will look more natural when combined with 40% opacity). However, if 
you need to change shading display with regards to main block, you can uncheck the Shadow 
copies main box check box, then shading box settings become available for editing.  



 

On the “Effects” tab you can enable character iteration display mode for the text in the main 
box. In this case you can specify text occurrence frequency rate.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Text Refreshed After text is refreshed 

on Text Added After text is added 

on Typewriter End After the moment when typewriter effect types last text character. 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

CLOSE Closes the object. 

REFRESH TEXT Refreshes the text in the object, Can be useful if the text contains dynamically changed substitutes. 

ADD TEXT  Adds the text to the current text. Note, that the style of closest paragraph will be used for new text. 

5.3.13.2 Relief Text Box 



Relief Text Box enables placing the desired text into the box with convex border. Compared to 
embedded regular text box, this Text Box enables using special effects and scrolling for text 
occurrence. 

Note, that this object is capable to make text substitution in Rich Text. Text 
substitutions can be variable values and object properties. Because Rich Text 
format is quite complex, additional markers for substitution area are used - 
double curle brackets. Text substitutions will be applied only for double curle 
brackets areas. For example {{$OBJ_19.x}} will be substituted by value of X 
coordinate of OBJ_19 object's top-left corner, and {{#att_left}}will be substituted by 
value of CourseLab variable named att_left. If no substitution is found, all double 
curle brackets area will remain intact. 

Example of object appearance:  

 

Object parameters 

 

Select color of the box border with respect to the overall design. To input text into the text 
box, press “TE” button of the corresponding field. The format of input area of the Text box is 
Rich Text, therefore all font settings (size, color, and style) will be saved as you type the text in. 
If needed, modify value for inner margin. Inner margin defines the space between box border 
and text. By default, text margin is equal to 5 pixels.  Set Overflow style if needed - default 
value Autoscroll is suitable for  most cases. 

If appropriate checkbox is marked, text box can be closed on mouse click anywhere within a 
box. 



 

On the “Effects” tab you can enable character iteration display mode for the text in the main 
box. In this case you can specify text occurrence frequency rate.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Text Refreshed After text is refreshed 

on Text Added After text is added 

on Typewriter End After the moment when typewriter effect types last text character. 

  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

CLOSE Closes the object. 

RESIZE Changes the size of the object. Note, that top-left corner position of the object is fixed. 

REFRESH TEXT Refreshes the text in the object, Can be useful if the text contains dynamically changed substitutes. 

ADD TEXT  Adds the text to the current text. Note, that the style of closest paragraph will be used for new text. 

5.3.13.3 Simple Text Box 

Simple Text Box enables placing the desired text into the box with optional border and 
different scrolling settings. Compared to embedded regular text box, this Text Box enables 
using scrolling and special effects for text occurrence. 



Note, that this object is capable to make text substitution in Rich Text. Text 
substitutions can be variable values and object properties. Because Rich Text 
format is quite complex, additional markers for substitution area are used - 
double curle brackets. Text substitutions will be applied only for double curle 
brackets areas. For example {{$OBJ_19.x}} will be substituted by value of X 
coordinate of OBJ_19 object's top-left corner, and {{#att_left}}will be substituted by 
value of CourseLab variable named att_left. If no substitution is found, all double 
curle brackets area will remain intact. 

Example of object appearance:  

 

Object parameters 

 

To input text into the text box, press “TE” button of the corresponding field. The format of 
input area of the Text box is Rich Text, therefore all font settings (size, color, and style) will be 
saved as you type the text in. 

If needed, modify value for inner margin. Inner margin defines the space between box border 
and text. By default, text margin is equal to 5 pixels. Set Overflow style if needed - default value 
Autoscroll is suitable for  most cases. 



If appropriate checkbox is marked, text box can be closed on mouse click anywhere within a 
box. 

 

On the “Effects” tab you can enable character iteration display mode for the text in the main 
box. In this case you can specify text occurrence frequency rate.  

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon  

on Text Refreshed After text is refreshed 

on Text Added After text is added 

on Typewriter End After the moment when typewriter effect types last text character. 

  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

CLOSE Closes the object. 

RESIZE Changes the size of the object. Note, that top-left corner position of the object is fixed. 

REFRESH TEXT Refreshes the text in the object, Can be useful if the text contains dynamically changed substitutes. 

ADD TEXT  Adds the text to the current text. Note, that the style of closest paragraph will be used for new text. 



5.3.13.4 Gradient Box 

Gradient Box enables placing the desired text into the box with optional border and different 
scrolling settings. Compared to embedded regular text box, this Text Box enables using scrolling 
and special effects for text occurrence. 

Note, that this object is capable to make text substitution in Rich Text. Text 
substitutions can be variable values and object properties. Because Rich Text 
format is quite complex, additional markers for substitution area are used - 
double curle brackets. Text substitutions will be applied only for double curle 
brackets areas. For example {{$OBJ_19.x}} will be substituted by value of X 
coordinate of OBJ_19 object's top-left corner, and {{#att_left}}will be substituted by 
value of CourseLab variable named att_left. If no substitution is found, all double 
curle brackets area will remain intact. 

Example of object appearance:  

 

Object parameters 



 

To input text into the text box, press “TE” button of the corresponding field. The format of 
input area of the Text box is Rich Text, therefore all font settings (size, color, and style) will be 
saved as you type the text in.Установите параметры внешнего вида. Select color scheme of 
the box with respect to the overall design. If needed, modify value for inner margin. Inner 
margin defines the space between box border and text. 

This Object always has size of its placeholder, scroll bar will be added automatically, when text 
size will exceed Object size. Vertical alignment is applicable only if text size is less than Object 
size. 

If appropriate checkbox is marked, text box can be closed on mouse click anywhere within a 
box. 



 

You can use transition effects for this Object. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Text Refreshed After text is refreshed 

on Text Added After text is added 

  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

REFRESH TEXT Refreshes the text in the object, Can be useful if the text contains dynamically changed substitutes. 

ADD TEXT  Adds the text to the current text. Note, that the style of closest paragraph will be used for new text. 

 



  



5.3.14 Test 

5.3.14.1 Test 

Test object presents the set of questions of different types. 

“Test” object supports these types of the questions used in CourseLab: 

 single choice  

 multiple select  

 ordered items  

 numeric fill-in-blank  

 text fill-in-blank  

 matching pairs. 

LIMITATION: No more than one Test on the Slide is recommended.   

Object parameters 



 

Use “Questions” tab to add any number of questions to the list of the questions by pressing “+” 
button. The opened edit screen practically duplicates the object “Question” edit window of the 
corresponding type, the only difference is that some common test parameters are missing. 
Please see the question object descriptions for more details.  

By default all question in the list are displayed to yser, but you can also define random selection 
from list of question to be displayed.  

WARNING! Be aware that you will need to calculate maximal score for the test 
manually (to use it in maximal score for objective). Also note that if you plan to 
use this module within an LMS, limits on amount of stored data may apply 
depending on e-learning standard used and LMS properties. Every test question 
stores its data (and length of data depends on complexity of question), therefore 
it is recommended not to exceed 20-40 questions in test. The only standard that 
allows large amount of data to be stored is SCORM 2004.  



 

You can set the test as “not credited”, if needed (for example when the test is a part of the 
learning process or an additional exercise rather than knowledge testing) by removing Scored 
Test mark on the “Limitations and scoring” tab.  

You can permit or restrict timing in questions (Use “Enable time limitation for test” check box) 
if timing is defined. In addition, you can specify time limit for the whole test (use “Limit test 
duration” check box and corresponding field). 

You can permit the option of skipping the question by marking corresponding check box, 
however, question will be classified as skipped (with opportunity to provide the answer later). 
Besides that, you can allow the second run for the test. If this option is unchecked, the user will 
be prompted with message stating that test had already been taken and only test results can be 
viewed. In case this option is marked, the student will be prompted with the same as above 
warning message, but with the two options available to choose from: one is to take test again 
and second is to see test results. If test is taken again, all previous test results are discarded. 
Also you can permit or restrict display of pictures related to the questions for the entire Test. 

IMPORTANT! You can not set up Objective for storing results of the entire test, 
instead, when editing each question specify parameters settings for required 



Objective(s). Such approach allows maximum flexibility when evaluating test 
results.  

 

You may permit the display of correct answer upon question completion by marking 
corresponding check box. If student has used off all the attempts for response, or if the time 
has expired then the correct answer will be displayed; user will not be credited for this answer. 
This option may be used when the main objective of the question is educating rather than 
testing.  



 

On the "Display" tab you can select basic appearance settings for the object.  



 



 

On the "Messages" and "Texts" tabs you can edit the information and warning messages of the 
test.  



 



 

On the "Buttons" and "Spots" tabs you can define custom question and test buttons and active 
spots for single choice, multiple select and order type of questions. 

On the "Sound" tab you can switch click and mouseover sounds on and off, or change it to 
custom sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Question Start The question is fully loaded and all elements of the question are displayed 

on Choice Change Item configuration changed in single choice question 



on Select Change Item configuration changed in multiple select question 

on Item Order Changed Item configuration changed in order question 

on Numeric Value Changed Value changed in numeric question 

on Text Value Changed Value changed in text question 

on Match Changed Item configuration changed in matching pairs question 

on Attempt At the moment of answer acceptance, but before answer evaluation 

on Success At the moment of answer evaluation, in case the answer is correct. 

on Failure At the moment of answer evaluation, in case the answer is incorrect. 

on Time Out At the moment of time expiration for the answer (if defined) 

on Attempts Limit  After answer evaluated, in case the number of attempts decreased to zero.  

on Question Skipped After “Skip Question” button is pressed 

on Question End After answer is evaluated and no more attempts left (on timeout or on attempts limit)  

on Test Timer Tick Every second while test timer is active 

on Test Timeout At the moment of time expiration for the whole test (if defined) 

on Test End After all questions are answered or test timeout 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

testMode Returns current test mode (tokens: "normal", "review"). $OBJ_ID.testMode 

questionNumber Returns current question number (starting from 0, first question has 0 
number). 

$OBJ_ID.questionNumber 

totalQuestionQuantity Returns total questions quantity in current test. $OBJ_ID.totalQuestionQuantity 

testDuration  Returns allowed test duration in seconds (if exists). $OBJ_ID.testDuration 

testTimer Returns current test timer value in seconds (if exists). $OBJ_ID.testTimer 

questionType Returns current question type (tokens: "choice", "select", "range", 
"numeric", "text", "oto").  

$OBJ_ID.questionType 

questionDuration  Returns allowed question duration in seconds (if exists). $OBJ_ID.questionDuration 

questionTimer Returns current question timer value in seconds (if exists). $OBJ_ID.questionTimer 

itemQuantity  Returns total variants quantity. $OBJ_ID.itemQuantity 

questionValue Returns current question answer value (format corresponds to 
question type).  

$OBJ_ID.questionValue 

attemptsLast  Returns current number of attempts. $OBJ_ID.attemptsLast 

attemptsTotal Returns allowed number of attempts. $OBJ_ID.attemptsTotal 

5.3.14.2 QTI Test 

QTI TestObject allows to display questions from the external QTI file. 

IMPORTANT! This Object can support only QTI 1.2 files (full support of QTI 
standard is not guarantied). 



QTI file cannot be used in edit mode, therefore only placeholder of the QTI Test is visible: 

 

The same Object in real Course looks different - in sequential mode (by Question): 

 

or in List mode: 



 

This Object object supports these types of the questions used in CourseLab: 

 single choice  

 multiple select  

 ordered items  

 numeric fill-in-blank  

 text fill-in-blank  

 matching pairs. 

LIMITATION: This Object does not support Images and other media objects - only 
text parameters from QTI file are used. 

Object parameters 



 

On the "Questions" tab define source of questions - QTI file or URL. If local file is selected - it 
will be automatically copied into Module's images folder. In case you select URL of the file - file 
will not be copied. Select questions display mode: sequentially (by question) or full list (in this 
case answer is submitted for all questions simultaneously). 

IMPORTANT! Be aware, that loading file from external URL may be the subject of 
browser security settings (cross-domain security). 

"Select questions randomly" checkbox allows random selection of questions from all questions 
in file.  

WARNING! Be aware that you will need to calculate maximal score for the test 
manually (to use it in maximal score for objective). Also note that if you plan to 
use this module within an LMS, limits on amount of stored data may apply 
depending on e-learning standard used and LMS properties. Every test question 
stores its data (and length of data depends on complexity of question), therefore 
it is recommended not to exceed 20-40 questions in test. The only standard that 
allows large amount of data to be stored is SCORM 2004.  

Most of test and questions parameters are defined in QTI file, but you can change or override 
some of them. 



 

On "Parameters" tab you can define Objectives for all questions of the QTI Test. Unlike usual 
Test, there is no possibility to bind Objectives to distinct questions. 

You can permit the option of skipping the question by marking corresponding check box, 
however, question will be classified as skipped (with opportunity to provide the answer later). 
Besides that, you can allow the second run for the test. If this option is unchecked, the user will 
be prompted with message stating that test had already been taken and only test results can be 
viewed. In case this option is marked, the student will be prompted with the same as above 
warning message, but with the two options available to choose from: one is to take test again 
and second is to see test results. If test is taken again, all previous test results are discarded. 
Also you can permit or restrict display of pictures related to the questions for the entire Test. 

file:///C:/Users/Weblin/Documents/CHM27/en-US/Project1_output/SingleHTML/Objects/q_099_test.html


 

You can enable or disable feedback messages. Feedback messages are defined in QTI file. 
When enabled, feedback messages will be displayed in special text block - you can change its 
width. 



 

On the "Display" tab you can select basic appearance settings for the object.  



 

On the Controls tab you can change display parameters for Control elements: progress-
indicators and buttons. 



 

On the "Background" tab you can switch displaying of background on and off and define its 
display parameters: 

 color scheme (one of predefined or custom),  

 border width (in pixels),  

 fill gradient angle - from 0 (north direction) to 360 degrees counterclockwise,  

 corner radius,  

 inner margin.  



 

On "Instruction" and "Texts" tabs you can change text constants that are used in the Object. 



 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Test Displayed Test is fully loaded and ready 

on Timeout At the moment of time expiration for current question (if defined) 

on Test Timeout At the moment of time expiration for the whole test (if defined) 

on Test End After all questions are answered or test timeout 

5.3.14.3 Current Results 

Current Results object allows to display current score in one objective (usually for main module 
objective). 

Example of Object appearance: 



 

Object parameters 

 

On the Parameters tab you can select objective, which score will be displayed and parameters, 
that will be displayed. 

You can edit descriptions for current and maximal scores. 

Use Normalize to 100% checkbox to display percent values (display only, that it has no impact 
to real scores). 

 

On the "Display" tab you can edit the color and font parameters.  

Object Methods  



The state of the Object can be modified using methods. 

Method name  Execution Result 

REFRESH TEXT Refreshes current score values. 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

objectiveID Returns objective identifier. $OBJ_ID.objectiveID 

rawScore Returns raw objective score. $OBJ_ID.rawScore 

scaledScore Returns scaled objective score (if can be calculated). $OBJ_ID.scaledScore 

maxScore Returns maximal objective score (if defined). $OBJ_ID.maxScore 

5.3.14.4 Results by Objectives 

Results by Objectives object allows to display current score in several objectives 
simultaneously. 

Example of Object appearance: 

 

Object parameters 

 



On the Scales tab you can select objectives list, which score will be displayed and parameters 
for each objective. 

Use Normalize to 100% checkbox to display percent values (display only, that it has no impact 
to real scores). 

 

On the "Display" tab you can edit the color and font parameters.  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

REFRESH TEXT Refreshes current score values. 

5.3.14.5 Detailed Results 

Detailed Results is used for dislaying detailed results on Question objects. 

LIMITATION: Object CANNOT display results on QTI Test objects. 

Example of Object appearance: 



 

Object parameters 

 

On the "Objects" tab you can define the list of Objects to display statistics, and details to be 
displayed. 



 

On the "Text Constants" tab you can edit all object text constants.  

  



5.3.15 Form 

5.3.15.1 Text Field 

Text Field enables user to input text using keyboard. Inserted values are accessible in a form of 
variables within CourseLab and may be employed in different actions. 

IMPORTANT! The value entered is recorded in associated variable when user 
leaves field only. 

Example of Object appearance: 

 

Object parameters 

 

Specify variable name, which will be used for storing user input.  

LIMITATION: Variable names must contain only Latin alphabet letters, and numbers, and 

must not start with a digit. Variable names must be unique within a Slide or Module 
(depending on selected variable scope).   

If necessary, specify default text, which will be displayed in the field once the Object loads up. 
If necessary, you may set restrictions on user-input length of value in characters. 



 

Use “Display” tab to specify the field appearance.  

 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 



Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Field Focus Lost At the moment when text is inserted and cursor leaves field 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE INPUT  Restrict access to input field. 

ENABLE INPUT  Permit access to input field. 

SET VALUE Set input field value 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

value Returns current input field value. $OBJ_ID.value 

5.3.15.2 Hidden Text Field 

Hidden Text Field enables user to input text or numbers using keyboard. At display input text is 
replaced with bullets. Moving forward, inserted values are accessible in a form of variables 
within CourseLab and may be employed in different actions. 

IMPORTANT! The value entered is recorded in associated variable when user 
leaves field only. 

Example of Object appearance: 

 

Object parameters 



 

Specify variable name, which will be used for storing user input.  

LIMITATION: Variable names must contain only Latin alphabet letters, and numbers, and 

must not start with a digit. Variable names must be unique within a Slide or Module 
(depending on selected variable scope).   

If necessary, specify default text, which will be displayed in the field once the Object loads up. 
If necessary, you may set restrictions on user-input length of value in characters. 

 

Use “Display” tab to specify the field appearance.  



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Field Focus Lost At the moment when text is inserted and cursor leaves field 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE INPUT  Restrict access to input field. 

ENABLE INPUT  Permit access to input field. 

SET VALUE Set input field value 

Object Specific Properties  



Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

value Returns current input field value. $OBJ_ID.value 

5.3.15.3 Text Area 

Text Area enables user to enter large amount of text using keyboard. Moving forward, inserted 
values are accessible in a form of variables within CourseLab and may be employed in different 
actions.  

IMPORTANT! The value entered is recorded in associated variable when user 
leaves field only. 

Example of Object appearance: 

 

Object parameters 



 

Specify variable name, which will be used for storing user input.  

LIMITATION: Variable names must contain only Latin alphabet letters, and numbers, and 

must not start with a digit. Variable names must be unique within a Slide or Module 
(depending on selected variable scope).   

If necessary, specify default text, which will be displayed in the field once the Object loads up. 

If necessary, specify text wrapping rules. The default behavior for Text Area is to automatically 
move to a new line, once the length of text line exceeds the right margin (Automatic soft 
wrap). This is rather “Virtual” text wrapping, in fact, if you enlarge Text Area text will wrap at 
the different position. Other wrapping rules: 

 Automatically move to a new line and insert CRLF (carriage return /line feed) character, once the length of text line 

exceeds the right margin (Automatic hard wrap). If Text Area is enlarged, wrap point will remain at the same 

position.  

 Move to a new line only when “Enter” button is pressed, otherwise, horizontal scroll bar will be displayed, once the 

length of text line exceeds the right margin (Manual wrap).  

Note: By pressing the “Enter” key, CRLF is inserted in either one of the above 
mentioned cases. 



 

Use “Display” tab to specify the field appearance.  

 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 



Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Field Focus Lost At the moment when text is inserted and cursor leaves field 

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE INPUT  Restrict access to input field. 

ENABLE INPUT  Permit access to input field. 

SET VALUE Set input field value 

Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

value Returns current input field value. $OBJ_ID.value 

5.3.15.4 CheckBox 

CheckBox enables user making Yes/No selections. Inserted values are accessible in a form of 
variables within CourseLab and may be employed in different actions.  

IMPORTANT! The value entered is recorded in associated variable when user 
leaves field only. 

Example of Object appearance: 

 

Object parameters 



 

Specify variable name, which will be used for storing user input.  

LIMITATION: Variable names must contain only Latin alphabet letters, and numbers, and 

must not start with a digit. Variable names must be unique within a Slide or Module 
(depending on selected variable scope).   

Specify value for the variable, in case user marks CheckBox and when CheckBox is unchecked. 
Default values are true/false.  

Specify initial state, which is whether or not CheckBox is marked after Object loads up.  



 

Use “Display” tab to specify the field appearance.  

The essential CheckBox is “Show description”. In case it is not marked, all other tab parameters 
are disabled for editing, therefore only CheckBox will be displayed on the Slide.  

In case “Show description” CheckBox is selected, you can input description text into the field, 
which is in Rich Text Format mode. If needed, modify value for text margin . Text margin 
defines the space between CheckBox border and text. Additionally, you can specify position 
(right or left) of the text description with regards to the CheckBox.  



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Check  User sets checkmark  

on Uncheck  User removes checkmark  

on State Changed User sets or removes checkmark. This event is triggered right before events mentioned above.  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE INPUT  Restrict access to input field. 

ENABLE INPUT  Permit access to input field. 

SET STATE Set checkbox state 



Object Specific Properties  

Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

value Returns 1 if object is currently checked, 0 otherwise. $OBJ_ID.value 

5.3.15.5 Group of Radio Buttons 

Group of Radio Buttons enables user making single Yes/No selection for one out of several 
values. Inserted values are accessible in a form of variables within CourseLab and may be 
employed in different actions.  

IMPORTANT! The value entered is recorded in associated variable when user 
leaves field only. 

Example of Object appearance: 

 

Object parameters 

 

Specify variable name, which will be used for storing user input.  



LIMITATION: Variable names must contain only Latin alphabet letters, and numbers, and 

must not start with a digit. Variable names must be unique within a Slide or Module 
(depending on selected variable scope).   

Fill in the list of possible variable values. Open Input screen by clicking on the “+” icon. Enter 
the text description for the selected value into the field, which is in Rich Text Format mode. 
Specify value for the variable, in case user marks Radio Button. Specify initial condition, which 
is whether or not Radio Button is checked after Module loads up.    

LIMITATION: No more than one value should be initially selected for this type of 
object.  

 

Use “Display” tab to specify the field appearance.  

The essential CheckBox is “Show description”. In case it is not marked, all other tab parameters 
are disabled for editing, therefore only CheckBox will be displayed on the Slide.  

In case “Show description” CheckBox is selected, you can input description text into the field, 
which is in Rich Text Format mode. If needed, modify value for text margin . Text margin 
defines the space between CheckBox border and text. Additionally, you can specify position 
(right or left) of the text description with regards to the CheckBox.  



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on State Changed User sets checkmark on Radio Button.  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE INPUT  Restrict access to input field. 

ENABLE INPUT  Permit access to input field. 

Object Specific Properties  



Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

value Returns value of currently checked radio button. $OBJ_ID.value 

5.3.15.6 Drop-down Menu 

Drop-down Menu enables user making single choice selections out of a multiple values. 
Inserted values are accessible in a form of variables within CourseLab and may be employed in 
different actions. 

IMPORTANT! The value entered is recorded in associated variable when user 
leaves field only. 

Example of Object appearance: 

 

Object parameters 

 

Specify variable name, which will be used for storing user input.  

LIMITATION: Variable names must contain only Latin alphabet letters, and numbers, and 

must not start with a digit. Variable names must be unique within a Slide or Module 
(depending on selected variable scope).   



Fill in the list of possible variable values. Open Input screen by clicking on the “+” icon. Enter 
the text description for the selected value and specify value for the variable, in case user 
selects particular menu item. Specify initial condition, which is whether or not Menu-Item is 
selected after Module loads up.    

LIMITATION: No more than one value should be initially selected for this type of 
object.  

 

Use “Display” tab to specify the Drop-down Menu display. Note: these settings will affect all 
menu-items. 



 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 

Object Events  

Object is capable generating events with regards to the user's actions and interpretation of the 
actions by the object. When combined with actions events can be employed for building up 
intellectual behavior models for other objects depending on the current state of the Object. 
Events are available using CourseLab built-in events manipulation mechanism.  

Event Triggered Upon 

on Item Selected User selects Menu Item  

Object Methods  

The state of the Object can be modified using methods. 

Method name  Execution Result 

DISABLE INPUT  Restrict access to input field. 

ENABLE INPUT  Permit access to input field. 

Object Specific Properties  



Along with common object properties, this object has some specific properties, that can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property Returns Syntax 

disabled  Returns 1 if object is currently disabled, 0 otherwise. $OBJ_ID.disabled 

value Returns current input field value. $OBJ_ID.value 

selectedName Returns currently selected item description. $OBJ_ID.selectedName 

5.3.15.7 Button 

Pressed Button enables triggering of the previously created actions. 

Example of Object appearance: 

 

Object parameters 

 

The only parameter on the first tab to fill is the button text.  



 

Use “Display” tab to specify the Button display. 

 

On the "Sound" tab you can switch item display sounds on and off, or change it to custom 
sounds 

IMPORTANT! Sounds must be short and have no starting lag. Otherwise it may 
lead to undesirable delays in course playing. 



5.3.16 Creating customized copies of Objects 

Starting from CourseLab version 2.5, you can add to CourseLab Objects Library customized 
copies of standard objects. 

DISCLAIMER: You cannot edit or change CourseLab standard Objects in any way. 
WebSoft Ltd. shall not be liable for correct work of modified copies of Objects and 
no support will be provided for these modified Objects.  

For example, lets make the copy of Single Choice Question Object: 

1. Insert basic Single Choice Question Object on any Slide. 

2. Customize the Object's parameters, i.e. view, color schemes, standard messages and 
warnings, feedback and scoring etc. according to your design requirements. 

3. Make sure that Object is displayed correctly when previewing Slide. 

 

4. Keeping this Object selected click "Customize" link at the bottom of Objects Panel.  

 

5. Dialog window with Objects Library structure will be displayed. Note, that it is open exactly 
on the section, which contains selected Object. You may create new Object's copy in the same 
section or in any other section (or even create your own section - right-click on the sections 
panel).  



 

6. Right-click on right panel of Dialog window and select "Create Object" option. 



 

7. Specify identifier for new Object copy. It must be unique and consist of latin characters and 
numbers (no spaces and special characters). 

 

8. Click OK - new Object's copy is created. It still has empty green icon. 



 

9. Create desired graphic file for icon (GIF or PNG, 64x48 pixels) in your favourite graphic editor. 
Double-click on the empty green icon to open Object editor window. Select "Picture" tab. Right-
click on the green icon and select "Load" option.  

 

10. Confirm all your changes clicking OK button. Your customized copy of standard Object is 
ready and will be displayed in Objects Library. 

  



5.4 Cursors 
The learning Courses designed for training on using software programs can contain software 
simulations. Usually, simulation is the sequence of the frames, where mouse cursor moves to 
the predefined menu item, then mouse click is imitated, and after that the next frame displays 
the results of pressing on the specified menu item. For mouse movement illustration the special 
object “Cursor” is employed. 

5.4.1 Using Cursors 

If during recording of simulation the marker “Capture Cursor” is checked, cursor object will be 
inserted into the frames automatically. However, cursor object can be added to the existing 
frames as well. To do so, select Cursor item from the Insert menu. 

 

Cursor will be placed on the current Frame.  

 

Cursor movement path  

The blue line that comes toward cursor represents cursor movement path. 



 

To change starting point of the cursor movement, hold down Ctrl key and double-click into the 
wanted point within a frame. In such a way you can modify the starting point of the cursor only 
on the first Frame within a Slide. For all subsequent frames the starting point of the cursor 
movement will be the cursor’s end point on the previous Frame.  

In order to modify cursor’s end point, simply drag the cursor icon using mouse into the desired 
point within a Slide. 

Select “Previous Frame” menu item from the cursor context menu to merge the final position 
of the cursor with the cursor’s end position on the previous Frame. 

Select “Next Frame” menu item from the cursor context menu to merge the final position of 
the cursor with the cursor’s end position on the next Frame. 

5.4.2 Cursors Movement Time 

It is possible to specify cursor movement starting time and duration of the cursor’s movement. 
Select “Format Cursor” menu item from the cursor context menu… “Format” dialog screen 
opens up. 



 

The “Display” field contains information regarding duration of the cursor movement. 

The “Appear after” field contains information regarding cursor movement starting time. 

Within the same Frame it is possible to create complex multiple cursors movement paths by 
adding several cursors.  It is obvious, that for each subsequent cursor the movement start time 
must be later than the movement end time of previous cursor.    

For all cursors with the “Display click” setting turned on, the duration of the click is 0.7 
second.  This time period needs to be considered when defining display time for the Frame, and 
when specifying setting “Appear After” for the next cursor in the frame. 

  



5.5 Scenarios 
Scenario presents itself as a template for building interactions between multiple 
objects.   Scenarios enable author of the course to define necessary parameters and get a filling 
for the slide right away.  

Even though the same task can be accomplished by placing text, pictures, and by specifying 
interactions between them, the usage of scenarios significantly speeds up the process.   

Sample of Scenario - Product Catalog . 

5.5.1 Product Catalog 

To insert Scenario on the Frame open Scenario Library on the task pane, select Scenario and 
doouble click on its icon. 

To change parameters of the scenario, open “Frame structure” section on the task pane. Select 
“Edit scenario…” item from the context menu on the scenario identifier. Dialog window opens 
up, where you can specify parameters for scenario.   

For each product the following is defined: 

 Name of the product.  

 File containing the picture of the product.  

 Formatted text describing the product.  

Upon completion of all parameters, there will be list of the product’s names displayed on the 
Slide. Once, one of the product’s name from the list is selected, the card for corresponding 
product opens up. 
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6. Handling Objects 

6.1 Object position within a Frame 

6.1.1 Object Selection 

In order to execute command against the object, this object has to be selected. 

Selected objects are outlined by markers, which are also used for object's resizing. 

The processing information regarding selected object is displayed in the status field within 
CourseLab. 

In case multiple objects are selected, status field contains only information pertaining to the 
last selected object. 

Selecting objects in the workspace 

 To select object, click on it using left mouse button.  

 In order to select multiple objects, left click on the desired object while holding down Shift 
or Ctrl key.  

 To undo selection selectively, left click on the object while holding down Shift or Ctrl key.  

 Click anywhere within a Slide to undo selection of all objects.  

 Use Ctrl+A combination to select all object in the Slide.  

Regardless the fact that objects placed on the Master-Slide are visible on the standard Slides as 
well, to select such objects they need to be opened within Master-Slide. 

Sequential objects Selection within workspace 

When object is selected, you can also select the subsequent object by pressing Tab key. 

 In order to select previous object from the sequence, use Tab key while holding down Shift 
key.  

Object's selection in the task panel 

1. Use View -> Tasks Pane -> Frame Structure to open Frame Structure section within Tasks 
Panel.  

2. To select the object in the Frame Structure, left click on the object's identifier. To select all 
the objects within the group in the Frame Structure, left click on the group's identifier.  

6.1.2 Border and fill colors. Opacity 



When you insert any Object into a Frame, it is placed into the rectangular placeholder. Use 
“Color” tab on the “Format” screen to specify placeholder’s background color. Note that these 
parameters pertain only to the Object’s placeholder, rather than the Object itself. If the Objects 
fit the entire rectangular placeholder (for example pictures), it is appropriate to specify the 
placeholder’s background color only when the pictures contain transparent areas. 

Exceptions: AutoShapes Objects, where changes to placeholder’s background and border 
color apply to the AutoShapes directly. 

 

On the same “Color” tab, move the “Transparency” Slider to modify the opacity of the Object’s 
placeholder as well as the opacity of the Object itself.  

6.1.3 Resizing Objects 

Resizing objects using mouse 

1. Select object.  

2. Position the cursor over one of the object's handles.  

3. Press left mouse button.  

4. Hold the mouse button down, and then drag the cursor to the desired location in the Slide. 
Dotted frame, which is moving along with cursor, indicates new size of the object's 
placeholder.  

5. Release the mouse button.  

To interrupt resizing of the object, press Esc key. 

Resizing objects using keyboard 



1. Select desired object.  

2. Hold down Shift key. Press the arrow keys to move right and bottom part of the object's 
border.  

The above mentioned methods can be also employed for resizing multiple objects. 

Precise resizing of the object 

1. Select desired object.  

2. Open "Format" dialog window by specifying "Format Object" command, which is available 
either by selecting Format menu item from the context menu, or by pressing button in the 
toolbar.  

3. Select the Size page on the dialog window.  

4. Specify new values for the Width and the Height of the object.  

 

You can also use Format window for resizing several selected objects. When Format dialog 
window is opened, the Width and the Height fields will be populated with the sizing values, 
only if these values are identical for all the selected objects. If you leave the field empty, 
corresponding size will remain unchanged for each object. 

"Format Object" command is also available from the object's context menu in the "Frame 
Structure" section of the Tasks Panel. 

When you insert the Object of any shape into the Frame it is placed into the Rectangular 
Placeholder. There are 3 types of Objects allocation within the Rectangular Placeholder:  



 Object that can automatically adjust it’s size to the size of Rectangular Placeholder (For 
example, pictures, and AutoShapes are always resizing it’s height and width to fit the 
Rectangular Placeholder),  

 Object that can resize by itself (autofit to contents depending, for example, on the amount 
of the text)  

 fixed-size Object  

6.1.4 Moving Objects 

Moving objects using mouse 

1. Move mouse cursor over the object.  

2. Press left mouse button.  

3. Hold the mouse button down, and then drag the cursor to the desired location in the Slide. 
Dotted frame, which is moving along with cursor, indicates new location of the object's 
placeholder.  

4. Release the mouse button.  

To interrupt relocation of the object, press Esc key. 

Moving objects using keyboard 

1. Select desired object.  

2. Now, you can control the object motion with the keyboard strokes by pressing direction 
keys.  

Moving objects using buttons in the toolbar panel 

 

Move Up. Selected object will be moved one position up. Command is available by 
pressing button from the toolbar panel. 

 

Move Down. Selected object will be moved one position down. Command is available by 
pressing button from the toolbar panel. 

 

Move Left. Selected object will be moved one position to the left. Command is available by 
pressing button from the toolbar panel. 

 

Move Right. Selected object will be moved one position to the right. Command is available 
by pressing button from the toolbar panel. 

The above mentioned methods can be also employed for moving multiple objects. Allocation of 
selected objects in relationship to each other will remain unchanged. 

Precise positioning of the object  

1. Select desired object.  



2. Open Format dialog window by specifying Format Object command, which is available 
either by selecting Format menu item from the context menu, or by pressing button in the 
toolbar.  

3. Transfer to the Position page on the dialog window.  

4. Specify new object's Horizontal and Vertical coordinates.  

 

You can also use Format window for resizing multiple selected objects simultaneously. When 
Format dialog window is opened, the Width and the Height fields will be populated with the 
sizing values, only if these values are identical for all selected objects. If you leave the field 
empty, corresponding size will remain unchanged for each object.  

Format Object command is also available from the object's context menu in the Frame 
Structure section of the Tasks Panel. 

You can cause the Object to be dragged by the mouse when the checkbox “Can be dragged by 
mouse” is on the same tab – in this case, learner can drag the specified Object within a frame.  

6.1.5 Aligning Objects 

The objects on the Slide can be aligned relative to each other. 

For two or more selected objects: 

Horizontal Alignment 

 

Align Left. Align the selected objects horizontally, relative to the border of the left most 
object from the selection. Command is available by pressing button on the toolbar. 

 

Align Center. Selected objects are centered horizontally relative to the centerline of the 



widest object from the selection. Command is available by pressing button on the toolbar. 

 

Align Right. Align the selected objects horizontally, relative to the border of the right most 
object from the selection. Command is available by pressing button on the toolbar. 

Vertical Alignment 

 

Align Top. Align the selected objects vertically, relative to the border of the top most 
object from the selection. Command is available by pressing button on the toolbar. 

 

Align Middle. Selected objects are centered vertically relative to the centerline of the 
highest object from the selection. Command is available by pressing button on the toolbar. 

 

Align Bottom. Selected objects are vertically aligned relative to the border of the lowest 
object from the selection. Command is available by pressing button on the toolbar. 

Commands available for three or more selected objects: 

Horizontal distribution of the objects 

 

Distribute Horizontally. Selected objects are horizontally equally distributed between the 
outermost objects from the selection. Command is available by pressing button on the 
toolbar. 

Distribute Vertically 

 

Distribute Vertically. Selected objects are vertically equally distributed between the 
outermost objects from the selection. Command is available by pressing button on the 
toolbar. 

6.1.6 Rotating Objects 

Rotating objects using mouse 

1. Place cursor over rotation marker.  

2. Press left mouse button.  

3. Hold the mouse button down, and then drag the cursor to the desired location in the Slide. 
Dotted frame, which is moving along with cursor, indicates new location of the object's 
placeholder.  

4. Release the mouse button.  

To interrupt rotation of the object, press Esc key. 

It is also possible to rotate several objects at once. Allocation of selected objects in relationship 
to each other will remain unchanged. 

To specify precise value for the angle of object's rotation 

1. Select desired object.  



2. Open Format dialog window by specifying Format Object command, which is available 
either by selecting Format menu item from the context menu, or by pressing button in the 
toolbar.  

3. Transfer to the Size page on the dialog window.  

4. Specify desired object's angle of rotation by supplying new value for the Rotation field.  

 

You can also use Format window to specify angle of rotation for several selected objects. When 
Format dialog window is opened, the Rotation field will be populated with the value, only if this 
value is identical for all selected objects. If you leave the field empty, angle of rotation will 
remain unchanged for each object. By doing so, you can specify value for the angle of rotation 
for several objects.  

IMPORTANT! The Browser’s capabilities are used for Object rotating when displaying the 
learning Module. Due to some Browser limitations, the quality of the rotated Object can 
be affected.  

LIMITATION: An Objects rotation is supported only by Internet Explorer Browsers, 
rotation is not supported by other Browsers.  

6.1.7 Changing Objects Z-Order 

Objects within a Slide appear sequentially.  It is very illustrative in case objects are positioned 
using cascading (see picture below). The newly created objects displayed first, therefore they 
are covered by objects, which have been created later. 



 

To modify the sequence of the objects (Z-Order), use the following commands: 

 

Bring to Front command is available from the context menu Order -> Bring to Front or by 
pressing corresponding button in the toolbar. 

 

Send to Back command is available from the context menu Order -> Send to Back or by 
pressing corresponding button in the toolbar. 

 

Bring Forward command is available from the context menu Order ->  Bring Forward or by 
pressing corresponding button in the toolbar. 

 

Send Backward command is available from the context menu Order ->  Send Backward or by 
pressing corresponding button in the toolbar. 

6.2 Controlling Display Time 

6.2.1 Effects 

By default objects are entirely displayed on the frame. However, to make the learning process 
even more interactive, specify transitions at display.   

LIMITATION: The full set of effects/transitions displays correctly only in Internet 
Explorer browser, in all other browsers the set of transitions is limited.  In case 
selected transition is not supported by particular browser CourseLab player will 
automatically replace such transition with the one supported by current browser.  

Use “Display” tab on the “Format” screen to specify object entry transition. The CourseLab (and 
consequently the CourseLab player) contains 24 options of built-in entry transitions. For each 
transition out of all (entry or exit) specify duration in seconds.    



 

Remarks 

 Unlike the time of entry transition execution, which  is included into the time of object 
execution, the time of exit transition is not included into the time of object execution, thus 
such transition will be carried out in “overtime”.  

 Transitions as well as other common settings are applicable to the object’s placeholder. 
Therefore, if placeholder’s size is much bigger than size of actual object, then transition 
execution against an empty placeholder space might take some extra time.  

 Transitions can be used not only at the time of object appearance, but also, at object 
display (or closing) initiated by some action.  

6.2.2 Objects Display Time 

For the objects on the Slide it is possible to define the start time for displaying the object and 
also, the duration of the objects display.  Moreover, it is possible to specify that object should 
be displayed only when initiated by certain event.  

To modify object display start time and duration of the object display select Format… item from 
the object context menu. “Format” dialog screen opens up. 



 

 Object display mode You can choose one out of four options:  

 None – object will not be displayed at all. This mode is used when object needs to be 
displayed only upon certain action from the user.  

 Rest of Frame – object will be shown from the moment display was turned on, up 
until transition to the next Frame within the same Slide (or to another Slide, in case 
current Frame is the last one or the only one on the Slide).  

 Rest of the Slide - object will be shown from the moment display was turned on, up 
until transition to the next Slide  

 Specified time – object will be shown from the moment display was turned on until 
specified time.  

 Appear after.Defines delay of the object display start time relative to the Frame display 
start time.     

6.2.3 Timeline Pane 

Besides explicitly specifying object’s display time, there is also an option/possibility to use visual 
controls on the “Timeline”  pane. 

Select View -> Timeline to open “Timeline” panel.  On the top portion of the module’s window 
“Timeline” panel opens up. 



 

On the panel there is a timetable containing all objects of the current Frame.  

 

The thin grey colored vertical line represents time limit for the Frame display end time.  In case 
Slide consists of several Frames, at this particular time transition to the next Frame occurs. 
Frame display time can be modified by dragging grey colored vertical line to the left or to the 
right along the time scale.   

Stripe lines with object’s identifiers in the “Frame timing” panel represent the time duration of 
the object display. Left boundary of the stripe line represents object display start time. Right 
boundary of the stripe line represents the time when object will disappear. You can change 
object display start time and duration of the object display by dragging (using mouse) the 
borders of the stripe lines or the stripe line itself. 

Stripe lines with mouse cursors on it represent the time duration of the cursors 
movement.    The empty spots on the stripe lines represent time during which the cursor 
remains still.  

IMPORTANT! In case “Display Click” setting is specified in the cursor’s properties, 
you should define the pause before the next cursor move or before Frame display 
end time is not less than 0.7 seconds.    

6.3 Object Properties 
Object Properties are parameters of object, which can be used in actions and text substitution.  



6.3.1 Common Object Properties 

Common Object Properties are properties, that belongs to every CourseLab object, and can be 
used in actions and in text substitutions (OBJ_ID below means current object ID): 

Property  Returns Syntax 

x  Returns current X coordinate of top-left corner of object's position on 
the Frame.  

$OBJ_ID.x 

y Returns current Y coordinate of top-left corner of object's position on 
the Frame.  

$OBJ_ID.y 

w Returns current width of the object in pixels.  $OBJ_ID.w 

h Returns current height of the object in pixels.  $OBJ_ID.h 

startx  Returns initial X coordinate of top-left corner of object's position on the 
Frame, that was defined in Edit mode. 

$OBJ_ID.startx 

starty Returns initial Y coordinate of top-left corner of object's position on the 
Frame, that was defined in Edit mode. 

$OBJ_ID.starty 

startw Returns initial width of object. $OBJ_ID.startw 

starth Returns initial width of the object in pixels.  $OBJ_ID.starth 

  

Note, that initial and current values are exactly the same until any position- or size-changing 
action is applied to the object. 

6.3.2 Specific Object Properties 

Specific Object Properties are parameters of object, which can be used for actions and text 
substitutions. Depending on the type of the object there could be different set of specific 
properties (or none). Read corresponding object's topic to find which properties are available. 

6.4 Binding sounds to Objects 
In the learning Module created by CourseLab you can bind audio files to any Object. Use the 
“Sound” tab on the “Format” dialog screen, select the audio file to be bound with the Object 
(the file will be automatically copied into the “Images” folder of the current learning Module). 



 

By default, the sound will start playing right after the Object appears on the frame. This feature 
can be turned off by checking the “Disallow autoplay” check box. In this case the audio file will 
be bound to the Object, however for playing the sound, the special Action “SOUND” should be 
used. The following audio formats can be used: Adobe Flash (*.swf), or any format supported 
by the Windows Media Player (*.wav, *.wma, *.mp3 and so on). 

IMPORTANT! When using audio files, make sure to turn ON the feature under (“Module 
menu – Runtime Settings”), which checks whether or not the system has the required 
component for playing specific audio formats. 

7. Animation 
At first, the Slide contains only the single Frame.  It is possible to achieve animation effect by 
creating the sequence of the Frames with predefined duration of playback assigned to each 
Frame.  

7.1 Using Frames 
Use “Frames” panel for managing the Frames on the Slide. To open “Frames” panel, select View 
-> Frames.  



 

In the bottom part of the Module window the “Frames” panel opens up. 

 

Add as many frames as necessary using menu Insert -> Frame. Make appropriate changes to 
each of them to reflect animation sequence. 

7.2 Frame Display Time 
Each individual Frame has its own display time. 

To modify display time in the “Frames” panel select Advance… item from the frame’s context 
menu.  

 

Specify display time in seconds. 

IMPORTANT! Specified Frame’s display time has a higher priority over the display 
time of the objects within the same Frame – in case this time is less  than the 
display time of some objects, then such objects will not be displayed at all.  

Specify method of transition to the next Frame – Advance setting. By default, transition to the 
next Frame takes place upon expiration of the frame’s display time (setting "Immediate") 
Alternative setting is "Wait for Action" – it means stopping upon finishing frame’s display. In 
this case, creation of action, which will trigger transition to the next Frame, will be of your 
responsibility. 



8. Events and Actions 
All interactions between Objects in CourseLab learning modules are based on the “Event – 
Action” mechanism. 

An Event is a signal originated either by the Object or during the course by the user. Generally, 
Events are generated when the state of an Object changes (for example, at the moment of 
Object appearance) otherwise Events are generated externally (for example, by mouse click on 
the Object). Events are used for triggering Actions when creating relationships inside a Module. 

Actions are predefined changes of an Object state and/or Module variables which are used for 
creating complex Object behavior. 

The Events are used to trigger execution of Actions. 

The Event source could be :  

1. a Frame or a Slide,  

2. one of the Objects on the Frame. 

In the first case, All Events are generated by the CourseLab player; in the second case, the 
common Events for all Objects are generated by the CourseLab player and all Object-specific 
Events are generated directly in the Object’s code. 

For illustration purposes, and to better understand the “Event – Action” mechanism, let us 
review the following example: Picture a street with a pedestrian crosswalk equipped with two 
traffic lights - one for pedestrians, and another one for vehicles. At the red signal of the vehicle 
traffic light the traffic stops, and starts again when red signal switches its color to green. 
Respectively, the pedestrians start crossing the crosswalk on the green signal and stop at red. In 
the example described above in the Event of “red signal of the traffic light for vehicles”, the 
“Car” type of Objects performed the Action “Stop”. In the Event of “green signal of the traffic 
light for vehicles” , the “Car” type of Objects performed the Action “Start”. “Pedestrians” type 
of Objects performs similar Actions but using Events of its own traffic light. The source for the 
Events in both cases is the two traffic lights. 

8.1 Events 
An Event is a signal originated either by the Object or during the course by the user. Generally, 
Events are generated when the state of an Object changes (for example, at the moment of 
Object appearance) otherwise Events are generated externally (for example, by mouse click on 
the Object).  

Events are classified by Event Source: Slide, Frame, Object or Keyboard.  

8.1.1 Slide and Frame Events 
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Each Slide and Frame of the Learning Module is generating the following two events: 

The “beforedisplay” Event arises at the moment when all Objects of the current Frame are fully 
loaded, right before displaying the first Object from the list (remember, that even if all Objects 
are to be displayed simultaneously, in practice the first Object to be displayed is the one which 
is located underneath all other Objects). Even though both the Slide’s “beforedisplay” Events 
and the Slide’s first Frame “beforedisplay” Events occur virtually simultaneously, the order of 
triggering is as follows: The Slide’s “beforedisplay” Event will occur first, and next, the Frame’s 
“beforedisplay” Event will follow. 

This Event is useful for some actions that should be performed prior to any Slide/Frame object 
creation: for example, setting variable value, which will be accessed when Objects are created. 

The “afterdisplay” Event occurs at the moment the last Object from the list on the current 
Frame is displayed. Please note, that the “afterdisplay” Event indicates that all Objects intended 
for automatic display have been displayed and this Event has no relationship with the transition 
to the next Frame or Slide. Even though “afterdisplay” Events for the last Frame and Slide occur 
virtually simultaneously, the order of triggering is as follows: The Frame’s “afterdisplay” Event 
will occur first, and next, the Slide’s “DISPLAY END” Event will follow. 

This Event is useful for actions, which invokes already created Objects, since you can be sure 
that Objects are already exist. 

8.1.2 Events common to all Objects 



 

Any Object located on the Frame can be the source for the following events: 

 the “beforedisplay” Event is generated right before start of creation of the selected 
Object; 

 the “afterdisplay” Event is generated at the moment of finishing Object creation (at the 
end of an effect execution, if the transition effect has been used at display); 

 the “onclick” Event is generated by the user by left mouse click directly within an Object;  

 the “ondblclick” Event is generated by a mouse double-click directly within an Object. The 
pause between the clicks, which indicates whether this is double-click rather than two 
single clicks, corresponds to the mouse properties defined under the operating system 
settings on the user’s computer; 

 the “onlmousedown” Event is generated when the left mouse button is pressed down 
within an Object; 

 the “onlmouseup” Event is generated when the pressed left mouse button is released 
within an Object; 

 the “onrmousedown” Event is generated when the right mouse button is pressed down 
within an Object; 

 the “onrmouseup” Event is generated when the pressed right mouse button is released 
within an Object; 

 the “onmouseover” Event is generated when the mouse cursor reaches the outside border 
of the Object, i.e. at the Object’s “Entry” point; 

 the “onmouseout” Event is generated when the mouse cursor reaches the inside border of 
the Object, i.e. at the Object’s “Exit” point; 



 the “ondrop” Event is generated when the dragged Object is dropped. It is important to 
understand, that if one Object is dragged and dropped over another Object, the second - 
i.e. target - Object would be the source of the generated event. 

8.1.3 Custom Object Events 

Besides general events, which are common to all Objects, there is a set of Objects (usually these 
are complex Objects, for example, questions), which can generate custom Events (specific to 
each Object).  

 

For example, “Question” types of Objects can generate Events such as "on Success", "on 
Failure", "on Attempts Limit", and other Events specific to the test questions. However, when it 
comes to managing these Events they are treated the same as any other Event. Custom Objects 
Events are described in the corresponding sections under the “Object”. 

These Events are described in Help documents of corresponding Objects. 

8.1.4 Using Keyboard events 

You can use keyboard events (i.e. pressing the keys) to launch action sequences. For every slide 
you can define onkeydown events (as many, as you wish - depending on key combinations 
number needed). 



Note, that keyboard events can be defined on the Slide and Frame only (i.e. 
specific objects cannot have it's own onkeydown events). 

To define such event open action editor using Slide context menu and right click on free white 
space in Events pane.  

 

New Keyboard event window appears. Press the key (or key combination) - it will be recorded 
in the Key field. 

 

Create as many onkeydown events as you need. 



 

  



8.2 Actions 
Actions are predefined changes of the object state and/or module variables, which are used for 
composing complex object behavior. 

To create actions you can either employ built-in actions (which are listed in the Action Panel), 
or use JavaScript if you are familiar with this language. 

Built-in actions 

 EXTERNAL URL - enables opening resource external to the Learning Module in the new 
Browser Window  

 RETURN - performs transition to the Slide where action CALL was previously executed  

 ROTATE - START - initiates object rotating  

 ROTATE - STOP - discontinues object rotating  

 CALL - enables transition to the specified Slide  

 MOVE - START - initiates moving of the object within a frame  

 MOVE - STOP - interrupts movement of the selected object or all currently moving objects  

 IF - conditional action, executes set of subordinate actions if condition expression is 
evaluated to true  

 IF COMPLETION STATUS - Branches actions depending on completion status.  

 IF SCORE - Branches actions depending on score.  

 IF SUCCESS STATUS - conditional action, executes set of subordinate actions depending on 
the Success Status of the specified objective  

 IF COMPLETION STATUS - conditional action, executes set of subordinate actions 
depending on the Completion Status of the specified objective  

 SOUND - either initiates or stops playback of the audio file  

 ELSE - alternative branch for conditional actions: CHECKHIT, IF, IF COMPLETION STATUS, IF 
SCORE, IF SUCCESS STATUS  

 METHOD - enables launching execution of object's methods  

 NAVIGATION - enables turning ON/OFF capability for transition to another Slides of the 
Module  

 PARALLEL - enables launching of dependant actions in parallel threads  

 SET SCORE. Changes score for specified objective.  

 DELAY - inserted into the sequence of actions will interrupt sequence  

 VARIABLE - defines variable and it’s value for CourseLab Player  

 GOTO - enables transition to another Slide or Frame  

 PRINT - calls standard browser's Print dialog window  
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 DISPLAY - enables turning ON/OFF object display  

 SEQUENTIALLY - enables launching of dependant actions in strict sequential order  

 MSGBOX - enables display of the message warning window  

 CHECKHIT - conditional action, is used for verifying the particular object that was dropped 
onto the selected ones  

 SIZE - START - initiates resizing of the object within a frame  

 SIZE - STOP - interrupts resizing of the selected object or all currently resized objects  

 TIMER -  is used for delayed launching of dependant actions  

 SET SUCCESS STATUS - changes Success Status for the specified objective  

 FOR - is used for executing dependant actions specified number of times  

 JAVASCRIPT enables execution of custom JavaScript code  

 Z-INDEX - defines absolute or relative z-index of the object  

 Using Expressions in Actions  

 Using Keyboard events  

8.2.1 EXTERNAL URL 

EXTERNAL URL action enables opening resource external to the Learning Module in the new 
Browser Window. 

EXTERNAL_URL ( edit URL )  

Parameters 

URL  
String or expression (must have string value). URL for opening in the new Window.  

URL should be specified with respect to the Internet addressing rules, specifying the protocol, 
for example: http://www.courselab.com/ .  

8.2.2 RETURN 

RETURN action performs transition to the Slide where action CALL was previously executed.. 

RETURN  

Parameters 

No parameters. 

8.2.3 ROTATE - START 

ROTATE - START action initiates object rotating. 
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LIMITATION: Objects rotation is supported only by Microsoft Internet Explorer.   

LIMITATION: The object, which can be dragged by mouse (i.e. corresponding 
checkbox in Object properties is checked), can not be turned or moved. For this 
type of objects “MOVE - START” action will be ignored.  

ROTATE - START ( objectid Object edit Angle select Additive time Duration )  

Parameters 

Object  
String. The identifier of the object which will be rotated.  

Angle  
Number or expression (must have numeric value).  Indicates the angle in degrees and 
direction of rotation. Positive value refers to rotating clockwise; negative value refers to 
rotating counter-clockwise.  

Additive  
Token. Possible values : 

Value Description 

Replace Defines absolute angle, i.e. rotating angle will be counted from 
initial object's state. 

Add Defines relative angle, i.e. rotating angle will be counted from 
current object's state. 

Duration  
Number. Defines time of rotation in seconds.  Zero value corresponds to the instant 
rotation of the object.  

Remarks 

You can rotate the object more than one full turn, specifying Angle parameter of more than 360 
degrees.  

8.2.4 ROTATE - STOP 

ROTATE - STOP action cancels object rotating.  

ROTATE - STOP ( objectid Object select All_Objects )  

Parameters 

Object  
String. The identifier of the object, which rotation needs to be cancelled. In case 
rotation of all objects need to be cancelled this parameter is ignored (and it may be left 
blank).  

All_Objects  
Token. Possible values:  
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Value Description 

Yes Rotation of all currently rotating objects will be 
cancelled; input value for Object parameter will be 
ignored. 

No Rotation of the Object specified in the Object 
parameter will be cancelled. 

8.2.5 CALL 

CALL action enables transition to the specified Frame of the Slide.  The first parameter for this 
action is the target Frame identifier where transition will be performed to. The second 
parameter allows predefined shortcuts to common values. 

Action CALL is similar to GOTO action, the only difference is that during execution of this action, 
identifier of the current Slide remains in memory as a parameter for the RETURN action.  

CALL ( frameid Frame select Option )  

Parameters 

Frame  
String. Target Frame identifier where transition will be performed to. Value of this 
control will be ignored in case Option parameter is set to any value except for "Specified 
Frame".  

Option  
Token. Defines target of transition. Possible values: 

Value Description 

Specified Frame Transition will be performed to the Frame that is 
selected in Frame control 

Next Frame Transition will be performed to the Frame which is 
next to current Frame (if exists). Value of Frame 
control is ignored. 

Previous Frame Transition will be performed to the Frame which is 
previous to current Frame (if exists). Value of Frame 
control is ignored. 

Next Slide Transition will be performed to the first Frame of 
the Slide which is next to current Slide (if exists). 
Value of Frame control is ignored. 

Previous Slide Transition will be performed to the first Frame of 
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the Slide which is previous to current Slide (if 
exists). Value of Frame control is ignored. 

Remarks 

RETURN action performs transition to the Slide where action CALL was previously executed.  

8.2.6 MOVE - START 

MOVE - START action initiates moving of the object within a frame. 

LIMITATION: The object, which can be dragged by mouse (i.e. corresponding 
checkbox in Object properties is checked), can not be turned or moved. For this 
type of objects “MOVE - START” action will be ignored.  

MOVE - START ( objectid Object edit X edit Y select Additive time Duration )  

Parameters 

Object  
String. Identifier of the object, which will be moved.  

X  
Number or expression (must have numeric value). Defines horizontal coordinate in 
pixels of the point where the object will finish its move, depending on the Additive 
parameter this value can be either absolute (i.e. counted off frame’s top left corner), or 
relative to the current value.  

Y  
Number or expression (must have numeric value). Defines vertical coordinate in pixels 
of the point where the object will finish its move, depending on the Additive parameter 
this value can be either absolute (i.e. counted off frame’s top left corner), or relative to 
the current value.  

Additive  
Token. Possible values : 

Value Description 

Replace Specified X and Y coordinates define the absolute 
coordinates of the point where the object will be 
moved. 

Add Specified X and Y coordinates will be added to the 
current ones (i.e. the object will be moved with 
regards to added coordinates relative to the 
object’s current position). 

Duration  
Number. Defines time in seconds of object relocation. Zero value corresponds to instant 
object relocation.  
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8.2.7 MOVE - STOP 

MOVE - STOP action interrupts movement of the selected object or all currently moving 
objects. 

MOVE - STOP ( objectid Object select All_Objects )  

Parameters 

Object  
String. The identifier of the object, which movement needs to be cancelled. In case 
movement of all objects need to be cancelled this parameter is ignored (and it may be 
left blank).  

All_Objects  
Token. Possible values:  

Value Description 

Yes Movements of all currently moving objects will be 
cancelled; input value for Object parameter will be 
ignored. 

No Movement of the Object specified in the Object 
parameter will be cancelled. 

8.2.8 IF 

IF - conditional action. Conditional action does not perform any noticeable changes to the 
Frame, it is rather intended for managing the execution of other actions. Enables launching of 
different dependant actions (or sequences of actions) with regards to the condition being 
evaluated. 

You can use ELSEaction to form alternative action sequence (i.e. when condition is not met). 

IF ( edit Condition )  

Parameters 

Condition  
Boolean expression. Condition can contain CourseLab variable value (as #var_name, 
where var_name is variable name - please refer to VARIABLE section for additional 
information) or object's property value (as $OBJ_ID.property, where OBJ_ID is actual 
object ID and property is existing object's property name - please refer to Object 
Properties section for additional information) or expressions.  

Remarks 

Action sequence, which is to be managed by IF action, must be indented at one position from 
IF. 
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See also Using Expressions in Actions for more details. 

8.2.9 IF COMPLETION STATUS 

IF COMPLETION STATUS action executes set of dependant actions depending on the 
Completion Status of the specified objective. You can use ELSE action to form alternative action 
sequence (i.e. when condition is not met). 

IF_COMPLETION_STATUS ( objectiveid Objective select Status )  

Parameters 

Objective  
String. Identifier of the objective, Completion Status of which must be verified.  

Status  
Token. Can have one of the following values: 

Value Description 

Unknown Completion Status is unknown  

Not Attempted Completion Status of selected objective has value "Not Attempted"  

Incomplete Completion Status of selected objective has value "Incomplete"  

Completed Completion Status of selected objective has value "Completed"  

Remarks 

Set of actions dependant to IF COMPLETION STATUS action must be indented on one position 
to IF COMPLETION STATUS action. 

8.2.10 IF SCORE 

IF SCORE action executes set of dependant actions depending on the Score (or subset of Score) 
of the specified objective. You can use ELSE action to form alternative action sequence (i.e. 
when condition is not met). 

IF SCORE ( objectiveid Objective edit Source select Condition edit Score )  

Parameters 

Objective  
String. The identifier of the objective, the score of which will be verified.  

Source  
String or expression (must have string value). Specifies the source of the current  score 
verification, i.e. objective's score subset identifier. If this parameter is omitted, then 
objective's total score will be verified. If this score subset does not exist in this objective, 
then its score will be treated as 0. Source parameter can be some task identifier (not 
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necessarily object ID - you can assign it as you wish, but with respect to usual limitation 
on special symbols). It is used to differ scores from different task in objective's score 
"heap". In other words, this parameter defines subset of this objective's score. Note, 
that objects that can add score to objectives automatically (i.e. Question and Test 
objects) always use their Object ID as Source, therefore you can easily verify score from 
any of such objects using its Object ID as Source parameter (and do not forget to define 
Objective parameter).  

Condition  
Token. Defines the rule of verification: 

Value Description 

< Verified score is less than Score parameter 

> Verified score is greater than Score parameter 

= Verified score is exactly equal to Score parameter 

<= Verified score is less than or equal to Score 
parameter 

>= Verified score is greater than or equal to Score 
parameter 

<> Verified score is not equal to Score parameter 

Score  
Number or expression (must have numeric value).  

Remarks 

Action sequence, which is to be managed by IF SCORE action, must be indented at one position 
from IF SCORE. 

8.2.11 IF SUCCESS STATUS 

IF SUCCESS STATUS action executes set of dependant actions depending on the Success Status 
of the specified objective. You can use ELSE action to form alternative action sequence (i.e. 
when condition is not met). 

IF_SUCCESS_STATUS ( objectiveid Objective select Status )  

Parameters 

Objective  
String. Identifier of the objective, Success Status of which must be verified.  

Status  
Token. Can have one of the following values: 
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Value Description 

Unknown Success Status is unknown  

Failed Success Status of selected objective has value "Failed"  

Succeeded Success Status of selected objective has value "Passed"  

Remarks 

Set of actions dependant to IF SUCCESS STATUS action must be located down below to the 
right relatively to IF SUCCESS STATUS action. 

8.2.12 SET COMPLETION STATUS 

SET COMPLETION STATUS action changes Completion Status for the specified objective. 

SET COMPLETION STATUS ( objectiveid Objective select Status )  

Parameters 

Objective  
String. The identifier of the objective, Completion State of which will be changed  

Status  
Token. Represents the value of the selected objective's Completion Status to be 
assigned: 

Value Description 

Unknown No information on objective's completion status.  

Not Attempted Completion of the objective is not started yet. 

Incomplete Completion of the objective is started, but it is not finished yet.  

Complete Completion of the objective is finished. 

8.2.13 SOUND 

SOUND action either initiates or stops playback of the audio file.  

SOUND ( objectid Object edit File select Action )  

Parameters 

Object  
String. The identifier of the object with associated audio file, which playback needs to be 
either started, or stopped.  



File  
String. Path to the audio file, which playback needs  to be either started or stopped. In 
case File parameter is not empty, input value for this field will have higher priority than 
value of the Object parameter, thus action will be performed against the file specified in 
the File parameter instead of the Object (the value of the Object parameter will be 
ignored and may be left blank).  

Action  
Token. Defines whether playback should be started or stopped: 

Value Description 

Start Selected audio source will start playing. 

Stop Selected audio source will stop playing. 

Remarks 

Audio file can be in Adobe Flash Player (*.swf) format or in any other format supported by 
Windows Media Player (*.mp3, *.wav, *.wma, and others).  

8.2.14 ELSE 

In case alternatives should be used when IF conditional expression (or other conditional action) 
is not satisfied (value is false), ELSE action can be added as a dependant action to the IF action 
to define alternative sequence of actions.  

ELSE  

Parameters 

No parameters. 

Remarks 

ELSE must be indented at one position from its parent conditional action. 

Action sequence, which is to be managed by ELSE action, must be indented at one position 
from ELSE. 

8.2.15 METHOD 

METHOD action enables launching execution of methods – actions built into the Object. 
However, it should be taken into consideration that not all types of objects have built-in 
Methods. 

METHOD ( objectid Object methodid Method )  

Parameters 
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Object  
String. Identifier of the object, which method should be launched.  

Method  
Selector. Method that should be launched.  

Remarks 

Please note that in case the selected method has associated input parameters additional entry 
fields will appear for inserting method’s parameters. Look at object's description to get more 
information on its specific method. 

8.2.16 NAVIGATION 

NAVIGATION enables turning ON/OFF capability for transition to another Slides of the Module. 

NAVIGATION ( select Navigation_Objects select Action )  

Parameters 

Navigation_Objects  
Token. Determines the set of navigation objects that may be used for transition to 
another Slide, which need to be enabled/disabled: 

Value Description 

All Navigation Objects All Navigation Objects will be turned enabled/disabled 

Prev and Next Buttons  Previous and Next Slide Buttons will be turned enabled/disabled 

Prev Button Previous Slide Buttons will be turned enabled/disabled 

Next Button Next Slide Buttons will be turned enabled/disabled 

Replay Button  Replay Slide Buttons will be turned enabled/disabled 

Navigation Menu Navigation Menu will be turned enabled/disabled 

Contents Access to Contents Tab (or Window) will be enabled/disabled  

Action  
Token. Possible values: 

Value Description 

Enable Selected objects will be enabled 

Disable Selected objects will be disabled 

8.2.17 PARALLEL 



PARALLEL action enables launching of dependant actions concurrently, i.e. each next action will 
be launched virtually simultaneously with previous one, using parallel thread.  

PARALLEL  

Parameters 

No parameters. 

Remarks 

Action sequence, which is to be managed by PARALLEL action, must be indented at one 
position from PARALLEL. 

See also SEQUENTIALLY action to launch action in sequence (this is default behavior). 

8.2.18 SET SCORE 

SET SCORE action changes score for specified objective. 

SET SCORE ( objectiveid Objective edit Source select Additive edit Score )  

Parameters 

Objective  
String. The identifier of the objective, the score of which will be changed.  

Source  
String or string expression. Specifies the source of the current  score modification, i.e. 
some task identifier (not necessarily object ID - you can assign it as you wish, but with 
respect to usual limitation on special symbols). It is used to differ scores from different 
task in objective's score "heap". In other words, this parameter defines subset of this 
objective's score.  

Additive  
Token. Defines the rule of changing: 

Value Description 

Replace Score will replace already existing in the given objective score from 
specified source 

Add Score will be added to already existing in the given objective score 
from specified source 

Score  
Number or expression (must have numeric value).  

8.2.19 DELAY 

DELAY action that is inserted into the sequence of actions will interrupt actions execution for 
specified time. 
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DELAY ( edit Duration select Infinite )  

Parameters 

Duration  
Number. Defines delay time in seconds for interrupting the sequence of actions. If 
parameter Infinite is set to “Yes”, then Duration parameter will be ignored.  

Infinite  
Token. Defines delay mode.  

Value Description 

Yes The sequence of actions will be interrupted 
indefinitely, until some action from the user is 
performed.  Duration parameter will be ignored. 

No The sequence of actions will be interrupted for the time specified. 

8.2.20 VARIABLE 

VARIABLE action defines runtime variable and it’s value, or, in case variable with specified 
name already exists, variable’s value will be changed.  

VARIABLE ( edit Name edit Value select Scope )  

Parameters 

Name  
String. Name of the variable.  

Value  
Boolean, number, string or expression. Value of variable  

Scope  
Token. Defines scope where this variable is variable. Possible values: 

Value Description 

Current Slide  Variable will exist only on current Slide. 

Entire Module  Variable will be accessible for all the Slides within a Module. 

Using variables in expressions 

To insert variable value into expression use “#” prefix symbol in front of the variable name (i.e. 
if variable name is var_name, then #var_name should be used for inserting variable value into 
the expression). See Using Expressions in Actions for more details. 

Remarks 
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To modify existing variable’s value, use the same VARIABLE action, in this case in the “Name” 
field specify name and scope of existing variable.  

8.2.21 GOTO 

GOTO action enables transition to the specified Frame of the Slide.  

This action is similar to CALL action, the only difference is that no visit history information is 
stored. 

GOTO ( frameid Frame select Option )  

Parameters 

Frame  
String. Target Frame identifier where transition will be performed to. Value of this 
control will be ignored in case Option parameter is set to any value except for "Specified 
Frame".  

Option  
Token. Defines target of transition. Possible values: 

Value Description 

Specified Frame Transition will be performed to the Frame that is 
selected in Frame control 

Next Frame Transition will be performed to the Frame which is 
next to current Frame (if exists). Value of Frame 
control is ignored. 

Previous Frame Transition will be performed to the Frame which is 
previous to current Frame (if exists). Value of Frame 
control is ignored. 

Next Slide Transition will be performed to the first Frame of 
the Slide which is next to current Slide (if exists). 
Value of Frame control is ignored. 

Previous Slide Transition will be performed to the first Frame of 
the Slide which is previous to current Slide (if 
exists). Value of Frame control is ignored. 

8.2.22 PRINT 

PRINT action calls standard browser's Print dialog window.  

PRINT  
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Parameters 

No parameters. 

8.2.23 DISPLAY 

DISPLAY action enables turning ON/OFF object display. This is the most frequently used action. 

DISPLAY ( objectid Object select Display select Effect time Duration )  

Parameters 

Object  
String. The identifier of the object, which must be either displayed, or hidden.  

Display  
Token. Hide or Show selected object  

Value Description 

Show Object will be displayed  

Hide Object will be hidden  

Effect  
Token. Enables using of transition on this action: 

Value Description 

Object Use transition defined in selected object's properties  

None Disable transition  

Any other value  Selects transition type for this action  

Duration  
Number. Duration of selected transition in seconds (will be ignored if None selected in 
parameter Effect). 

8.2.24 SEQUENTIALLY 

SEQUENTIALLY action enables launching of dependant actions in strict sequential order, i.e. 
each next action will be launched only upon completion of the previous one, unlike the usual 
routine, where actions are launched in predefined order, even the previous action is not even 
finished.  

SEQUENTIALLY 

Parameters 

No parameters. 



Remarks 

Action sequence, which is to be managed by SEQUENTIALLY action, must be indented at one 
position from SEQUENTIALLY. 

See also PARALLEL action if you need to launch actions concurrently. 

8.2.25 MSGBOX 

MSGBOX action enables display of the message warning window for the user with text 
specified. 

MSGBOX( edit Text )  

Parameters 

Text  
String (delimited with ") or expression of any available type. Message text.  

Remarks 

Parameter can contain CourseLab variable value (as #var_name, where var_name is variable 
name - please refer to VARIABLE section for additional information) or object's property value 
(as $OBJ_ID.property, where OBJ_ID is actual object ID and property is existing object's 
property name - please refer to Object Properties section for additional information) or 
expression.  

8.2.26 CHECKHIT 

CHECKHIT action is used for verifying the particular object that was dropped onto the selected 
ones. The only parameter for this action is the identifier of the object being dragged, which is to 
be verified with regards to compliance. 

Typically, this action is triggered by ondrop event generated by object-target. In case identifier 
of the object being dragged is identical to the specified one, sequence of dependant actions will 
be executed.   

CHECKHIT ( objectid Object )  

Parameters 

Object  
String. The identifier of the object being dragged, which is to be verified with regards to 
compliance.  

Remarks 

You can use ELSEaction to form alternative action sequence (i.e. when condition is not met). 
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Action sequence, which is to be managed by CHECKHIT action, must be indented at one 
position from CHECKHIT. 

8.2.27 SIZE - START 

SIZE - START action initiates resizing of the object within a frame. 

LIMITATION: Some objects (usually those, that automatically adjust their size 
depending on content,- for example, text boxes, balloons etc.) may resize 
correctly by X coordinate, but automatically adjust the size by Y coordinate 
(ignoring H parameter of this action).  

SIZE - START ( objectid Object edit W edit H select Additive time Duration )  

Parameters 

Object  
String. Identifier of the object, which will be resized.  

W  
Number or expression (must have numeric value). Defines width change of the object, 
depending on the Additive parameter this value can be either absolute (i.e. define new 
width of the object), or relative to the current width.  

H  
Number or expression (must have numeric value). Defines height change of the object, 
depending on the Additive parameter this value can be either absolute (i.e. define new 
height of the object), or relative to the current height.  

Additive  
Token. Possible values : 

Value Description 

Replace Specified W and H parameters define new width of 
the object (absolute values). 

Add Specified W and H parameters will be added to the 
current width and height of the object (i.e. the 
object will be resized with regards to added 
coordinates relative to the object’s current size). 

Duration  
Number. Defines time in seconds of object resize. Zero value corresponds to instant 
object relocation.  

8.2.28 SIZE - STOP 

SIZE - STOP action interrupts resizing of the selected object or all currently resized objects. 

SIZE - STOP ( objectid Object select All_Objects )  

Parameters 
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Object  
String. The identifier of the object, which resize needs to be cancelled. In case resize of 
all objects need to be cancelled, this parameter is ignored (and it may be left blank).  

All_Objects  
Token. Possible values:  

Value Description 

Yes Resize of all currently resized objects will be 
cancelled; input value for Object parameter will be 
ignored. 

No Resize of the Object specified in the Object 
parameter will be cancelled. 

8.2.29 TIMER 

TIMER action is used for delayed launching of dependant actions.  

TIMER ( edit Duration )  

Parameters 

Duration  
Number. Value of timer delay in seconds.  

Remarks 

Action sequence, which is to be managed by TIMER action, must be indented at one position 
from TIMER. 

8.2.30 SET SUCCESS STATUS 

SET SUCCESS STATUS action changes Success Status for the specified objective. 

SET SUCCESS STATUS ( objectiveid Objective select Status )  

Parameters 

Objective  
String. The identifier of the objective, Success Status of which will be changed .  

Status  
Token. Represents the value to be assigned to selected objective’s Success Status: 

Value Description 

Unknown No information on status.  

Failed Success Status of selected objective has value "Failed"  



Succeeded Success Status of selected objective has value "Passed"  

8.2.31 FOR 

FOR action is used for executing dependant actions specified number of times. 

FOR ( edit Name edit From edit To edit Step select Scope )  

Parameters 

Name  
String. Cycle counter variable name.  

From  
Number or expression (must have numeric value). Starting value for the cycle counter.  

To  
Number or expression (must have numeric value). Stopping value for the cycle counter.  

Step  
Number or expression (must have numeric value). Iteration step for the cycle counter.  

Scope  
Token. Defines scope of the cycle counter variable. Possible values: 

Value Description 

Current Slide  Variable will exist only on current Slide. 

Entire Module  Variable will be accessible for all the Slides within a Module. 

Remarks 

Action sequence, which is to be managed by FOR action, must be indented at one position from 
FOR. 

8.2.32 JAVASCRIPT 

JAVASCRIPT action enables execution of any custom JavaScript code. 

JAVASCRIPT ( textedit Text )  

Parameters 

Text  
Javascript code.  

8.2.33 Z - INDEX 

Z - INDEX action changes Z coordinate of the object (i.e. brings the layer, where the object is 
located, forward or backward). Z - INDEX is not measured in pixels, its value is always relative, 
i.e. layers with greater Z - INDEX will be located in front of layer with smaller Z - INDEX. 
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Z_-_INDEX ( objectid Object edit Z select Additive )  

Parameters 

Object  
String. Identifier of the object, Z - INDEX of which will be changed.  

Z  
Number or expression (must have numeric value). Specifies change of Z - INDEX of the 
selected object.  

Additive  
Token. Defines the rule of changing:  

Value Description 

Replace Z parameter value will replace current object's Z - 
INDEX 

Add Zparameter value will be added to current object's 
Z - INDEX 

8.2.34 Using Expressions in Actions 

Expressions can be used in action parameters to calculate parameter values. CourseLab 
variables and object properties can be used as expression arguments along with numbers and 
strings. When action is launched, every expression in action parameters is evaluated and 
replaced with expression value.  

Boolean expression is the type of expressions that has boolean true or false as a result of 
evaluation. This type of expression is generally used in IF action to define condition statement. 
Example of boolean expression is: 

#var1==#var2+10 

Note, that if you define incorrect expression, it may cause the error in module. Please double 
check expression syntax to avoid problems. 

Operators allowed for building expressions: 

Operator Description 

Arithmetic/String 

+ Addition of numbers or concatenation of strings  

- Subtraction or negation (numbers only)  

* Multiplication (numbers only)  
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/ Division (numbers only)  

Boolean 

! NOT - unary Boolean negation - if operand evaluates to true then the result 
evaluates to false and vice versa.  

&& AND - if both operands evaluate to true then the result evaluates to true, 
otherwise - false  

|| OR - if either or both operands evaluate to true then the result evaluates to 
true, otherwise - false  

Comparison 

!= Not equal (usually works fine, but may depend on automatic data type conversion *)  

== Equal (usually works fine, but may depend on automatic data type conversion *)  

> Greater than  

>= Greater than or equal  

< Less than  

<= Less than or equal  

  

* Data type conversion: numbers and symbols of numbers are different types of 
data, i.e. in general, for example, 34 should not be equal to "34" (first is number, 
second is string). But JavaScript programming language (which is used in 
CourseLab runtime) has automatic data type conversion feature, i.e. 34 may be 
equal to "34" in conditional statement. Please be aware of this feature. 

Data types allowed for building expressions: 

Data type Description 

NUMBER [0...9] - any sequence of these characters 

BOOLEAN true | false - predefined dictionary values 

STRING Any character sequence enclosed in quotes ("" or ''). Using of " and ' inside the string is forbidden - 
if you need these characters to be included in string - use backslash to mask them (i.e. \" will mean 
single " inside the string) 

VARIABLE CourseLab run-time variable value (i.e. # sign followed by variable name). Characters, that can be 
used in variable name include 0-9, a-z, A-Z, _ Note, that no whitespaces are allowed in variable 



names. 

IDENTIFIER Used for inserting object properties in expression. Syntax for object 
property is $object_identifier.object_ property, where object_identifier and object_property 
are of IDENTIFIER data type. Characters, that can be used in IDENTIFIER 
include 0-9, a-z, A-Z, _ Note, that no whitespaces are allowed. 

 Math functions allowed for building expressions: 

Function Description 

Math.random() returns random number greater than 0 and less than 1 

Math.PI returns PI value 

Math.sin( x) returns sine of x 

Math.cos( x) returns cosine of x 

Examples of expressions: 

Expression Description 

#var1<=#var2+10 Simple boolean expression for IF action  

((#var1>5) && (#var2>10)) || 
#var3=='cancel'  

Complex boolean expression for IF action  

#var1*#var2/100 Numeric expression for defining action parameter numeric value 
(arythmentic) 

#var1+" is correct" String expression for defining action parameter string value 
(concatenating strings) 

  

  



9. Scoring 
Scores and statuses in Learning Modules created with CourseLab are based on using objectives 
and rules. 

9.1 Objectives 
Objective is a special parameter for evaluating of Learning Module completion and success. 

There might be one or several objectives in the single Module. Technically, there is no 
limitation on number of learning objectives; however, such limitations can be introduced when 
using certain International standards of data transfer protocols (for example, in SCORM the 
number of objectives cannot exceed 100).    

Each objective has a Score, Success Status and Completion Status. 

Success Status can have one of the following values: 

 Unknown  

 Failed (objective is not accomplished)  

 Passed (objective is accomplished)  

Competion Status can have one of the following values: 

 Unknown  

 Not Attempted (completion of the objective is not started yet).  

 Incomplete (completion of the objective is started, but it is not finished yet)  

 Complete (completion of the objective is finished).  

One of the objectives for the Module must have defined setting "Module objective". Module 
translates results of completion of this objective to the Learning Management Systems as a 
result of completion for the entire Module. By default, it is named "total" and has predefined 
initial completion status "incomplete" (it means that entire module will have completion status 
"incomplete" immediately after initial launch).  

During Module execution the properties of the objectives change either by employing special 
actions, or by employing actions  built-in into the complex objects (for example, "Question" 
objects record score into the defined objective by itself). 

To add new objective: 

1. Select Module -> Runtime Settings… 



 

2. In the opened “Runtime Settings” dialog screen go to the “Objectives” tab. 

3. On the “Objectives” tab press “Add” button.  

 

4. Use “Objective” dialog screen to specify objective’s settings. Specify objective's identifier 
(please, use latin charachters and numbers only), objective's description (plain text, if needed), 
initial completion and success statuses and scores. There must be always only one objective 
marked as Module Objective - score and statuses of this objective will be sent to LMS as whole 
module score and statuses. Initial statuses are set by default to: Completion status to 
"Incomplete", Success status to "Unknown". It means that, once learner has enered the 
module, its completion status immediately becomes "Incomplete". This is most common 
behaviour. Minimal and maximal scores are set by default to 0 an 100 correspondingly. Minimal 
score is the initial score value (in most cases 0). Maximal score must be changed to sum of all 
scores that can be achieved bu learner - i.e. maximal possible score for this objective. This value 
is used by LMS (and result displaying objects) to calculate percent values.  



 

Actions to change objectives 

Actions with scores and statuses include:  

 SET SCORE. Changes score for specified objective.  

 SET COMPLETION STATUS. Changes objective's completion status.  

 SET SUCCESS STATUS - Changes objective's success status.  

 IF SUCCESS STATUS - Branches actions depending on success status.  

 IF COMPLETION STATUS - Branches actions depending on completion status.  

 IF SCORE - Branches actions depending on score.  

9.2 Rules 
The Rule presents the set of conditions. If conditions are satisfied the status of indicated 
objective will change. Using Rules allows transferring control on both Success and Completion 
Statuses to the CourseLab player, i.e. statuses will be changed automatically. 

To add Rule: 

1. Select Module -> Runtime Settings… 
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2. In the opened “Runtime Settings” dialog screen go to the “Rules” page. 

3. On the “Rules” tab press “Add” button. 

 

For each Rule specify the following:  



 

 Identifier of the objective, which state will be changed due to the Rule execution.  

 Success Status for specified objective, in case Rule must change it.  

 Completion Status for specified objective, in case Rule must change it.  

 The logical expression among the conditions. If conditions are satisfied, Rule will “work”. 
The different logical conditions are connected to each other by following logical operators: 
AND, OR, XOR, and NOT. To change logical operation, select desired operation from the list 
and press “Operation” button. The logical operators can be grouped by using round 
parentheses. Select conditions from the list and press “Group” button to add parentheses. 
Select conditions inside of parentheses and press “Ungroup” button to remove 
parentheses.  

Conditions 

Each condition defines one of the following checks: 

1. Slides Visited. Condition is satisfied if during Module execution all the Slides in sequence, 
including the ones with defined identifiers were viewed by the student.  



 

2. Objective Score. Condition is satisfied if value of the actual objective’s score for the defined 
condition is for example greater or equal to the specified value.  For comparison of specified 
score with actual score, the following operators are employed: <, >, =, <=, >=, and <>. 

 

3. Objective Success. Condition is satisfied if actual value of the Objective Success Status 
corresponds to the specified one.  



 

4. Objective Completion. Condition is satisfied if actual value of the Objective Completion 
Status corresponds to the specified one. 

 

Using of the last three above mentioned checks for creating Rules allow building cascading 
Rules – when status of the single objective depends on the statuses of other objectives.  

  



10. Screen Capture 
Learning courses are created for many purposes. One of the most common objectives is 
instructing on how to use various software. To facilitate the creation of software simulations 
CourseLab contains built-in screen capture mechanism, therefore no additional software needs 
to be installed. Simulations are recorded directly into the internal format of the editor and can 
be edited later as usual frames. Internet Browser’s capabilities allow replaying of such animated 
simulations. No additional components (Flash Player, Shockwave Player, Media Player, etc.) are 
required.  

LIMITATION: Screen Capture may not capture some menus on computers with 
"Aero" themes enabled (Windows Vista, Windows 7). It is recommended to 
switch into any "non-transparent" theme (for example, Classic) to capture 
screens with open menus. 

10.1 What needs to be done prior to recording the simulation? 
Create a learning Module (or select an already created one) to insert the simulation into. Select 
(or create a new) Slide for placing the simulation. The Editor allocates each simulation session 
into a single Slide and automatically adds necessary frames; there is no need to add frames 
manually. Define the size of the free space on the Frame within the Slide where the simulation 
will be fitted - this is the requirement for setting up simulation recording. 

IMPORTANT! CourseLab does not support auto scaling for captured screens. Screen 
captures will be performed only within user defined area in scale of 1:1. Therefore, make 
sure that defined size of the captured screen enables recording all required information 
from the target software. If of size insufficiency, you might need to change template of 
the current Slide to increase size of recording area.  

Specify a graphic format for storing screen captures. Select the “Settings” item from the 
“Service” menu, on the “Screen Capture” tab specify the desired file format. As long as you do 
not have any specific restrictions, we recommend using PNG format for screen capturing, since 
this format performs best in terms of quality and size of the saved files.  

Even though you can correct results later on, you should determine the screen capturing 
scenario beforehand, in order to avoid mistakes. 

10.2 Screen Capture Wizard 
While on the slide, which is to be used for recording the simulation, select “Capture Screens” 
item from the “Tools” menu. 



 

Screen Capture Wizard opens up. 

 

From the drop-down menu select program to record the simulation from. Mark “Capture 
Cursor” check box if you need to record mouse’s clicks and movements. Clicks and movements 
will be captured automatically, once the recording starts.  



 

Specify position for the top left corner of the area for recording simulations within a frame.  By 
default, position of top left corner of the area for recording simulations within a frame is equal 
to top left corner of the frame (position 0,0), however there are instances where it is not 
acceptable. For example, if there is a title located at the top of the frame, then top left corner 
of the area for recording should be placed underneath, by adding frame title’s height in pixels 
into the “Vertical Position” field. 

 



Define location and size of the area on the monitor to be captured. The editor will try to adjust 
captured application window to the specified size automatically, if possible. 

 

10.3 Capture Frames 
After switching to the capture mode, editor minimizes into the icon on the windows taskbar.  

 

Red rectangular enclose appears, which limits the area or capturing. Make sure that all desired 
information is well fitted inside of the screen capture area.  



 

Press PrintScrn, the first frame is captured.  Go to the next step in target program, and press 
PrintScrn one more time.  Using PrintScrn continue capturing all the changes that you apply to 
the target program, until you complete recording based on the desired scenario. 

IMPORTANT! If you marked “Capture Cursor” check box before entering the 
capture mode all mouse’s clicks and movements will be recorded automatically. 
However, remember that mouse click does not automatically capture the screen, 
do not forget pressing PrintScrn where appropriate.  

Upon capture scenario is completed, double click CourseLab icon from the taskbar. CourseLab 
Editor window will be restored and all captured frames will be available for editing. 

10.4 Modifying capture settings while in capture mode 
After switching to the capture mode, editor minimizes into the icon on the windows taskbar 
and red rectangular enclose appears, which limits the area or capturing. 

 

CourseLab will try to adjust captured application window to the specified area size.  



 

However, some programs will not allow doing so. In this case, you can manually adjust screen 
capture area to fit the target window, or opposite, target window to fit screen capture area. 
You can modify screen capture area by dragging red border or by using context menu of the 
capture area. 

 

Adjust screen capture area to fit the target window. 

Select “Resize Frame” item from the context menu. Screen capture area will automatically 
adjust its size to the current window size of the target application.  

Adjust target window to fit the screen capture area. 



Select “Resize Window” item from the context menu.  Editor will automatically attempt 
adjusting size of target window to the size of screen capture area. If target program did not 
allow such change, adjust size manually. 

Precise sizing of the screen capture area and recording position. 

Select “Size...” item from the context menu. In the opened window you can modify numerical 
values for size and position of the screen capture area.  

 

Use another tab of the “Size...” screen to modify position of the top left corner of the area 
within a frame, where capture recording will be inserted. 



 

10.5 Partial Screen Capture 
In addition to capturing the entire window of the target program, you can also record part of 
the screen capture area to the frame as a separate picture without interrupting capturing flow. 
It can be useful for example, for drop-down menu imitation (you can save the menu as a 
separate picture and further use editor’s capabilities for manipulating this picture).  

Press Shift-PrintScrn combination to enter the special capture mode. The target program 
freezes up and in addition to the red you will see the blue enclose frame indicating special 
capture mode.  

 



Modify size of the special capture area by dragging border and press PrintScrn.  

 

The content within blue area will be captured on the current frame as a separate picture. You 
can enter or modify identifier name to make it more self-explanatory before saving the picture 
(remember, that identifier names should contain only Latin alphabet letters, numbers, and 
underscore character). 

 

Use the same technique for “cutting” any number of the pictures from the current captured 
screen, by sequentially changing size and location of the blue screen capture area and by 
pressing the PrintScrn.   

After you finish “cutting”, you can go back to the main capture repository by pressing Shift-
PrintScrn. The blue enclose frame will disappear and captured program will “unfreeze”; also 
PrintScrn button will continue capturing the entire area. 

10.6 Editing captured frames 
Review all the captured screens. Make sure that all the necessary screens are captured. Repeat 
capturing if any screens are missing. 

Sometimes, if the “Capture Cursor” mode is “On”, the very first Frame will be empty, it means 
that capturing mouse movements took place prior to the first screen capture. You may simply 
remove this frame.  



 

The blue tracing lines on the Frame are reflections of the mouse movements (they will not be 
visible when replaying). When required, you can modify the location of the mouse clicks (you 
can drag them) and/or remove unwanted clicks completely, in this case the trace of the mouse 
path will be automatically adjusted. Note that you can also modify the cursor shape, speed of 
movements, and time duration for holding down the mouse button. To accomplish these 
modifications, right-click on the cursor image and select “Format Cursor” from the context 
menu. 

However, the captured set of frames is not quite finished and should be considered 
“groundwork” for future editing. Most likely you are going to need to provide additional 
supporting explanations in a form of balloons or popup windows.  

From the editor’s point of view, each captured Frame can be treated as a typical Frame (the 
only difference is the recorded mouse movements). On any of the captured frames you can 
insert additional Objects from the Objects library (balloons, popup, pictures, etc.) On all 
captured frames you can use Actions, change timeouts and so on, just like with any other 
frames. 

By default, the replay time for a particular Frame is defined by the time spent on mouse 
movements.  

However, you can manually change a Frame display time, if necessary. Right-click on the 
necessary Frame and use the “Transition” item from the context menu. Specify the required 
timeout for the frame. 

  



11. Import from PowerPoint 
CourseLab allows importing content of the Microsoft PowerPoint presentations into the 
Learning Module. 

11.1 Import from PowerPoint Wizard 
CourseLab allows importing content of the Microsoft PowerPoint presentations into the 
Learning Module. 

Note that Microsoft PowerPoint must be installed on the same computer to 
provide correct presentation import. 

To start import, select Tools -> Import from PowerPoint menu option. 

 

Import screen wizard opens up. Press Next to continue. 

 

Specify the path to the MS PowerPoint presentation to be imported.  



 

Specify the Master-Slide (press “Master” button to select) which will be the base for the 
imported presentation. The pink area on the Wizard’s screen represents the imported 
presentation. Press the “Position” button to specify the position of the imported presentation 
on the Slide and scaling. You can import comments to Slides if necessary and position it on the 
Slide the same way as the presentation main body (grey area represents comments). Press the 
“Next” button to proceed.  

 



On the next wizard page you can select the Slides to be imported. Hold down the Ctrl key to 
select Slides.  

 

Press the “Next” button and start processing. 

 



Depending on the size of presentation, it can take up to several minutes to import 
presentation. In general, imported Slides reproduce the corresponding PowerPoint Slides. You 
can further modify these Slides, if desired. 

 

  



12. License management 
CourseLab license management uses hardware or software HASP keys based on SafeNet Inc. 
technology.  CourseLab application is the same for both types of keys, i.e. installed CourseLab 
application will work with any of these keys, that will be found. 

12.1 HASP HL key (USB-dongle) 
License managing using HASP HL key is very simple: license is present on the computer where 
key is inserted in USB-port. 

 

If HASP driver is installed without errors, then inserted USB-dongle is lit with red light 
constantly. If there are problems with driver or USB-dongle itself, then key does not lit at all or 
blinking. 

Current license and key state can be viewed via browser : http://localhost:1947 . Functional key 
will be listed as on the picture below: 

  

Please note, that USB-dongle firmware must have version 3.25 or higher. 

12.2 HASP SL key (software key) 
License management using HASP SL key involves the exchange of information between the 
computer on which the software key is installed and the CourseLab Licensing Server. Software 
key (unlike hardware key) binds to computer, where it is installed. It cannot be transferred to 
another computer as easy as hardware key, therefore please install it on the computer where 
you plan to work with CourseLab. .  

Current license and key state can be viewed via browser: http://localhost:1947 . Functional key 
will be listed as on the picture below: 

http://www.safenet-inc.com/
http://localhost:1947/
http://localhost:1947/


  

IMPORTANT! Software key will be listed anyway - even if it is not activated yet. Unlike 
hardware key (which is activated by supplier), software key is always exists on the 
computer, but needs to be activated to use it.  

12.2.1 License activation 

On first launch of installed CourseLab application License Activation Wizard will be displayed. 

If you have hardware key (USB-dongle) insert it into free USB port, wait a little while key will be 
constantly lit with red light, and press Next button to start using CourseLab. 

If you have software key (HASP SL), then select Software Key option and press Next button. On 
the next Wizard screen you will be asked to select activation method: via Internet or E-mail. 

  

Activation via Internet 

This method is preferrable, because it is very simple. If your computer has Internet connection - 
select "Via Internet" checkmark and press "Next" button. 

IMPORTANT! While activating HASP driver will try to connect with CourseLab 
Licensing Server using secure HTTPS protocol (port 443). Server address is 
https://hasp.courselab.com. If your firewall or other security settings blocks this 
connection - add this address into exception list. 

On the next screen fill in Product Key, that was provided by your CourseLab supplier (Product 
Key is character sequence (from 19 to 25 symbols) and press "Next" button. 

If connection is not blocked and Product Key is correct, then activation will be accomplished in 
few seconds and you can start using CourseLab. If, for some reason, activation via Internet is 
not accomplished (you get activation error messages), press "Back" button and select "Via E-
mail". Е 

Activation via E-mail 

This activation method needs some manual procedures, therefore it may take from few 
minutes to few days to accomplish it. 



 Activation procedure is an exchange of e-mail messages containing files with a digital 
signature. User sends files with digital signature of the HASP driver - C2V (customer-to-vendor), 
reply contains digital signature of Licensing server - V2C (vendor-to-customer).  

Fill in Product Key, that was provided by your CourseLab supplier (Product Key is character 
sequence (from 19 to 25 symbols) into correspondinf field, "Location" field becomes active. 
Select location where C2V file with activation request will be created and press "Create file" 
button. Create this file and send it as attachment to your CourseLab supplier. 

After you receive reply from your supplier with V2C file attached, save this file on local disk, 
proceed to the same Activation License Wizard screen, select location of the file in 
corresponding field and press Next. License on this computer will be activated. 

12.2.2 Temporary detaching of the license 

Software key (HASP SL) allows detaching the license from Host computer and attach it 
temporarily to another computer (maximal detach period - 9999 days). After you detach license 
CourseLab application on Host computer stops at the selected detach period automatically. 

Terms: Recipient computer is the computer, to which the detached license is (or will be) 
attached; Host computer is the computer, where CourseLab was installed and activated 
initially. 

IMPORTANT! License can be temporarily detached only on the Host computer. There's no 
possibility to detach license from Recipient computer and attach it to some third 
computer (i.e. cascade detach). If you need to attach license to some third computer, 
return it to Host first and then start usual detach procedure for another computer.  

License Detaching process consists of these steps: 

Creating ID file on Recipient computer  

To create ID file (which is needed to "introduce" Recipient computer to Host) select in the 
CourseLab application on the Recipient computer menu option Help -> License -> Create ID 
file... ID file creation wizard opens up. 



 

Create ID file and transfer it to Host computer. 

Creating H2R file on Host computer 

To create H2R (Host-to-Recipient) file select in the CourseLab application on the Host computer 
menu option Help -> License -> Detach... H2R file creation wizard opens up. Locate ID file, 
select detach period in days (maximum 9999), select location for creating H2R file and press 
"Next" button. 

Transfer H2R (host-to-recipient) file to Recipient computer. 

IMPORTANT! From this moment license on Host computer stops.  

Attaching license on Recipient computer 

Select in the CourseLab application on the Recipient computer menu option Help -> License -> 
Attach... Locate H2R file and press "Next" button. From this moment license on Recipient 
computer starts to work. 

12.2.3 Return of the detached license 

If the detached license that is used on another computer becomes unusable before its 
expiration date, then you can initiate early return of detached license back to Host computer. 

Terms: Recipient computer is the computer, to which the detached license is (or will be) 
attached; Host computer is the computer, where CourseLab was installed and activated 
initially. 

IMPORTANT! License can be temporarily detached only on the Host computer. There's no 
possibility to detach license from Recipient computer and attach it to some third 



computer (i.e. cascade detach). If you need to attach license to some third computer, 
return it to Host first and then start usual detach procedure for another computer. 

Creating R2H-file on Recipient computer 

To create R2H (Recipient-to-Host) file select in the CourseLab application on the Recipient 
computer menu option Help -> License -> Cancel... R2H file creation wizard opens up. 

 Transfer created R2H file to Host computer. Note, that Host is the only computer that will 
accept this file.  

IMPORTANT! From the moment of creation R2H file license on the Recipient computer is 
cancelled.  

Reattaching the license on Host computer 

In the CourseLab application on the Host computer select menu option Help -> License -> 
Attach.... Locate transferred R2H file and press "Next". From this moment license will work on 
Host computer again. 

12.2.4 License deactivation 

IMPORTANT! License deactivation means that you refuse from using CourseLab 
completely. Deactivated license cannot be used anymore on any other computer. Please 
be aware of this fact.  

Deactivation procedure is an exchange of e-mail messages containing files with a digital 
signature. User sends files with digital signature of the HASP driver - C2V (customer-to-vendor), 
reply contains digital signature of Licensing server - V2C (vendor-to-customer).  

Select menu command Help -> License -> Deactivation.... License Deactivation Wizard will 
display procedure steps on the first screen. Press Next to continue. 



 

On the next Wizard screen select location where C2V file with deactivation request will be 
created. Create this file and send it as attachment to your CourseLab supplier. 

 

After you receive reply from your supplier with V2C file attached, save this file on local disk, 
proceed to the same Deactivation License Wizard screen, select location of the file in 
corresponding field and press Next. License on this computer will be deactivated and another 
C2V file will be created - send it to your CourseLab supplier to confirm license deactivation. 



  

12.3 CourseLab registration 
Registration of your CourseLab is not mandatory, but may help CourseLab support team to 
speed up your support request processing. Select menu Help -> Register CourseLab... - 
Registration Wizard will open.  

 

Fill in your registration data and press Next. If Internet connection is present your data will be 
immediately sent to CourseLab Registration Server. 

  


